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1 Product overview

This chapter presents an overview of the hardware components of the HP Workstation.

● Product features on page 1

● Product specifications on page 5

● Chipkill support on page 11

● ENERGY STAR Qualification on page 11

● Multi-core processors on page 12

Product features
Exploded view

The following image shows a typical HP xw9400 Workstation (drive configurations can vary).

For complete and current information on supported accessories and components, see
http://partsurfer.hp.com.

Figure 1-1  Exploded view

Table 1-1  Exploded view

Item Description Item Description

1 PCI card support 10 Memory modules

2 Power supply 11 Card guide/Front fan

3 CPU heatsinks 12 Graphics card

4 Processors 13 Optical drive*
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Item Description Item Description

5 System fan 14 PCIe card

6 Access panel 15 Diskette drive

7 System board 16 PCI card

8 Chassis 17 Hard drive

9 Front bezel 18 Memory fan
* A CD-ROM is an example of an optical drive.

Table 1-1  Exploded view (continued)
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Front panel components  
The following image shows a typical HP xw9400 Workstation. Drive configurations can vary.

Figure 1-2  Front panel components

Table 1-2  Front panel components

Item Symb
ol

Description Item Symb
ol

Description

1  Optical drive 6 Headphone connector

2  5.25-inch drive bay 7 USB 2.0 ports

3  Diskette drive (optional) 8 Hard drive activity light

4 IEEE-1394a connector 9 Power button

5 Microphone connector 10  Power on light
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Rear panel components
Figure 1-3  Rear panel components

Table 1-3  Rear panel components

Item Symbol
*

Description Item Symb
ol

Description

1  Power cord connector 10  Graphics adapter

2  Built In Self Test (BIST) LED 11 Audio line-in connector

3 Serial connector 12 RJ-45 network connectors

4 SPDIF OUT** 13 IEEE-1394a connector

5 Keyboard connector 14 Mouse connector

6 USB 2.0 ports 15  Cable lock slot

7 Microphone connector 16  Padlock loop

8 Audio line-out connector 17  Universal chassis clamp opening

9  MiniSAS 4–port connector (optional) 18  Access panel key
* The rear panel connectors are labeled with industry-standard icons and colors to assist you in connecting your peripheral
devices.
** SPDIF OUT is a single RCA jack to support SPDIF digital audio output via coax cable.

Serial number and COA label location
Each workstation has two unique serial number labels. Systems preinstalled with Microsoft® Windows®
XP also have a certificate of authentication (COA) label (2). The serial number labels (1) are located on
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the side panel of the unit and on the rear panel. Keep the serial number available when contacting
customer service for assistance.

Figure 1-4  Serial number and COA label location

Product specifications
The following table lists the physical dimensions.

Table 1-4  Physical characteristics

Weight (depending on
configuration)

18-27.7 kg (39.6-61.1 lb.)

Tower dimensions 455 mm (17.9 in.) tall, 210 mm (8.3 in.) wide, 525
mm (20.7 in.) deep

Rack mount
dimensions (top cover
and foot removed)

210 mm (8.3 in.) tall, 440 mm (17.3 in.) wide, 525
mm (20.7 in.) deep

ENWW Product specifications 5



Power supply and cooling
This section describes power supply specifications.

Table 1-5  Power supply source voltages

Source voltage Description

+3.3V PCI, PCIe, onboard logic, SAS controller, IEEE 1394, and
chipset

+5V Storage (disk, optical, diskette), PCI, audio, USB, input to
onboard regulator, and onboard logic

+12 V-CPU0 Input to onboard regulator that supplies power to CPU0 and
CPU0 fan

+12 V-CPU1 Input to onboard regulator that supplies power to CPU1,
CPU1 fan, and chipset regulators

+12 V-M Input to onboard regulator that supplies power to memory

+12 V-B PCI, PCIe, and system fans

+12 V-D Storage (hard drive, optical drive, diskette drive)

+12 V/G1 PCI Express auxiliary connector

+12 V-G2 Second PCI Express auxiliary connector

+12 V-R Not used

+12 V-N PCI and serial ports

+5 V-SB Sleep circuitry

Table 1-6  Maximum current per rail

Voltage rail 1050W maximum
continuous current

+3.3V 22.0A

+5V 18.0A

+12 V-CPU0 18.0A

+12 V-CPU1 18.0A

+12 V-M 18.0A

+12 V-B 18.0A

+12 V-D 18.0A

+12 V/G1 18.0A

+12 V-G2 18.0A

+12 V-R 18.0A

+12 V-N 0.30A

+5 V-SB 9.0A
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CAUTION: Do not exceed 150 watts of 3.3V and 5V power combination.

Do not exceed 84.0 amps (1008W) of 12V (CPU0/CPU1/M/B/D/G1/G2/R) power combination.

Do not exceed 1050 watts of total continuous output power.
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Power supply specifications
The integrated, surge-tolerant power supply is rated to withstand a power surge of up to 2,000 V (line-
to-PE or neutral-to-PE) and 1,000 V (line-to-line) without any data loss or system downtime. The
following specifications describe the power supply:

Table 1-7  Power supply specifications

Item Description

Power supply 1050W
Wide Ranging, Active PFC

Operating voltage range 90-269 VAC

Rated voltage range 100-240 VAC 118 VAC

Rated line frequency 50-60 Hz 400 Hz

Operating line frequency
range

47-66 Hz 393-407 Hz

Rated input current 13.2A @ 100-127
VAC

6.6A @ 200-240
VAC

12.0A @ 118
VAC

Heat dissipation

(Configuration and
software dependent)

Typical 3,136 BTU/hr = 791kg-cal/hr)

Maximum 4,480 BTU/hr = 1,129 kg-
cal/hr)

Power supply fan 92x32 mm variable speed

80 Plus compliant 80 Plus compliant and compatible
with ENERGY STAR compliant
configurations.

FEMP Standby Power
compliant @115V (<2W in
S5 – Power Off)

No

Power Consumption in
ENERGY STAR Mode –
Suspend to RAM (S3)
(Instantly Available PC)

<25 watts

Built-in self-test LED Yes

Surge tolerant (withstands
power surges up to 2000V)

Yes

Power consumption and heat dissipation
Power consumption and heat dissipation specifications are available for multiple power supply
configurations. To review available specifications, see http://www.hp.com/go/quickspecs.

To reach zero power consumption, unplug the workstation from the power outlet or use a power strip
with an on/off switch. For additional information about power-saving features, see your operating system
documentation.

This product is in compliance with U.S. Executive Order 13221.
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System fans and airflow
The workstation includes one rear system fan, one memory fan, one processor (CPU) heatsink fan for
each processor, and one power supply fan, plus a front system fan.

Resetting the power supply
If an overload triggers the power supply overload protection, all power is immediately shut off. To reset
the power supply unit:

1. Disconnect the power cord.

2. Determine what caused the overload and fix the problem.

3. Reconnect the power cord and reboot the workstation.

When you power down the workstation through the operating system, power consumption falls below
the low power consumption rate but does not reach zero. This on/off feature extends the life of the power
supply.

Power cord requirements
The power cord set (flexible cord or wall plug) received with this product meets the requirements for use
in the country where you purchased the equipment.

If you must obtain a power cord for a different country, you should purchase a power cord that is
approved for use in that country.

The power cord must be rated for the product and for the voltage and current marked on the product’s
electrical ratings label. The voltage and current rating of the cord should be greater than the voltage and
current rating marked on the product. The length of the cord must be between 1.8m (6 feet) and 3.6m
(12 feet). If you have questions about the type of power cord to use, contact the HP authorized service
provider.

A power cord should be routed so that it is not likely to be walked on or pinched by items placed on it
or against it. Particular attention should be paid to the plug, electrical outlet, and the point where the
cord exits from the product.

NOTE: A 15AMP-capable (minimum) power cord must be used in with a 110-V power source. A
10AMP-capable (minimum) power cord should be used with a 220-V power source.
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Environmental specifications
This section describes environmental specifications of your workstation.

Temperature

Operating: 5 to 35°C (40 to 95°F)

Non-operating: -40 to 60°C (-40 to 140°F)

NOTE: Derate by one degree C (1.4 degrees F) for every 305m
(1,000 ft.) altitude over 1,524m (5,000 ft.).

Humidity
Operating: 8 to 85% RH, non-condensing

Non-operating: 8 to 90% RH, non-condensing

Altitude
Operating: 0 to 3,048m (10,000 ft.)

Non-operating: 0 to 9,144m (30,000 ft.)

Shock

Operating: ½-sine: 40g, 2-3ms

Non-operating:

● ½-sine: 160 cm/s, 2-3ms (~100g)

● square: 422 cm/s, 20g

NOTE: Values represent individual shock events and do not
indicate repetitive shock events.

Vibration
Operating random: 0.5g (rms), 5-300 Hz

Non-operating random: 2.0g (rms), 10-500 Hz

NOTE: Values do not indicate continuous vibration.

PCI card slot power specification
Table 1-8  PCI and PCI Express slot power specifications

Slot# Slot Type Slot Power (Maximum)

1 PCI Express x16 (x8) 25W*

2 PCI Express x16 graphics 150W**

3 PCI 32 bit, 33 MHz 25W*

4 PCI Express x16 (x8) 25W*

5 PCI Express x16 graphics 150W**

6 PCI-X 100 25W*

7 PCI-X 100/133 25W*
* In addition to these slot power specifications, the overall power consumption of the system (including I/O cards, processor,
and memory) must not exceed the maximum ratings of the system power supply. See Power supply specifications
on page 8 for details.
** Includes 75 W maximum from the system board connector, and 75 W maximum from the auxiliary graphics power connector.
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NOTE: If a graphics card requiring more than 75W is installed in Slot 2, HP recommends not using
slot 3, which is the PCI slot below the graphics slot. If a graphics card requiring more than 75W is installed
in slot 5, HP recommends not using slot 6, which is the PCI-X 100 slot below the graphics slot. In addition
to these slot power specifications, the overall power consumption of the system (including I/O cards,
processors, memory, and drives) must not exceed the maximum ratings of the system power supply.
Also, there are broad restrictions on using dual 150W graphics cards.

For hardware specifications of other system components, such as graphics cards or optical drives, see
the website of the specific manufacturer.

Chipkill support
Chipkill is a form of advanced Error Checking and Correcting (ECC) computer memory technology. The
HP xw9400 Workstation supports 128-bit Chipkill ECC memory functionality. Standard ECC functionality
detects and corrects single bit data errors in memory systems. But Chipkill offers greater memory error
protection by providing error correction for up to 4-bit errors within the same symbol (nibble boundary).
Chipkill cannot correct any random four bits across 128 bits.

Chipkill on the xw9400 functions within these parameters:

● The workstation enables Chipkill functionality on paired ECC memory DIMMs only.

● The use of single memory DIMM—not supported on the xw9400 workstation—allows standard
single bit ECC only.

● Chipkill can detect and correct up to four bit errors if the four bits are in the same symbol. That is,
multiple bit errors in bits 0–3 or 4–7 of a byte can be detected and corrected. Multi-bit error that
overlap or span symbol boundaries (bits 2–5 or 3–6, for example) cannot be corrected. For DIMMs
that are based on x4 parts, this means that a single DRAM chip can fail and the system will continue
to operate. For x8 and x16 parts, a complete DRAM chip cannot fail, but symbol errors will be
corrected as described.

ENERGY STAR Qualification
HP computers marked with the ENERGY STAR logo are compliant with the applicable U.S.
Environmental Protection Agency (EPA) ENERGY STAR specifications for computers. The EPA
ENERGY STAR logo does not imply endorsement by the EPA. As an ENERGY STAR Partner, Hewlett-
Packard Company has determined the products marked with the ENERGY STAR logo are ENERGY
STAR qualified per the applicable ENERGY STAR guidelines for energy efficiency. The following logo
appears on all ENERGY STAR qualified computers.

The ENERGY STAR Computers Program was created by the EPA to promote energy efficiency and
reduce air pollution through more energy-efficient equipment in homes, offices, and factories. One way
products achieve this energy efficiency is by reducing power consumption when not being used through
the Microsoft Windows Power Management feature.

The Power Management feature enables the workstation to enter a low-power (or “sleep”) mode after
a period of inactivity. When used with an external monitor that is ENERGY STAR qualified, this feature
also supports the similar power management features of the external monitor.
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To take advantage of this energy savings:

● The Power Management feature has been preset to suspend the workstation to a sleep state after
30 minutes of inactivity.

● The Power Management feature has been preset to suspend the monitor to a sleep state after 15
minutes of inactivity.

Both the computer and monitor can be woken from sleep mode through user interaction with any of the
computer input devices (mouse, keyboard, and so on). when configured with Wake On LAN (WOL)
enabled, the workstation can also be woken by a network signal.

See the EPA ENERGY STAR Power Management Web site for more information about the energy and
financial savings potential of the Power Management Feature: http://www.energystar.gov/
powermanagement.

See the EPA ENERGY STAR Web site for more information about the ENERGY STAR program and
its environmental benefits: http://www.energystar.gov.

CAUTION:  Using the Energy Save Monitor feature with monitors that are not ENERGY STAR qualified
can cause video distortion when an Energy Save timeout occurs.

NOTE:  ENERGY STAR is not supported on Linux workstations.

If it is necessary to restore the operating system, you must also reset the ENERGY STAR settings (if
applicable) after the restore.

To verify the factory default power settings for your workstation, select Start>Control Panel, and then
double-click Power Options.

Multi-core processors
This HP Workstation supports selected AMD Opteron™ 2000 series multi-core processors that provide
multiple true processors in a single socket. Multi-core processors are better at handling the load of multi-
threaded applications (such as rendering images in Digital Content Creation) and highly multi-tasked
environments (such as running several productivity applications while listening to music).
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2 Setting up the operating system

This chapter provides setup and update information for the workstation operating system. It includes
these topics:

Topics

Setting up the Microsoft operating system on page 14

Setting up Red Hat Enterprise Linux on page 15

Setting up Novell SLED on page 16

Updating the workstation on page 16

This chapter also includes information on how to determine that you have the latest BIOS, drivers, and
software updates installed on the workstation.

CAUTION: Do not add optional hardware or third-party devices to the HP workstation until the
operating system is successfully installed. Adding hardware might cause errors and prevent the
operating system from installing correctly.
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Setting up the Microsoft operating system
NOTE: If you ordered a downgrade from Windows Vista to Windows XP Professional operating
system, your system will be preinstalled with Windows XP Professional operating system. With this
configuration, you will receive recovery media for Windows Vista operating system only. In case you
need to restore or recover the Windows XP Professional operating system in the future, it is important
that you create recovery media disks for Windows XP Professional operating system after first boot.

When you first apply power to the workstation, the operating system is installed. This process takes
approximately 5 to 10 minutes. Carefully follow the instructions on the screen to complete the installation.

CAUTION: After installation has started, do not turn off the workstation until the process is complete.
Turning off the workstation during installation can damage the installation and operation of the software.

For complete operating system installation and configuration instructions, see the operating system
documentation that was provided with the workstation. Additional information is available in the online
help tool after you successfully install the operating system.

Installing or upgrading device drivers
To install hardware devices after the operating system is installed, you must install the appropriate
device drivers before you install the devices. Follow the installation instructions that came with the
device. In addition, for optimum performance, your operating system must have the most recent updates,
patches, and software fixes. For additional driver and software update information, refer to Upgrading
device drivers on page 18.

Transferring files and settings to your Windows workstation
The Microsoft Windows operating system offers data migration tools that helps you choose and transfer
files and data from a Windows computer to your Windows Vista or Windows XP Professional operating
system workstation.

For instructions on how to use these tools, see the documents at http://www.microsoft.com.
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Setting up Red Hat Enterprise Linux
HP offers an HP Installer Kit for Linux (HPIKL) to supplement Red Hat box sets and help HP Linux
customers customize their system image. The HPIKL contains the HP driver CD and device drivers to
successfully setup up the Red Hat Enterprise Linux (RHEL) operating system, The HP Installer Kit for
Linux CDs are currently available for download at http://www.hp.com/support/workstation_swdrivers.

Installing with the HP driver CD
To install the HP driver CD, see “Installing with the HP Installer Kit for Linux” in the HP Workstations for
Linux manual at http://www.hp.com/support/workstation_manuals.
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Installing and customizing Red Hat-enabled workstations
Linux-enabled workstations require the HP Installer Kit and the purchase of a Red Hat Enterprise Linux
box set. The Installer kit includes the HP CDs necessary to complete the installation of all versions of
the Red Hat Enterprise Linux box set that have been qualified to work on an HP workstation.

To use the drivers in the HP Installer kit for Linux other than RHEL, you must manually extract the drivers
from the HP Driver CD and install them. HP does not test the installation of these drivers on other Linux
distributions nor does HP support this operation.

Verifying hardware compatibility
To see which Linux versions have been qualified to work on HP Workstations visit http://www.hp.com/
support/linux_hardware_matrix.

Setting up Novell SLED
To set up the SUSE Linux Enterprise Desktop (SLED) on systems preloaded with the operating system:

1. Boot the workstation.

2. Start the Installation Settings and enter the password, network, graphics, time, keyboard settings,
and Novell Customer Center Configuration for the workstation.

NOTE: During Installation Settings after the first time after booting the system the Novell
subscription can be activated from the Novell Customer Center Configuration screen. Visit the full
Novell Customer Center documentation at http://www.novell.com/documentation/ncc/.

Updating the workstation
HP is constantly working on improving your total workstation experience. To ensure that the workstation
leverages the latest enhancements, HP recommends that you install the latest BIOS, driver, and
software updates on a regular basis.

Updating the workstation after first boot
After successfully booting the workstation for the first time, you should follow these guidelines to ensure
that the workstation is up-to-date:

● Ensure that you have the latest system BIOS loaded. See Upgrading the BIOS on page 16 for
instructions.

● Ensure that you have the latest drivers for your system. See Upgrading device drivers
on page 18 for instructions.

● Become familiar with your available HP resources.

● Consider a subscription to Driver Alerts at http://www.hp.com/go/subscriberschoice.

Upgrading the BIOS
For optimum performance, determine the BIOS revision on the workstation, and upgrade it if necessary.
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Determining current BIOS
To determine the current BIOS of the workstation during system power up:

1. Wait for F10=setup to appear on the lower right corner of the screen.

2. Press F10 to enter the F10 Setup utility.

The F10 Setup utility displays the workstation BIOS version under File > System Information.

3. Note the workstation BIOS version so that you can compare it with the BIOS versions that appear
on the HP website.
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Upgrading BIOS
To find and download the latest available BIOS, which includes the latest enhancements:

1. Go to http://www.hp.com/go/workstationsupport.

2. Select Download Drivers and Software from the left menu column under Tasks.

3. Follow the instructions to locate the latest BIOS available for the workstation.

4. If the BIOS on the Web site is the same as the version on your system, no further action is required.

5. If the BIOS on the Web site is a version later than the one on your system, download the appropriate
version for the workstation. Follow the instructions in the release notes to complete the installation.

Upgrading device drivers
If you install a peripheral device (such as a printer, display adapter, or network adapter), confirm you
have the latest device drivers loaded. If you purchased your device through HP, visit the HP Web site
to download the latest drivers for your device. These drivers have been tested to ensure the best
compatibility between your device and your HP workstation.

If you did not purchase your device from HP, HP recommends visiting the HP Web site first to see if
your device and its drivers have been tested for HP workstation compatibility. If no driver is available,
visit the device manufacturer's Web site to download the latest drivers.

To upgrade device drivers:

1. Go to http://www.hp.com/go/workstationsupport.

2. Select Download Drivers and Software from the left menu column under Tasks.

3. Follow the instructions to find the latest drivers available for the workstation.

If a needed driver is not found, see the Web site of the manufacturer of the peripheral device.
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3 Restoring the operating system

This chapter describes how to restore the Windows or Linux operating system. It includes these topics:

Topics

Restore methods on page 19

Ordering backup software on page 20

Restoring Windows Vista on page 20

Restoring Windows XP Professional on page 21

Restoring Novell SLED on page 23

Installing with the HP driver CD on page 15

Restore methods
The Windows Business Vista operating system can be reinstalled using the HP RestorePlus! process.
The Windows XP Professional operating system can be reinstalled using the RestorePlus! process or
the HP Backup and Recovery Manager.

● RestorePlus!

The RestorePlus! process reinstalls the Windows operating system and device drivers (for devices
included with the system) to a near-factory state. The process does not back up or recover data
on the hard drive. Some application software might not be restored using this process and must
be installed from the appropriate application CD.

● HP Backup and Recovery Manager (HPBR) Recovery Point

The HP Backup and Recovery Manager application can be used to capture and restore the contents
of the system partition. It captures a snapshot of the system partition and stores it in a Recovery
Point. Everything on the system partition at the time the recovery point was made is saved.

NOTE: HP Backup and Restore is only supported on the HP xw6600 and xw8600 Workstations.

The Recovery Point is saved to the hard drive and can be burned to media for safekeeping.

CAUTION: These methods restore the operating system, but not data. Data must be backed up
regularly to avoid loss.
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Ordering backup software
If you cannot create system recovery CDs or DVDs, you can order a recovery disk set from the HP
support center. To obtain the support center telephone number for your region visit http://www.hp.com/
support/contactHP.

Restoring Windows Vista
This section describes how to restore Windows Vista.

Ordering the RestorePlus! media
If you ordered restore media with your workstation, the media is included with your workstation
components.

If you did not order restore media, call HP Support and request a RestorePlus! media kit. For worldwide
technical support phone numbers, visit http://www.hp.com/support.

Restoring the operating system
NOTE: Windows Vista provides a backup and restore application as well. To learn more about this
application, visit the Microsoft Web site.

CAUTION: Before you restore the operating system, back up your data.

When you run RestorePlus! from media, the process deletes all information on the primary hard drive,
including all partitions.

To restore Windows Vista:

1. Boot from the RestorePlus! DVD to start the RestorePlus! process. You must start from the
RestorePlus! DVD to install device drivers and settings.

2. Follow the prompts to restore your operating system.

Some application software might not be restored using this process. If software is not restored, install
it from the appropriate application DVD.
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Restoring Windows XP Professional
This section describes how to restore the Windows XP Professional operating system.

NOTE: The workstation must have a CD or DVD writer installed to create the media set.

Creating RestorePlus! media
The RestorePlus! kit can be created using the files contained on the hard drive. To create the restore
media:

1. Boot the workstation.

2. During boot up, an HP Backup and Recovery Manager screen is displayed prompting you to create
Recovery CDs or DVDs. Select Now.

3. An Initial Recovery Point (IRP) of the system is captured. This is a snapshot of the system hard
drive. The capture can take more than 10 minutes.

4. After the IRP is created, you can create a set of backup CDs or DVDs.

To create a RestorePlus! media set including the Windows XP operating system CD, select
RestorePlus! > Microsoft Windows XP operating system > Supplemental media.

NOTE: Depending on the options, there might be additional DVDs you can create.

5. Follow the prompts to create RestorePlus!, operating system, and HPBR media.

If you are unable to create CD/DVDs on your workstation, call HP Support and request a RestorePlus!
media kit. For worldwide technical support phone numbers, visit http://www.hp.com/support.
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Creating HP Backup and Recovery (HPBR) media
NOTE: HPBR functionality is used with Windows XP only. For details, refer to the SoftThinks guide
on the Documentation and Diagnostics CD included with the workstation.

The Initial Recovery Point can be burned to optical media and used to recover a system. This section
describes making the media.

NOTE: The workstation must have a CD or DVD writer to create the media set.

To create HPBR recovery media:

1. The Initial Recovery Point was captured when the RestorePlus! media set was created previously.

If the IRP was not created, start the HP Backup and Recovery Manager and create recovery points
using the Expert mode. Follow the HPBR online documentation for instructions.

2. Burn the IRP to media from HPBR.

Select HPBR Start > All Programs > HP Backup & Recovery > HP Backup and Recovery
Manager.

3. Select Next at the first screen.

Select Create recovery CDs or DVDs to recover the system, and then select Next.

4. Choose Next to display a list of available CD image and the recovery points.

5. Check the box next to Initial Recovery Point, and then select Next.

6. Follow the instructions to create the media.
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Restoring the operating system
CAUTION: Before you restore the operating system, back up your data.

When you run RestorePlus! from media, the process deletes all information on the primary hard drive,
including all partitions. If you run RestorePlus! from the recovery partition, only the root (C:) partition is
affected.

Using RestorePlus!
To restore with RestorePlus!:

1. Boot the workstation from the RestorePlus! DVD. You must start from the RestorePlus! DVD for
device drivers and settings to be installed.

2. Follow the prompts to restore the operating system.

Some application software might not be restored using this process. If software is not restored, install
it from the appropriate application DVD.

Using HPBR
To restore with the HPBR Initial Recovery Point media:

1. Boot the workstation from the Initial Recovery Point media.

2. Follow the prompts to restore the system to the state when the IRP was created.

Using the recovery partition
A system that shipped with Windows XP includes a recovery partition. You can boot the system from
that recovery partition.

From the recovery partition you can perform a system restore using the HPBR Initial Recovery Point, if
it was created. If it was not, you can use a RestorePlus! install.

To restore using the recovery partition:

1. Boot the workstation.

2. When prompted on the boot screen to enter the Recovery Manager, press F11.

TIP: The opportunity to press F11 during the boot process is small. It comes about the time the
F10 prompt appears.

NOTE: To ensure that the recovery processes reinstall on the correct hard drive, do not
disconnect the target drive during the recovery process.

3. Follow the prompts to restore the system to factory-like condition.

Restoring Novell SLED
The SLED restore media is required to restore the Linux operating system.

Creating restore media
THE SUSE Linux Enterprise Desktop preload includes a SUSE ISO icon on the desktop. You can click
this icon to go to the /iso directory. The /iso directory contains all iso images used to preload your
workstation. To recover or restore the original image, follow the instructions in the readme file in the /
iso directory to copy the ISO image file onto CDs.
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NOTE: Make copies of the ISO recovery images on CD as backup files in case your workstation
experiences a hard drive failure.
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4 System management

This section describes the various tools and utilities that allow for the system management of the
workstation.

● Computer Setup (F10) Utility on page 25

● Desktop management on page 36

Computer Setup (F10) Utility
The Computer Setup Utility enables you to:

● Change current settings from the factory default settings.

● Modify or restore factory default settings.

● Determine if all of the devices installed on the workstation are recognized by the system and
functioning properly.

● Determine information about the operating environment of the workstation.

● Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

● Establish and manage security features and password prompting during system reset and during
power-on.

● Establish and manage energy-saving time-outs (not supported for Linux platforms).

● Set the system date and time.

● Set, view, and change the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

● Modify the boot order of installed mass storage devices such as hard drives, diskette drives, optical
drives, and network drives.

● Enable or disable Network Server Mode, which enables the workstation to boot the operating
system when the power-on password is enabled with or without a keyboard or mouse attached.
When attached to the system, the keyboard and mouse remain locked until the power-on password
is entered.

● Enable/disable POST Messages to change the display status of POST messages. POST
messages disabled suppresses most POST messages, such as memory count, product name, and
other non-error text messages. If a POST error occurs, the error is displayed regardless of the
mode selected. To temporarily switch to POST messages enabled, press any key (except F1
through F12) during POST.

● Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

● Enter the Asset Tag or property identification number assigned by your company to this
workstation.
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● Secure the integrated I/O functionality, including the serial and USB ports, audio, embedded NIC,
SAS, or IEEE 1394 so that the I/O functionality cannot be used until they are unsecured.

● Enable or disable removable media boot ability.

● Enable or disable removable media write ability (when supported by hardware). Used commonly
for legacy diskettes.

● Replicate your system setup by saving system configuration information onto diskette or USB, or
restoring it onto one or more workstations.

BIOS ROM
The BIOS of the computer is a collection of programs stored as firmware in ROM. The BIOS ROM
includes such functions as POST, PCI device initialization, Plug 'n' Play support, power management
activities, and the Computer Setup Utility. BIOS supports the following systems and specifications:

● Dual AMD Opteron 2xxx series processors

● Up to DDR2-667 memory

● HyperTransport setup and initialization

● Chipset (includes NVIDIA nForce Professional 3600 and 3050 with NEC ?PD720404 PCIe to PCI-
X bridge)

● ACPI 1.0b with ACPI 2.0 extensions for 64-bit support, according to Microsoft Logo Requirements.
S1, S3, S4, and S5 with Remote Power On by way of LAN wake packet.

● SMBIOS Spec 2.5 implementation and field definitions that accurately represent hardware
configurations and OEM ID

● BBS 1.01

● DOS and Windows based BIOS flash tools

● Microsoft SDG 3.0 compliant as applicable

● PMM 1.01 as applicable

● MPS 1.4 as applicable

● PXE 2.1

● USB 1.1/USB 2.0

● PCI 2.2 or later

● “El Torito” Bootable CD 1.0

The BIOS ROM is a 1-MB FLASH unit. The runtime portion of the BIOS resides in a 96-KB block from
E8000h to FFFFFh (approximately). ACPI code and data take about 128 KB below TOLM (top of low
memory, the last RAM address below 4 GB).
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Using Computer Setup (F10) Utility
You can call up the Computer Setup Utility during workstation restart or power on. To access the
Computer Setup Utility menu:

1. Power on or restart the workstation.

2. Press the F10 key as soon as your display is active and the message Setup appears in the lower
right corner of the screen.

NOTE: If you miss the opportunity to press F10, restart the workstation and press F10 again. Or,
you can press Ctrl+Alt+Delete prior to boot .

3. At first boot, select your language from the list, and press the Enter key. In the Computer Setup
Utility menu, five headings are displayed: File, Storage, Security, Advanced, and I/O.

4. Use the left and right arrow keys to select the appropriate heading. Use the up and down arrow
keys to select the option you want, and press Enter.

5. To apply and save changes, select File>Save Changes and Exit.

● If you have made changes that you do not want applied, select File>Ignore Changes and
Exit.

● To reset to factory settings, select  File>Default Setup>Restore Factory Settings as
Default. Press F10 to accept the changes. Click File>Apply Defaults and Exit. This option
restores the original factory system defaults.

CAUTION: Do not turn the workstation power off while the ROM is saving your Computer Setup Utility
changes because the CMOS could become corrupted. After you exit the F10 Setup screen, it is safe to
remove all power from the workstation.
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Computer Setup (F10) Utility menu
NOTE: The following content is subject to change with new BIOS releases, so your menu may be
different than shown in Table 1–1.

Table 4-1  Computer Setup Utility menu descriptions

Heading Option Description

File System
Information

Lists product name, SKU number, processor type/speed/stepping, cache size
(L1/L2), memory type and size, integrated Media Access Control (MAC) IDs for
Network Interface, system BIOS type, chassis serial number, asset tracking
number, and Boot Block Date.

 About Displays copyright information.

 System
Temperatur
es

Displays temperature graph.

 Set Time
and Date

Enables you to set system time and date.

 Flash
System
ROM

Enables you to select a device from which to flash system ROM.

 Replicated
Setup

Save to Removable Media

Saves the current F10 Setup configuration to a text file called
cpqsetup.txt.

  Restore from Removable Media

Restores previous F10 Setup configuration from a text file called
cpqsetup.txt.

 Default
Setup

Save Current Settings as Default

Stores the current F10 Setup configuration as the default.

  Restore Factory Settings as Default

Restores the original factory settings to the F10 Setup configuration information
as the default.

 Apply
Defaults
and Exit

Saves the selected default settings (previously-saved user or factory settings)
and exits the Computer Setup Utility.

 Ignore
Changes
and Exit

Exits the Computer Setup Utility without applying or saving any changes.

 Save
Changes
and Exit

Saves changes to system configuration and exits the Computer Setup Utility.

Storage Device
Configuratio
n

Lists all installed non-SAS and non-SATA storage devices.

When a device is selected, detailed information and options are displayed.
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Heading Option Description

 Hard Disk

Identifies the hard disk drives on the system by model, firmware, serial number,
connector color, emulation type, multisector transfers, and translation mode.

By default, SATA drives are not listed here.

Default values can be set here for IDE and SATA drives, but not for SAS drives.

  CD-ROM

Identifies the optical drives on the system.

  Diskette (for legacy diskette drives only)

Identifies the highest capacity media type accepted by the diskette drive.
Options are 3.5" 1.44 MB, 5.25" 1.2 MB, and Not Installed.

  Default Values

Enables you to set the default values for IDE and SATA devices such as the
following:

● Multisector Transfers (IDE devices only)–Specifies how many sectors are
transferred per multi-sector Programmed Input/Output (PIO) operation.
Options (subject to device capabilities) are Disabled, 8, and 16.

● Transfer Mode (IDE devices only)–Specifies the active data transfer mode.
Options (subject to device capabilities) are PIO 0, Max PIO, Enhanced
DMA, Ultra DMA 0, and Max UDMA.

● Translation Mode (IDE/SATA disks only)–Enables you to select the
translation mode to be used for the device, which enables the BIOS to
access disks partitioned and formatted on other systems and may be
necessary for users of older versions of UNIX (for example, SCO UNIX
version 3.2). Options are Bit-Shift, LBA Assisted, Off, User, and Automatic.

NOTE: The Automatic option allows BIOS to automatically determine the
translation mode used to configure a previously-formatted IDE, SATA, or
USB mass storage device. Hence, you do not have to know how the mass
storage device was previously formatted.
Ordinarily, the translation mode selected automatically by the BIOS should
not be changed. If the selected translation mode is not compatible with the
translation mode that was active when the disk was partitioned and
formatted, the data on the disk will be inaccessible.

 Storage
Options

Removable Media Boot

Enables/disables ability to boot the system from removable media.

  Legacy Diskette Write

Enables/disables ability to write data to legacy media.

  BIOS DMA Data Transfers

Enables/disables DMA transfers for IDE and SATA devices when possible
during POST to increase transfer speed.

  SATA Controller #0

Enables/disables SATA controller 0.

  SATA Controller #1

Enables/disables SATA controller 1.

Table 4-1  Computer Setup Utility menu descriptions (continued)
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Heading Option Description

  SATA Controller #2

Enables/disables SATA controller 2.

  IDE Controller

Enables/disables IDE controller.

 Boot Order Enables you to configure the boot, diskette drive, and hard drive orders by
physically reordering the menu entries. Each device on the list can be
individually excluded from or included for consideration as a bootable operating
system source. Boot Order presents these selections:

● Optical drive

● Diskette drive

● USB device

● Hard drive

● Network controllers (2)

Boot devices can be disabled from participating in the boot order process. Boot
order changes are stored when the F10 Setup changes are confirmed by
selecting File>Save Changes and Exit.
NOTE: MS-DOS drive lettering assignments might not apply after a non-MS-
DOS operating system has started.
Shortcut to Temporarily Override Boot Order
To boot one time from a device other than the default device specified in Boot
Order, restart the workstation and press the F9 key when the F9=Boot Menu
message appears on the screen. After POST is completed, a list of bootable
devices is displayed. Use the arrow keys to select the preferred bootable device
and press Enter. The workstation then boots from the selected device for this
one time.

Security Setup
Password

Enables you to set and enable setup (administrator) password.

NOTE: If the setup password is set, you must enter Computer Setup Utility
to change it, flash the ROM, and make changes to certain plug-and-play
settings under Windows.

 Power-On
Password

Enables you to set and enable the power-on password.

NOTE: If a power on-password is set, or the workstation cover removal
sensor is activated, entries for these items will appear in this list.

Table 4-1  Computer Setup Utility menu descriptions (continued)
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Heading Option Description

 Device
Security

Makes the following devices available or hidden to the system:

● Serial Port

● All USB Ports

● External USB ports

● Front USB Ports

● System Audio

● IEEE 1394 Controller

● Network Controller 1

● Network Controller 2

● Onboard SAS Controller

● Embedded Security Device

For each device, Device Available is the default setting and allows the operating
system access to the device. Device hidden makes the device unavailable; it
is disabled by the BIOS and cannot be enabled by the operating system.

When enabled, Embedded Security Device offers these options:

● Enable/disable—Turns the TPM on/off.

● Power-On Authentication Support—Enables/disables an authentication
feature that requires you to enter a TPM user key password to boot the
system. This feature uses the TPM to generate and store the authentication
password.

● Reset Authentication Credential—Resets the authentication functionality
and clears all authentication credentials.

NOTE: A setup password must be set to enable the Embedded Security
Device and to access any security features associated with the Embedded
Security Device.

 Network
Service
Boot

Enables/disables a Network Service Boot which boots using the NIC PXE
option ROM. In this case, the actual boot image resides on a remote server.
When enabled, you can set the boot order of the NIC PXE option ROM and you
can force a network boot by pressing F12 during POST.

 System IDs Asset Tag

A 16–byte string identifying the system.

  Ownership Tag

An 80–byte string identifying ownership of the system. This tag is displayed on
the screen during POST.

  UUID (Universal Unique Identifier)

Can only be updated if the current chassis serial number is invalid. (These ID
numbers are normally set in the factory and are used to uniquely identify the
system.)

  Keyboard

Enables you to set the keyboard locale for System ID entry.

Table 4-1  Computer Setup Utility menu descriptions (continued)
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Heading Option Description

 OS Security Data Execution Prevention

Enables/disables Data Execution Prevention mode in the processors. This
mode prohibits code from running in pages that were set up as data pages, and
prevents attacks such as buffer overflows. Operating system support is
required for this feature.

  AMD Virtualization Technology

Enables AMD Virtualization Technology to increase workstation performance.

  OS Management of Embedded Security Device

Enables/disables the ability of the operating system to control the TPM device.
This includes turning it on/off, initializing it, and resetting it.

  Reset of Embedded Security Device through OS

Enables/disables the ability of the operating system to reset the TPM.

Advanced** Power-On
Options

Allows you to set:

● POST Mode (QuickBoot, FullBoot, or FullBoot every 1–30 days).

● POST Messages (Enable/Disable).

● F9 Prompt (Enable/Disable). Enabling this feature will display the text
F9=Boot Menu during POST. Disabling this feature prevents the text from
being displayed. However, pressing the F9 key will still access the boot
menu.

● F10 Prompt (Enable/Disable). Enabling this feature displays the text
F10=Setup during POST. Disabling this feature prevents the text from
being displayed but pressing F10 still accesses the Setup screen.

● F11 Prompt (Enable/Disable). Makes the Factory Recovery option visible
during POST.

● F12 Prompt (Enable/Disable). Enabling this feature displays the text
F12=Network Service Boot during POST. Disabling this feature prevents
the text from being displayed but pressing F12 still forces the system to
attempt booting from the network.

● Factory Recovery Boot Support (Enable/Disable). Recovery partition
(HDD) option available for Vista. Vista leaves the factory with this support
in place.

● Option ROM* prompt (Enable/Disable). Enabling this feature causes the
system to display a message before loading options ROMs.

● Remote Wakeup Boot Source

● After Power Loss (on/off)

● POST Delay (in seconds) (Enable/Disable). Enabling this feature adds a
user-specified delay to the POST process. This delay is sometimes needed
for hard disks on some PCI cards that spin up slowly—so slowly that they
are not ready to boot by the time POST is finished. The POST delay also
gives you more time to select F10 to enter Computer Setup (F10).

● I/O APIC Mode (Enable/Disable)

● Limit (PUID Maximum Value to 3) (Enable/Disable)

● Setup Browse Mode (Enable/Disable)

● ACPI/USB Buffers @ Top of Memory (Enable/Disable)

Table 4-1  Computer Setup Utility menu descriptions (continued)
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Heading Option Description

  POST Messages (Enable/Disable).

When enabled, POST displays non-error messages to the screen.

  F9 Prompt (Displayed/Hidden)

Displays F9=Boot Menu during POST. Hiding this feature prevents the text
from being displayed, but pressing F9 still calls up the boot menu.

  F10 prompt (Displayed/Hidden)

Displays F10=Setup during POST. Hiding this feature prevents the text from
being displayed but pressing F10 still accesses the Setup screen.

  F12 prompt (Displayed/Hidden)

Displays F12=Network Service Boot during POST. Hiding this feature
prevents the text from being displayed, but pressing F12 still forces the system
to attempt booting from the network.

  Option ROM* Prompt (Enable/Disable)

When enabled, causes the system to display a message before loading options
ROMs.

  Remote Wakeup Boot Source

Enables you to specify which boot device to use after a remote wake event.

  After Power Loss (Off/On/Previous State)

In the event of an AC power loss, determines system behavior when power is
restored. Options are Off (stay off), On (turn on immediately), and Previous
State (if the computer was on when power was lost, power on immediately; if
it was off, stay off).

  POST Delay (in seconds) (None, 5, 10, 15, 20)

Specifies a delay during POST. This setting may be necessary for certain add-
in peripherals that respond slowly or violate specifications. For instance, disk
drives should spin up within 15 seconds, but some older drives might take
longer.

  Setup Browse Mode (Enable/Disable)

Enables viewing Setup Options without entering Setup password. Enable
allows you to view Setup in read-only mode if you do not enter the Setup
password. Disable blocks Setup entirely if you do not enter the Setup
password. This option is only valid if a Setup password is set.

 Thermal Fan Idle Mode

This setting changes the minimum fan speed. The fans are still automatically
controlled.

The internal fans of the system are controlled automatically to guarantee proper
operation of any configuration shipped from the factory. However, some
customers with cards and configurations with special thermal/cooling needs
may need to increase the minimum spinning speed of the fans in the system.
They can do so by using this menu and selecting a higher minimal fan speed.

 BIOS
Power-On

Enables you to disable or specify a day and time for BIOS power-on.

 OS Power
Manageme
nt

ACPI S3 Support (Enable/Disable)

Enables/disables ACPI S3 suspend-to-RAM (Standby) from OS.

Table 4-1  Computer Setup Utility menu descriptions (continued)
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Heading Option Description

  ACPI S3 Hard Disk Reset (Enable/Disable)

When awakening from the ACPI S3 state, reset IDE hard drive before returning
to the OS.

  ACPI S3 PS2 Mouse Wake Up (Enable/Disable)

Allow the mouse to awaken the system from the ACPI S3 state.

  USB Wake on Device Insertion (Enable/Disable)

Awaken the system from ACPI S3 state on USB device insertion.

 Execute
Memory
Test

System reboots and executes the memory test.

 Chipset/
Memory

● Coherent HT: 1000 MHz, 2200 MHz default (Available on selected
workstations).

● ECC Support (Enable/Disable)

Enables/disables memory Error Correcting Code (ECC).

  Memory Scrubbing (Enable/Disable)

Enables/disables memory ECC scrubbing. If ECC Support is enabled, the
scrubbing feature walks through memory in the background to avoid
accumulation of ECC errors in memory. Upon detection of an ECC error, either
during the scrubbing walk-through or during normal processor-to-memory
operation, the scrubbing mechanism corrects the data and writes it back into
the corresponding memory DIMM module.

  Memory Node Interleave (Enable/Disable)

This option is valid for dual-processor systems only.

If enabled, BIOS interleaves the memory on CPU0 and CPU1 together. This
option requires the total memory installed on CPU0 (slots 1a/1b/3a/3b) and on
CPU1 (slots 2a/2b/4a/4b) to be the same.

If disabled, BIOS maps the memory connected to CPU0, then the memory
connected to CPU1. The system is then effectively in NUMA mode.

  PCI SERR# Generation (Enable/Disable)

Disables PCI SERR# generation for ill-behaved PCI add-in cards that can
generate spurious SERRs.

  NET Watchdog Timer (Enable/Disable)

Enables/disables the watchdog timer.

  ACPI Bus Segmentation (Enable/Disable)

Enables/disables PCI bus segmentation. Disabling this option may prevent
installation issues with some Linux implementations.

  HPET (Enable/Disable)

Enables/disables the High Precision Event Timer. This feature must be enabled
to use low power settings (PowerNow!). Some Linux implementations may
require disabling this feature.

Table 4-1  Computer Setup Utility menu descriptions (continued)

34 Chapter 4   System management ENWW



Heading Option Description

I/O** APIC
Interrupts

APIC

Allow manual configuration of system IRQs.

For more details on using this feature and on maximizing interrupt performance,
refer to the Optimizing APIC Interrupt Assignments on the xw9400 white paper
available at http://tclperf.fc.hp.com/performance_briefs/index.htm.

 Onboard
Devices

Disable or set IRQ, DMA, and I/O Range values for legacy devices.

 PCI Devices Disable or select IRQ values for PCI devices.

 Device
Options

NIC PXE Option ROM Download (Enable/Disable)

Disable means you cannot boot from this device, but more option ROM space
is available for other devices.

  Onboard SAS Option ROM Download (Enable/Disable)

Disable means you cannot boot from SAS drives, but more option ROM space
is available for other devices.

  SATA Option ROM Download (Enable/Disable)

Enables or disables downloading embedded SATA option ROM. Disable
means you cannot boot from SATA devices, but more option ROM space is
available for other devices.

  SATA RAID (Enable/Disable)

Enables or disables SATA drives for a RAID. If disabled, a single line is
displayed. If enabled, the menu expands to allow enabling/disabling each
SATA port.

  Num Lock State at Power-On (Off/On)

Sets the keyboard Num Lock state after POST. The Operating System can
change this state, also.

  S5 Wake on LAN (Enable/Disable)

Allows the network to wake the system from shutdown (ACPI S5). When set
to Disable, system power consumption is reduced to match Federal Energy
Management Program (FEMP) guidelines.

  Unique Sleep State Blink Rates (Enable/Disable)

Assigns different LED blink patterns for S1 and S3. (The system LED is off for
S4 and S5.)

  Monitor Tracking (Enable/Disable)

Enabling this option allows the ROM to save the monitor asset tracking
information such as the serial number and model.

Table 4-1  Computer Setup Utility menu descriptions (continued)
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Heading Option Description

 Slot Options Modifies options for:

● Slot 1—PCI Express x8

● Slot 2—PCI Express x16 graphics

● Slot 3—PCI 32 bit, 33 MHz

● Slot 4—PCI Express x16 (x8)

● Slot 5—PCI Express x16 graphics

● Slot 6—PCI-X 100

● Slot 7—PCI-X 100/133

For PCI Express slots, the available option is Option ROM Download.

For PCI and PCI-X slots, the available options are Option ROM Download
and Latency Timer.

* Available on select models.

** These options should be used by advanced users only.

Desktop management
HP Client Management Solutions (available for download from http://www.hp.com/go/easydeploy)
provides standards-based solutions for managing and controlling workstations in a networked
environment. This section summarizes the capabilities and features of desktop management key
components:

● Initial configuration and deployment on page 36

● Remote system installation on page 37

● Managing and updating software on page 37

● ROM flash on page 39

● Asset tracking and security on page 43

● Fault notification and recovery on page 49

NOTE: Support for specific features described in this guide might vary by model or software version.

Initial configuration and deployment
The workstation comes with a preinstalled system software image. After a brief software unbundling
process, the workstation is ready to use.

You might prefer to replace the preinstalled software image with a customized set of system and
application software. There are several methods for deploying a customized software image, including:

● Installing additional software applications after unbundling the preinstalled software image.

● Using software deployment tools, such as Altiris® Deployment Solutions™, to replace the
preinstalled software with a customized software image.

● Using a disk cloning process to copy the contents from one hard drive to another.

Table 4-1  Computer Setup Utility menu descriptions (continued)
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The best deployment method depends on your information technology environment and processes. The
PC Deployment section of the HP Lifecycle Solutions website (http://whp-sp-orig.extweb.hp.com/
country/us/en/solutions.html) provides information to help you select the best deployment method.

The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with recovery
of system software, configuration management and troubleshooting, and power management.

Remote system installation
Remote System Installation enables you to start and set up your system using the software and
configuration information located on a network server. This feature is usually used as a system setup
and configuration tool, and can be used for the following tasks:

● Deploying a software image on one or more new PCs

● Formatting a hard drive

● Installing application software or drivers

● Updating the operating system, application software, or drivers

To initiate Remote System Installation, press F12 when F12=Network Service Boot appears in the
lower-right corner of the HP logo screen. Follow the onscreen instructions to continue the process. The
default boot order is a BIOS configuration setting that can be changed to always attempt to PXE boot.

HP and Altiris have partnered to provide tools designed to make the task of corporate PC deployment
and management easier and less time-consuming, ultimately lowering the total cost of ownership and
making HP PCs the most manageable client PCs in the enterprise environment.

Managing and updating software
HP provides several tools for managing and updating software on desktops and workstations—HP Client
Manager Software, Altiris Client Management Solutions, System Software Manager, Proactive Change
Notification, and Subscriber’s Choice.

HP Client Manager software
HP Client Manager Software (HP CMS) assists you in managing the hardware aspects of your client
workstations with features that include:

● Detailed views of hardware inventory for asset management

● PC health check monitoring and diagnostics

● Proactive notification of changes in the hardware environment

● Web-accessible reporting of business-critical details such as machines with thermal warnings,
memory alerts, and more

● Remote updating of system software such as device drivers and ROM BIOS

● Remote changing of boot order

● Configuring the system BIOS settings

For more information on the HP Client Manager, see http://www.hp.com/go/ssm.
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Altiris Client Management solutions
HP and Altiris have partnered to provide comprehensive, tightly integrated systems management
solutions to reduce the cost of owning HP client PCs. HP Client Manager Software is the foundation for
additional Altiris Client Management Solutions that address:

● Inventory and asset management

◦ Software license compliance

◦ PC tracking and reporting

◦ Lease contract and fixed asset tracking

● Deployment and migration

◦ System deployment

◦ Personality migrations

● Help desk and problem resolution

◦ Managing help desk tickets

◦ Remote troubleshooting

◦ Remote problem resolution

◦ Client disaster recovery

● Software and operations management

◦ Ongoing desktop management

◦ HP system software deployment

◦ Application self-healing

See http://www.hp.com/go/ssm for more information about:

● How HP Client Manager Software works

● Which solutions are compatible with your operating system

● How to download a fully-functional, 30-day evaluation version of the Altiris solutions

System Software Manager
System Software Manager (SSM) is a utility that enables you to update system-level software on multiple
systems simultaneously. When executed on a PC client system, SSM detects both hardware and
software versions and then updates the appropriate software from a central repository, also known as
a file store. Driver versions that are supported by SSM are denoted with a special icon on the software,
the driver download website, and the Support Software CD. To download the utility or to obtain more
information on SSM, see http://www.hp.com/go/ssm.
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Proactive Change Notification
The Proactive Change Notification program uses the Subscriber's Choice website to proactively and
automatically send you:

● Proactive Change Notification (PCN) emails informing you of hardware and software changes to
most commercial workstations and servers, up to 60 days in advance.

● Emails containing Customer Bulletins, customer advisories, customer notes, security bulletins, and
driver alerts for most commercial workstations and servers.

You create your own profile to ensure that you only receive the information relevant to a specific IT
environment. To learn more about the Proactive Change Notification program and create a custom
profile, see http://www.hp.com/go/pcn.

Subscriber’s Choice
Subscriber’s Choice is a client-based service from HP. Based on your profile, HP supplies you with
personalized product tips, feature articles, and driver and support alerts and notifications. Subscriber’s
Choice Driver and Support Alerts/Notifications deliver emails notifying you that the information you
subscribed to in your profile is available for review and retrieval. To learn more about Subscriber’s
Choice and create a custom profile, see http://www.hp.com/go/pcn.

ROM flash
The workstation comes with a programmable flash ROM. By establishing a setup password in the
Computer Setup Utility, you can protect the ROM from being unintentionally updated or overwritten,
which is important to ensure the operating integrity of the workstation. Should you need or want to
upgrade the ROM, you can:

● Order an upgraded ROMPaq diskette from HP.

● Download the latest ROMPaq images from HP driver and support page, http://www.hp.com/
support/files.

NOTE: For maximum ROM protection, be sure to establish a setup password. The setup password
prevents unauthorized ROM upgrades. System Software Manager enables you to set the setup
password on one or more PCs simultaneously. For more information, see http://www.hp.com/go/ssm.

Remote ROM flash
Remote ROM Flash enables you to safely upgrade the ROM on remote HP workstations directly from
the centralized network management console. Performing this task remotely on multiple workstations
and personal computers results in a consistent deployment of and greater control over HP ROM images
over the network. It also results in greater productivity and lower total cost of ownership.

The workstation must be powered on to use Remote ROM Flash.

For more information on Remote ROM Flash, see the HP Client Manager Software or System Software
Manager at http://www.hp.com/go/ssm.

HPQFlash
The HPQFlash utility is used to locally update or restore the system ROM on individual workstations
through a Windows operating system.

For more information on HPQFlash, see http://www.hp.com/support/files and enter the name of your
workstation when prompted.
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FailSafe Boot Block ROM
The FailSafe Boot Block ROM allows for system recovery in the unlikely event of a ROM flash failure,
for example, if a power failure occurs during a ROM upgrade. The Boot Block is a protected section of
the ROM that checks for a valid system ROM flash when the system is powered on.

NOTE: System recovery can use a removable medium such as a diskette, CD, or USB.

● If the system ROM is valid, the system starts normally.

● If the system ROM fails the validation check, the FailSafe Boot Block ROM provides enough support
to start the system from a ROMPaq removable medium which will program the system ROM with
a valid image.

NOTE: Workstation models that support recovery from a ROMPaq CD provide ISO ROMPaq images
in the downloadable ROM SoftPaq.

When the Boot Block detects an invalid system ROM, the System Power LED blinks red eight times,
once every second, followed by a two-second pause. Also, you will hear eight beeps that correspond
to the blinks. A Boot Block recovery mode message is displayed on the screen (some models).

To recover the system after it enters Boot Block recovery mode:

1. If a removable medium is loaded in the workstation, remove it and power down the workstation.

2. Insert the appropriate ROMPaq removable medium in the workstation.

3. Power on the workstation.

If no ROMPaq removable medium is found, you are prompted to insert one and restart the
workstation.

If a setup password has been established, the Caps Lock light illuminates and you are prompted
to enter the password.

4. Enter the setup password.

If the system successfully starts from the removable medium and successfully reprograms the
ROM, the three keyboard lights illuminate.

5. Remove the removable medium and restart the system.

The following table lists the various keyboard light combinations used by the Boot Block ROM (when a
PS2 keyboard is attached to the workstation) and explains the meaning and action associated with each
combination.

Table 4-2  PS2 keyboard light combinations used by Boot Block ROM

Light * State Description

FailSafe
Boot Block
Mode

Keyboard LED
Activity

State/Message

Num Lock On ROMPaq diskette or ROMPaq CD not present, is bad, or
drive not ready

Caps Lock On Enter password

Num, Caps,
Scroll Lock

Blink On in
sequence, one at a
time—N,C, SL

Keyboard locked in network mode
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Light * State Description

FailSafe
Boot Block
Mode

Keyboard LED
Activity

State/Message

Num, Caps,
Scroll Lock

On Boot Block ROM Flash successful.

* Diagnostic lights do not flash on USB keyboards.

Replicating the setup
The following procedures enable you to easily copy one setup configuration to other workstations of the
same model to provide faster, more consistent configuration of multiple workstations.

NOTE: Setup configuration procedures require a diskette or a USB such as an HP DriveKey.

To collect and replicate BIOS settings on multiple computers, use System Software Manager or HP
Client Manager Software. For more information, see http://www.hp.com/go/easydeploy.

Copying to a single workstation

CAUTION: A setup configuration is model-specific. File system corruption can result if the source and
target workstations are not the same model. For example, do not copy the setup configuration from an
HP xw6200 Workstation to an HP xw9400 Workstation.

1. Select a setup configuration to copy, then shut down the workstation.

2. Reboot the workstation.

3. As soon as the screen illuminates, press and hold the F10 key until you enter the Computer Setup
Utility. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

If you are using a PS2 keyboard, disregard the keyboard error message that might appear.

4. Insert the configuration diskette or USB.

5. Click File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette or USB.

6. Power off the workstation to be configured and insert the diskette or USB.

7. Power on the workstation to be configured.

8. As soon as the screen illuminates, press and hold the F10 key until you enter the Computer Setup
Utility. Press Enter to bypass the title screen, if necessary.

9. Click File>Replicated Setup>Restore from Removable Media, and follow the instructions on the
screen.

10. Restart the workstation when the configuration is complete.

Copying to multiple workstations

CAUTION: A setup configuration is model-specific. File system corruption can result if the source and
target workstations are not the same model. For example, do not copy the setup configuration from an
HP xw6200 Workstation to an HP xw9400 Workstation.

Table 4-2  PS2 keyboard light combinations used by Boot Block ROM (continued)
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This method takes a little longer to prepare the configuration diskette or USB, but copying the
configuration to target workstations is significantly faster.

NOTE: A bootable diskette or USB is required for this procedure. If Windows XP is not available to
create a bootable diskette or USB, use the method for copying to a single workstation instead (see
Copying to a single workstation on page 41).

1. Create a bootable diskette or USB.

2. Select a setup configuration to copy, then shut down the workstation.

3. Power on the workstation.

4. As soon as the screen illuminates, press and hold the F10 key until you enter the Computer Setup
Utility. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

If you are using a PS2 keyboard, disregard the keyboard error message that might appear.

5. Insert the diskette or USB.

6. Click File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen
to create the configuration diskette or USB.

7. Download a BIOS utility for replicating setup (repset.exe), and copy it onto the configuration diskette
or USB. To obtain this utility, go to http://www.hp.com/support/files and enter the model number of
the workstation.

8. On the configuration diskette or USB, create an autoexec.bat file containing the following
command: repset.exe cpqsetup.txt.

9. Power off the workstation to be configured. Insert the configuration diskette or USB and power on
the workstation. The configuration utility runs automatically.

10. Restart the workstation when the configuration is complete.

Dual-state power button
With ACPI enabled, the power button can function either as an on/off switch or as a sleep button. The
feature does not completely remove the power, but instead causes the workstation to enter a low-power
standby state. This feature enables you to power off without closing applications and to return to the
same operational state without any data loss.

To change the power button configuration:

1. Click Start, and select Control Panel>Power Options.

2. In Power Options Properties, click the Advanced tab.

3. In the Power Button section, select Hibernate or Standby. (Hibernate must be enabled in the
Hibernate tab to use this option.)

After configuring the power button to function as a Hibernate/Standby button, press the power button
to put the system in a very low power state. Press the button again to bring the system to full power
status.

To completely remove all power to the system, press and hold the power button for four seconds.

CAUTION: Do not use the power button to power off the workstation unless the system is not
responding. Powering off the power without operating system interaction can cause damage to or loss
of data on the hard drive.
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Worldwide web site
HP engineers rigorously test and debug software developed by HP and third-party suppliers, and
develop operating system specific support software, to ensure performance, compatibility, and reliability
for HP workstations.

When making the transition to new or revised operating systems, it is important to implement the support
software designed for that operating system. If you plan to run a version of Microsoft Windows that is
different from the version included with the workstation, you must install corresponding device drivers
and utilities to ensure that all features are supported and functioning properly.

HP has made the task of locating, accessing, evaluating, and installing the latest support software easier.
You can download the software from http://www.hp.com/support. The Web site contains the latest
device drivers, utilities, and flashable ROM images needed to run the latest Microsoft Windows operating
system on the HP workstation.

Building blocks and partners
HP management solutions integrate with other systems management applications, and are based on
industry standards, such as:

● Web-Based Enterprise Management (WBEM)

● Windows Management Interface (WMI)

● Wake on LAN technology

● ACPI

● SMBIOS

● Pre-boot Execution Environment (PXE) support

● Alert Standard Format

Asset tracking and security
Asset tracking features incorporated into the workstation provide key asset tracking data that can be
managed using HP Systems Insight Manager, HP Client Manager Software, or other system
management applications. Seamless, automatic integration between asset tracking features and these
products enables you to choose the management tool that is best suited to the environment and to
leverage the investment in existing tools.

HP also offers several solutions for controlling access to valuable components and information.
ProtectTools Embedded Security, if installed, prevents unauthorized access to data, checks system
integrity, and authenticates third-party users attempting system access. Security features such as
ProtectTools and the Hood Sensor (Smart Cover Sensor) help to prevent unauthorized access to your
data and to the internal components of the workstation. By disabling parallel, serial, or USB ports, or by
disabling removable media boot capability, you can protect valuable data assets. Memory Change and
Hood Sensor (Smart Cover Sensor) alerts can be automatically forwarded to system management
applications to deliver proactive notification of tampering with a workstation’s internal components.

NOTE: ProtectTools, the Hood Sensor (Smart Cover Sensor), and the Hood Lock (Smart Cover Lock)
are available as options on select systems.

Use the following utilities to manage security settings on the HP workstation:

● Computer Setup (F10) Utility (local).

● HP Client Manager Software or System Software Manager (remote). This software enables the
secure, consistent deployment and control of security settings from a simple command line utility.
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The following table and sections refer to managing security features of the workstation locally through
the Computer Setup Utility.

Table 4-3  Security features overview

Feature Purpose How It Is Established

Removable Media Boot
Control

Prevents booting from the
removable media drives.

Computer Setup Utility Menu.

Serial, Parallel, USB,
or Infrared Interface
Control

Prevents transfer of data through the
integrated serial or USB interfaces.

Computer Setup Utility menu.

Power-On Password Prevents use of the workstation until
the password is entered. This can
apply to both initial system startup
and restarts.

Computer Setup Utility menu.

Setup Password Prevents reconfiguration of the
workstation (use of the Setup -
Utilities) until the password is
entered.

Computer Setup Utility menu.

Network Server Mode Provides unique security features for
workstations being used as servers.

Computer Setup Utility menu.

Ownership Tag Displays ownership information, as
defined by the system administrator,
during system startup (protected by
setup password).

Computer Setup Utility menu.

Kensington Cable Lock
Provision

Prevents entire system theft only. Install a Kensington cable
lock to secure the workstation
to a fixed object.

Padlock Loop Prevents access panel from being
removed. This loop can also be used
to secure the unit to a fixed object.

Install a padlock.

Access Panel Key Lock
(Standard)

Prevents removal of the access
panel and all internal components
including optical and floppy drives

Lock the access panel.

Universal Chassis Clamp
Lock (Optional)

The version without a cable
discourages access panel removal
and prevents the theft of I/O devices.
The version with a cable additionally
prevents entire system theft and
allows multiple systems to be
secured with a single cable.

Install a chassis clamp lock.

Hood Sensor Notifies a local or remote user when
the chassis access panel has been
opened.

Install an intrusion sensor.

NOTE: For more information about the Computer Setup Utility, see Computer Setup (F10) Utility menu on page 28.

Password security
The power-on password prevents unauthorized use of the workstation by requiring entry of a password
to access applications or data each time the workstation is turned on or restarted. The setup password
specifically prevents unauthorized access to the Computer Setup Utility and can also be used as an
override to the power-on password. That is, when prompted for the power-on password, entering the
setup password instead will allow access to the workstation.
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A network-wide setup password can be established to enable the system administrator to log in to all
network systems to perform maintenance without having to know the power-on password.

NOTE: System Software Manager and HP Client Manager Software allow remote management of
setup passwords and other BIOS settings in a networked environment. For more information, see
http://www.hp.com/go/easydeploy.

Establishing a setup password in the Computer Setup (F10) Utility

Establishing a setup password through the Computer Setup Utility prevents reconfiguration of the
workstation (through use of the Computer Setup Utility) until the password is entered.

To establish a setup password using workstation setup:

1. Power on or restart the workstation.

2. As soon as the screen illuminates, press and hold F10 until you enter the Computer Setup Utility.
Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

If you are using a PS2 keyboard, disregard the keyboard error message that might appear.

3. Select Security>Setup Password, and follow the onscreen instructions.

4. Before exiting, select File>Save Changes and Exit.

Establishing a power-on password in the Computer Setup (F10) Utility

Establishing a power-on password through the Computer Setup Utility prevents access to the
workstation when power is on, unless the password is entered. When a power-on password is set, the
Computer Setup Utility presents Password Options under the Security menu. The password options
include Network Server Mode and Password Prompt on Warm Boot.

When Network Server Mode is disabled, the password must be entered each time the workstation is
powered on when the key icon appears on the monitor.When Password Prompt on Warm Boot
is enabled, the password must also be entered each time the workstation is rebooted. When Network
Server Mode is enabled, the password prompt is not presented during POST, but any attached PS2
keyboard remains locked until the power-on password is entered.

To enable Network Server Mode, a power-on password must be set. The option then shows up
under Advanced>Password Options. This feature allows the system to boot without asking for the
power-on password, but the keyboard and mouse are locked until you enter it. The keyboard LEDs
rotate constantly when the system is in locked mode

To establish a power-on password through workstation setup:

1. Power on or restart the workstation.

2. As soon as the screen illuminates, press and hold the F10 until you enter the Computer Setup
Utility. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

If you are using a PS2 keyboard, disregard the keyboard error message that might appear.

3. Select Security>Power-On Password, and follow the onscreen instructions.

4. Before exiting, select File>Save Changes and Exit.
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Entering a power-on password

To enter a power-on password:

1. Power on or restart the workstation.

2. When the key icon appears on the monitor, enter the current password, and press Enter.

NOTE: Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must restart the workstation before you can continue.

Entering a setup password

If a setup password has been established on the workstation, you will be prompted to enter it each time
you run the Computer Setup Utility.

To enter a setup password:

1. Power on or restart the workstation.

2. As soon as the screen illuminates, press and hold the F10 key until you enter the Computer Setup
Utility. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation
and press and hold the F10 key again to access the utility.

If you are using a PS2 keyboard, disregard the keyboard error message that might appear.

3. When the key icon appears on the monitor, enter the setup password, and press Enter.

NOTE: Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful
tries, you must restart the workstation, before you can continue.

Changing a power-on or setup password

To change a power-on or setup password:

1. Power on or restart the workstation.

2. As soon as the screen illuminates, press and hold the F10 key until you enter the Computer Setup
Utility. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the workstation and press
and hold the F10 key again to access the utility.

If you are using a PS2 keyboard, disregard the keyboard error message that might appear.

3. When the key icon appears, enter the current password, a slash (/) or alternate delimiter character,
your new password, another slash (/) or alternate delimiter character, and your new password again
as shown: current password/new password/new password

NOTE: Type carefully. For security reasons, the characters you enter do not appear on the
screen.

4. Press Enter.

The new password takes effect the next time you power on the workstation.
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NOTE: See the table of National keyboard delimiter characters on page 47 for information about the
alternate delimiter characters. The power-on password and setup password can also be changed using
the Security menu in the Computer Setup Utility.

Deleting a power-on or setup password
To delete a power-on or setup password:

1. Power on or restart the workstation.

2. To delete the power-on password, go to step 3.

To delete the setup password, as soon as the screen illuminates, press and hold the F10 key until
you enter the Computer Setup Utility. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the computer
and press and hold the F10 key again to access the utility.

Use the appropriate operating system shutdown process.

3. When the key icon appears, enter your current password followed by a slash (/) or alternate
delimiter character as shown: current password/.

4. Press Enter.

NOTE: See the National keyboard delimiter characters on page 47 for information about the
alternate delimiter characters. The power-on password and setup password can also be changed using
the Security menu in the Computer Setup Utility.

National keyboard delimiter characters

Each keyboard is designed to meet country-specific requirements. The syntax and keys that you use
for changing or deleting your password depend on the keyboard that came with your workstation.

Table 4-4  National keyboard delimiter characters

Arabic / Greek - Russian /

Belgian = Hebrew . Slovakian -

BHCSY* - Hungarian - Spanish -

Brazilian / Italian - Swedish/Finnish /

Chinese / Japanese / Swiss -

Czech - Korean / Taiwanese /

Danish - Latin American - Thai /

French ! Norwegian - Turkish .

French
Canadian

é Polish - U.K. English /

German - Portuguese - U.S. English /
* For Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia.

Clearing passwords

If you forget your password, you cannot access the workstation. See Resetting the password jumper
on page 189 for instructions on clearing passwords.
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Hood sensor (Smart Cover Sensor)
The optional hood sensor is a combination of hardware and software technology that can alert you when
the workstation side access panel has been removed. There are three levels of protection, as described
in the following table.

Table 4-5  Hood sensor protection levels *

Level Setting Description

Level 0 Disabled Hood sensor is disabled (default).

Level 1 Notify User When the workstation is restarted, the
screen displays a message indicating that
the workstation side access panel has been
removed.

Level 2 Setup Password When the workstation is restarted, the
screen displays a message indicating that
the workstation side access panel has been
removed. You must enter the setup
password to continue.

* These settings can be changed using the Computer Setup Utility.

Setting the hood sensor protection level

To set the hood sensor protection level:

1. Power on or restart the workstation.

2. As soon as the screen illuminates, press and hold the F10 key until you enter the Computer Setup
Utility. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the computer
and press and hold the F10 key again to access the utility.

If you are using a PS2 keyboard, disregard the keyboard error message that might appear.

3. Select Security>Smart Cover>Cover Removal Sensor, then side access panel, and follow the
onscreen instructions.

4. Select File>Save Changes and Exit.

Cable lock provision (optional)
The rear panel of the chassis can accommodate a cable lock accessory that allows the workstation to
be physically secured to a work area.

Security lock (optional)
This optional feature prevents entire system theft and discourages access panel removal.

Universal chassis clamp lock (optional)
The version without a cable discourages access panel removal and prevents theft of I/O devices. The
version with a cable also prevents entire system theft and allows multiple systems to be secured with a
single cable.
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Access panel key lock
This lock prevents removal of the access panel and all internal components. The key is shipped on the
rear of the workstation.

Fault notification and recovery
Fault notification and recovery features combine innovative hardware and software technology to
prevent the loss of critical data and minimize unplanned downtime.

If the workstation is connected to a network managed by HP Client Manager software, the computer
sends a fault notice to the network management application. With HP Client Manager software, you can
also remotely schedule diagnostics to automatically run on all managed PCs and create a summary
report of failed tests.

Drive Protection System
The Drive Protection System (DPS) is a diagnostic tool built into the hard drives installed in select HP
workstations. DPS is designed to help diagnose problems that might result in unwarranted hard drive
replacement.

When HP workstations are built, each installed hard drive is tested using DPS, and a permanent record
of key information is written onto the drive. Each time DPS is run, test results are written to the hard
drive. The service provider can use this information to help diagnose conditions that caused you to run
the DPS software.

ECC fault prediction and pre-failure warranty
When the workstation encounters an excessive number of error checking and correcting (ECC) memory
errors, it displays a Local Alert message. This message contains detailed information about the errant
memory module, enabling you to take action before you experience un-correctable memory errors. The
pre-failure warranty for ECC memory modules enables you to replace these modules, free of charge,
before the modules actually fail. ECC memory modules are supported on current HP workstations.

Thermal sensors
A thermal sensor is a hardware and software feature that tracks temperature. When combined with HP
Client Manager Software, a thermal sensor notifies the network administrator when a normal
temperature range is exceeded. For example, a thermal sensor monitors processor temperature. If
processor temperature remains too high, the system eventually shuts down.
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5 Removal and replacement procedures

This chapter describes removal and replacement procedures of most internal components.

● Warnings and cautions on page 50

● Service considerations on page 51

● Customer Self Repair on page 55

● Pre-disassembly procedures on page 55

● System board components on page 56

● System board architecture on page 57

● Removing and replacing components on page 58

● Product recycling on page 121

Warnings and cautions
WARNING!  Any surface or area of the equipment marked with this symbol indicates the presence
of a hot surface or hot component. If this surface is contacted, the potential for injury exists. To reduce
the risk of injury from a hot component, enable the surface to cool before touching.

WARNING!  Any surface or area of the equipment marked with this symbol indicates the presence
of an electrical shock hazard. To reduce the risk of injury from electrical shock, do not open any enclosed
area marked with this symbol.

WARNING! To reduce the risk of electric shock or damage to your equipment:

— Do not disable the power cord grounding plug. The grounding plug is an important safety feature.

— Plug the power cord in a grounded (earthed) outlet that is easily accessible at all times.

— Disconnect power from the equipment by unplugging the power cord from the electrical outlet.

WARNING! To reduce the risk of serious injury, read the Safety & Comfort Guide. It describes proper
workstation setup, posture, health, and work habits for computer users, and provides important electrical
and mechanical safety information. This guide is located at http://www.hp.com/ergo and on the
documentation CD (if one is included with the product).

WARNING! If a product is shipped in packaging marked with this symbol, , the product must always

be lifted by two persons to avoid personal injury due to product weight.

CAUTION: Static electricity can damage the electronic components of the workstation. Before
beginning these procedures, be sure you discharge static electricity by briefly touching a grounded metal
object.
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CAUTION: Observe the following cautions when removing or replacing a processor:

— Installing a processor incorrectly can damage the system board. Contact an HP authorized reseller
or service provider to install the processor. If you plan to install the processor yourself, read all of the
instructions carefully before you begin.

— Failure to follow the workstation preparation instructions can result in an improperly installed
processor, causing extensive workstation damage.

— Processor socket pins are delicate and bend easily. Use extreme care when placing the processor
in the socket.

CAUTION: To prevent damage to the workstation, observe the following Electrostatic Discharge
(ESD) precautions while performing the system parts removal and replacement procedures:

— Work on a static-free mat.

— Wear a static strap to ensure that any accumulated electrostatic charge is discharged from your body
to the ground.

— Create a common ground for the equipment you are working on by connecting the static-free mat,
static strap, and peripheral units to that piece of equipment.

NOTE: HP accessories are for use in HP Workstation products. They have been extensively tested
for reliability and are manufactured to high quality standards.

Service considerations
The following sections discuss service considerations that should be reviewed and practiced before
removing and replacing any system components.

WARNING! When lifting or moving the workstation, do not use the front bezel as a handle or lifting
point. Lifting the workstation from the front bezel or lifting it incorrectly can cause the unit to fall and harm
the user and damage the workstation. To properly and safely lift the workstation, lift it from the bottom
of the unit.

Read cautions, warnings, and safety precautions
For your safety, review the cautions, warnings, and safety precautions before accessing the components
of the workstation. Also, review the Safety and Regulatory Guide that came with your workstation for
more information.

WARNING! Some parts inside the computer will be hot. Power off and unplug the system, and wait
three to five minutes for them to cool before opening the system access panels or touching internal
components.

Electrostatic discharge information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) might not appear to be affected at all and can work
perfectly throughout a normal cycle. The device can function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.
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Generating static
The following table shows that different activities generate different amounts of static electricity. Static
electricity increases as humidity decreases.

Table 5-1  Static electricity

 Relative Humidity

Event 5% 4% 1%

Walking across carpet

Walking across vinyl floor

Motions of bench worker

7,500 V

3,000 V

400 V

15,000 V

5,000 V

800 V

35,000 V

12,000 V

6,000 V

Removing bubble pack from PCB

Packing PCBs in foam-lined box

7,000 V

5,000 V

20,000 V

11,000 V

26,500 V

21,000 V

CAUTION: 700 volts can degrade a product.

Preventing electrostatic damage to equipment
Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories.

● Transport products in static-safe containers, such as tubes, bags, or boxes, to avoid hand contact.

● Protect all electrostatic parts and assemblies with conductive or approved containers or packaging.

● Keep electrostatic-sensitive parts in their containers until they arrive at static-free stations.

● Place items on a grounded surface before removing them from their containers.

● When handling or touching a sensitive component or assembly, ground yourself by touching the
chassis.

● Avoid contact with pins, leads, or circuitry.

● Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive
foam.
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Personal grounding methods and equipment
Use the following equipment to prevent static electricity damage to equipment:

● Wrist straps are flexible straps with a maximum of one megohm ± 10% resistance in the ground
cords. To provide a proper ground, wear the strap against bare skin. The ground cord must be
connected and fit snugly into the banana plug connector on the grounding mat or workstation.

● Heel straps, toe straps, and boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both
feet with a maximum of one-megohm ± 10% resistance between the operator and ground.

Table 5-2  Static shielding protection levels

Method Voltage

Antistatic plastic

Carbon-loaded
plastic

Metallized
laminate

1,500

7,500

15,000

Grounding the work area
To prevent static damage at the work area:

● Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

● Use static-dissipative mats, foot straps, or air ionizers to give added protection.

● Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

● Turn off power and input signals before inserting and removing connectors or test equipment

● Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

● Keep work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended materials and equipment
It is recommended that the following materials and equipment be used to prevent static electricity:

● Antistatic tape

● Antistatic smocks, aprons, or sleeve protectors

● Conductive bins and other assembly or soldering aids

● Conductive foam

● Conductive tabletop workstations with ground cord of one-megohm ± 10% resistance

● Static-dissipative table or floor mats with hard tie to ground

● Field service kits

● Static awareness labels
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● Wrist straps and footwear straps providing one-megohm ± 10% resistance

● Material handling packages

● Conductive plastic bags and tubes

● Conductive tote boxes

● Opaque and transparent metallized shielded bags

● Transparent shielding tubes

Required tools and software
The following tools and software are required to service your workstation:

● Torx T-15 screwdriver or flathead screwdriver

● Diagnostics software

Screws
The screws used in the workstation are not interchangeable. They might have standard or metric threads
and might be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with
the removed part and then returned to their proper locations.

Special handling of components
The following components require special handling when servicing the workstation.

Cables and connectors
Cables must be handled with care to avoid damage. Apply only the tension required to seat or unseat
the cables during insertion or removal from the connector. Handle cables by the connector or pull strap
whenever possible. In all cases, avoid bending or twisting the cables, and be sure that the cables are
routed in such a way that they cannot be caught or snagged by parts being removed or replaced.

CAUTION: When servicing this workstation, be sure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the workstation.

Hard drives
Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
guideline applies to failed drives and replacement spares. Keep the following guidelines in mind as well:

● If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

● Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the workstation.

● Avoid dropping drives from any height onto any surface.

● If you are inserting or removing a hard drive, power off the workstation. Do not remove a hard drive
while the workstation is on.

● Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector. For more information about preventing electrostatic damage, see
Electrostatic discharge information on page 51.
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● Do not use excessive force when inserting a drive.

● Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

Lithium coin cell battery
The battery that comes with the workstation provides power to the real-time clock and has a minimum
lifetime of about three years.

For instructions on battery removal and replacement, see Battery on page 88.

WARNING! This workstation contains a lithium battery. A risk of fire and chemical burn exists if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose of
in water or fire, or expose it to temperatures higher than 140 degrees F (60 degrees C).

NOTE: Batteries, battery packs, and accumulators should not be disposed of with general household
waste.

Customer Self Repair
Customer Self Repair (CSR) enables you to obtain replacement parts and install them yourself on your
workstation. See http://www.hp.com/go/selfrepair/ for more information.

Pre-disassembly procedures
After shutdown, perform the following steps before servicing the workstation:

1. Remove or disengage any security devices that prohibit opening the workstation.

2. Close any open software applications.

3. Remove any diskettes or CDs from the workstation.

4. Exit the operating system.

5. Shut down the workstation and any peripheral devices that are connected to it.

6. Disconnect the power cord from the electrical outlet and then from the workstation.

7. Disconnect all peripheral device cables from the workstation.
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System board components
The following image shows the system board connectors and sockets on the HP xw9400 Workstation.

Figure 5-1  System board identification

Table 5-3  System board components

Ite
m

Description Item Description Item Description Item Description

1 Main power 13 Memory fan 25 Front control
panel

37 Primary IDE**

2 Memory module
pairs

14 PCI Express x16
(x8
performance)*

26 Front USB 38 Diskette drive

3 Voltage
regulator fan
(Liquid Cooling
Unit)

15 PCI Express x16
graphics

27 Internal USB 0 39 Clear CMOS
button

4 CPU1 16 PCI 32 bit, 33
MHz

28 Serial SCSI
(SAS)

40 Internal USB 1

5 Serial 17 PCI Express x16
(x8
performance)*

29 PCI-X speed
jumper

41 Processor power

6 SPDIF Out 18 PCI Express x16 30 Spare 12V fan 42 CPU0 fan

7 PS/2 keyboard/
mouse

19 PCI-X 100 31 Spare 12V fan 43 Fan detection
jumper

8 IEEE 1394/USB 20 PCI-X 100/133 32 Serial ATA
(SATA)

44 Battery
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Ite
m

Description Item Description Item Description Item Description

9 LAN/USB 21 CD audio 33 Hard disk activity
LED

45 CPU0

10 Chassis fan 22 Auxiliary audio 34 Password
jumper

46 CPU1 fan

11 LAN/USB 23 Front audio 35 Crisis recovery
jumper

47 Memory power

12 Audio 24 Front IEEE 1394 36 PCI fan   

* The PCI Express x16 is a PCI Express x16 connector that has x8 bandwidth.

** The Primary IDE connector is generally used for optical drives.

System board architecture
The following image shows the HP xw9400 Workstation block diagram.

Figure 5-2  System board block diagram

Table 5-3  System board components (continued)
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Removing and replacing components
This section discusses the procedures necessary to remove and install various hardware components
on your workstation.

Before servicing or upgrading your workstation:

1. Review the safety precautions and the Service considerations on page 51, as well as the Safety
and Regulatory Information.

2. Locate and clear a suitable work area.

3. Shut down the system and remove power from the unit.

4. Gather your tools.

5. Remove all security devices.

6. Service your unit.

7. Restore power to your unit.

NOTE: Prior to removing and replacing a component, make sure you remove all installed components
that obstruct or prevent the removal of the component.

If you are unsure how to remove a particular component, please do one of the following:

1. Refer to the appropriate section in this chapter.

2. If the content you desire is not referenced in this chapter, see www.hp.com/support/
xw9400_manuals and look under “Setup and Install – General” for instructions.

3. See the manufacturer’s web site for instructions for a third party (non-HP) component.
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Disassembly order
Use the following table to determine the sequence in which to remove the major components.

        

Pre-disassembly (Pre-
disassembly
procedures
on page 55)

Locks (Security lock
(optional)
on page 61)

Access panel (Access panel
on page 63)

 Hood sensor (Hood
sensor (Smart cover
sensor) on page 65)

    

Front bezel (Front
bezel on page 64)

Front panel I/O device assembly
(Front panel I/O device
assembly on page 66)

Power button and
front speaker
(Power button
assembly and
system speaker
on page 67)

Optical drive (Optical
drive on page 90)

Diskette drive
(Diskette drive
(optional)
on page 93)

Bezel blanks (Bezel
blanks on page 64)

  Power supply (Power
supply on page 69)

    

  System fan (System
fan on page 70)

    

  Memory fan (Memory
fan on page 71)

    

Memory (Memory
on page 72)

Front fan removal
(optional) (Front fan
removal
on page 84)

Battery (Battery
on page 88)
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Hard drive (Hard
drive on page 95)

CPU heatsink (Removing the
CPU heatsink on page 113)

Processor
(Removing the
processor
on page 117)

PCI retainer (PCI retainer
on page 78)

PCI retention clamp
(PCI retention
clamp on page 80)

PCI or PCI Express card
(Removing PCI or PCI Express
cards on page 82)

CPU heatsink
(Removing the CPU
heatsink
on page 113)

Processor
(Removing the
processor
on page 117)

System board
(System board
on page 120)
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Security lock (optional)
If a security padlock is installed, remove it before servicing the unit. To remove the padlock, unlock it
and slide it out of the padlock loop as shown in the following image.

Figure 5-3  Removing the security lock

Cable lock (optional)
If a cable lock is installed, remove it before servicing the unit. To remove the cable lock, unlock it and
pull it out of the cable lock slot as shown in the following image.

Figure 5-4  Removing the cable lock
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Universal chassis clamp lock (optional)
If a universal chassis clamp lock is installed, remove it before servicing the unit.

To remove the lock:

1. Unlock the device and remove the locking mechanism.

2. Remove the screw attaching the lock to the chassis.
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Access panel
Before accessing the internal components of the workstation, the access panel must be removed.

To remove the access panel:

WARNING! Before removing the workstation access panel, be sure that the workstation is powered
off and that the power cord is disconnected from the electrical outlet.

1. Disconnect power from the system.

2. If a lock is present, unlock the access panel. The keys are on the rear panel (Rear panel
components on page 4). Also, unlock any other locks that are present (Kensington, or Padlock).

3. Pull up on the handle and lift off the cover.

Figure 5-5  Opening the access panel

To replace the access panel, align the bottom groove of the access panel with the bottom edge of the
chassis. Rotate the access panel toward the chassis and press firmly until the latch engages.
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Front bezel
To remove the front bezel:

1. Lift up on the three (1) tabs located on the front bezel.

2. Rotate the front bezel away (2) from the chassis, and remove the bezel.

Figure 5-6  Opening the front bezel

Bezel blanks
To remove the bezel blanks:

1. Disconnect power from the system, (Pre-disassembly procedures on page 55), remove the access
panel, and remove the front bezel (Front bezel on page 64)

2. Remove the bezel blanks by squeezing in on the tabs (1) and pulling in the bezel blanks (2).

Figure 5-7  Removing the bezel blanks
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Hood sensor (Smart cover sensor)
To remove the hood sensor:

1. Disconnect power from the system (Pre-disassembly procedures on page 55) and remove the
access panel (Access panel on page 63). Remove the front bezel. Lay the workstation on its side
with the system board facing up.

2. Remove the two hood sensor bracket screws, and remove the bracket and sensor as a unit.

Figure 5-8  Removing the hood sensor

To replace the hood sensor, reverse the previous steps.
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Front panel I/O device assembly
To remove the front panel I/O device assembly:

1. Disconnect power from the system (Pre-disassembly procedures on page 55). Remove the access
panel (Access panel on page 63) and the front bezel (Front bezel on page 64).

2. Unlatch the plastic snap that secures the cables inside the chassis and, disconnect the front panel
I/O device assembly cables from the system board.

3. Remove the screws that hold the front panel I/O device assembly and bracket to the chassis, and
remove the screws that hold the front panel I/O device assembly to the bracket.

4. Pull the front panel I/O device assembly out about two inches away from the chassis.

5. Pull the bracket away from the front panel I/O device assembly.

Figure 5-9  Removing the front panel I/O device assembly

6. Slide the front panel cables through the chassis and out the front of the unit.

To replace the front panel I/O device assembly, reverse the previous steps.
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Power button assembly and system speaker
The power button and the system speaker are part of the same assembly.

To remove the power button:

1. Disconnect power from the system (Pre-disassembly procedures on page 55) and remove the
access panel (Access panel on page 63).

2. Remove the front bezel (Front bezel on page 64) and the front panel I/O device assembly (Front
panel I/O device assembly on page 66).

3. Disconnect the power button assembly cable from the system board.

4. Disconnect the speaker wire and the hood sensor from the inline connectors on the power button
assembly cable.

5. Remove the screw (1) that secures the power button assembly to the chassis.

6. Dislodge the metal clip from the chassis by rocking the power button back and forth. Then slide
the power button assembly (2) out from the front of the chassis.

Figure 5-10  Removing the power button assembly

To remove the speaker:

1. Disconnect the speaker cable from the in-line front panel I/O device assembly cable, if you have
not already done so.
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2. Slide the speaker away from the three flanges and remove it from the chassis.

Figure 5-11  Removing the speaker
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Power supply
1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the

access panel (Access panel on page 63). Place the workstation on its side with the system board
facing up.

2. Disconnect the three power supply cable connectors from the system board.

NOTE: Cable ties and cable clips may be present.

3. Disconnect the power supply connections from the optical drives, diskette drive, hard drives, and
graphics card (select models only).

4. Remove the four screws (1) from the back panel.

5. Slide the power supply toward the front, and lift up (2) to remove it from the chassis.

Figure 5-12  Removing the power supply

To install the power supply, reverse the previous steps. If you're installing a new power supply, be sure
to move the memory fan bracket (3) from the old power supply to the new one.
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System fan
To remove the system fan:

1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 63). Place the workstation on its side with the system board
facing up.

2. Disconnect the fan power plug from the system board (1).

3. Press down on the ribbed portion of the system fan housing (2), rotate the fan housing down, and
lift the unit out of the chassis.

Figure 5-13  Removing the system fan

To replace the system fan, reverse the previous steps.

CAUTION: When installing the system fan, be sure that the fan is situated so that the airflow direction
is going out of the chassis to avoid overheating.
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Memory fan
To remove the memory fan:

1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 63). Place the workstation on its side with the system board
facing up.

2. Disconnect the memory fan power plug from the system board (1).

NOTE: If the fan is simply being moved to access the DIMMs, it does not need to be disconnected
from the system board.

3. Press the tab in on the memory fan housing (2) and lift the unit out of the chassis (3). 

Figure 5-14  Removing the memory fan

To replace the memory fan, reverse the previous steps. Ensure that the memory fan power cable is
connected to the system board.
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Memory

Memory module features

● Eight memory slots for DIMMs, four per CPU

● Accepts 512-MB, 1-GB , 2-GB, 4-GB, and 8-GB DIMMs

● 64-GB maximum configuration with 8-GB DIMMs

● Standard ECC PC2-5300 DIMMs

● No support for mirroring

● No spare DIMM support

Memory module requirements

● Use only PC2-5300 ECC DIMMs. Certified and warranted HP memory is recommended.

● Match DIMM pairs by size and type.
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Removing memory module
1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the

access panel (Access panel on page 63). Place the workstation on its side with the system board
facing up.

CAUTION: To ensure that memory modules are not damaged during removal or installation,
power off the workstation and unplug the power cord from the AC power outlet. Wait until the LED
on the back of the power supply turns off before removing memory. If you do not unplug the power
cord while installing memory, your memory modules might be damaged and the system will not
recognize the memory changes.

2. Remove the memory fan. Press the tab in on the memory fan housing (1) and lift the unit out of the
chassis (2).

NOTE: The system fan (System fan on page 70 ) must also be removed to access DIMMs in the
rear slots.

Figure 5-15  Removing memory fan

3. Gently push out on the socket levers (1).
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4. Lift the DIMM straight up, and remove it from the unit (2).

Figure 5-16  Removing DIMM

NOTE: DIMMs and DIMM sockets are keyed for proper installation. Be sure these guides align when
installing a DIMM.
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Installing a memory module
NOTE: HP only ships DIMMs that are electrically and thermally compatible with this product. Because
third-party DIMMs might not be electrically or thermally compatible, they are not supported by HP.

1. Disconnect power from the system (Pre-disassembly procedures on page 55) and remove the
access panel (Access panel on page 63). Lay the workstation on its side with the system board
facing up.

2. Depress the green tabs on the memory fan housing (1) and lift the unit out of the chassis (2).

Figure 5-17  Removing the memory fan

3. Gently push out on the socket levers.

4. Prepare to load memory modules in valid configurations:

● DIMMs must be loaded in matched pairs.

● If loading two DIMMs, install them in slots 1a/1b.

● If loading four DIMMs, install them in slots 1a/1b and 2a/2b for a dual CPU system, or in 1a/
1b and 3a/3b for a single CPU system.

● If loading six DIMMs, install them in slots 1a/1b, 2a/2b, and 3a/3b.

● If loading eight DIMMs, install them in all slots.

● Load the memory module pairs in order of size, from largest to smallest.

Figure 5-18  Identifying memory slots

2
4 1

3

5. Lower the DIMM straight down, and be sure the socket levers secure the module into place.
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NOTE: DIMMs and DIMM sockets are keyed for proper installation. Be sure these guides align
when installing a DIMM.

6. Lower the memory fan until it snaps into place.

NOTE: Ensure that all cables are clear of the fan housing when lowering the memory fan.

The BIOS generates warnings/errors on invalid memory configurations.

● If BIOS cannot obtain a valid memory configuration, it will halt the system with a diagnostics 2006
code for memory error (five beeps and blinks).

● If memory node interleave is enabled but the memory installed on the two CPUs is not equal, BIOS
will report a warning during POST (“215-Cannot Interleave Unequal Memory Nodes”). The system
can still boot in this condition.
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PCI slots
Figure 5-19  Identifying PCI slots

Table 5-4  PCI slots

Slot Type Ref

1 PCI Express x16 (x8) J31

2 PCI Express x16 graphics J41

3 PCI 32 bit, 33 MHz J20

4 PCI Express x16 (x8) J33

5 PCI Express x16 graphics J32

6 PCI-X 100 J25

7 PCI-X 100/133 J26
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PCI retainer
For added protection, some cards have PCI retainers installed to prevent movement during shipping.

Removing the PCI retainer

1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 63). Place the workstation on its side with the system board
facing up.

2. For both short and tall cards, press in on the sides (1) of the retainer, and rotate it (2) out of the
chassis.

Figure 5-20  Removing the short or tall card PCI retainer

Installing the PCI retainer

1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 63). Place the workstation on its side with the system board
facing up.
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2. For both short and tall PCI cards, attach the hooks of the PCI retainer (1) under the slots on the
rear of the chassis, and then rotate the retainer down until the retainer arm (2) supports the card.

Figure 5-21  Installing the short or tall card PCI retainer
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PCI retention clamp
1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the

access panel (Access panel on page 63). Place the workstation on its side with the system board
facing up.

2. Open the PCI retention clamp by pressing down on the two green clips at the ends of the clamp
and rotating the clamp toward the back of the system.

Figure 5-22  Opening the PCI retention clamp
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PCI Express
PCI Express is a point-to-point architecture and uses a serial data transmission protocol. A single PCI
Express lane consists of four wires and can transmit 250 MB/s in a single direction or 500 MB/s in both
directions simultaneously. This bandwidth is not affected by what is happening on other PCI Express
buses or legacy PCI/PCI-X buses (provided that total bandwidth can be handled by the CPU and the
memory subsystem.) The transmission protocol is somewhat similar to that used for a LAN connection
and contains error correction and detection, packet addressing, and other network features.

PCI Express improves system attributes. PCI Express enables a low-power, scalable, high-bandwidth
communication path with a small number of connections (wires) compared to traditional parallel
interfaces (for example, PCI).

The PCI Express I/O slots can support other PCI Express cards with lesser bus bandwidth than what is
physically defined for the slot. Use the following table to determine compatibility.

For example, a PCI Express x8 card does not work in a PCI Express x1 slot, but a PCI Express x1 card
works in a PCI Express x8 slot.

Table 5-5   PCI Express compatibility matrix for xw9400

 Slot 1*
x16 mechanical

x8 electrical

Slot 2
x16 mechanical

x16 electrical

Slot 4
x16 mechanical

x8 electrical

Slot 5
x16 mechanical
x16 electrical

PCI Express
x1 Card

Yes Yes Yes Yes

PCI Express
x4 Card

Yes Yes Yes Yes

PCI Express
x8 Card

Yes Yes Yes Yes

PCI Express
x16 Card

Yes Yes Yes Yes

* Slot 1 is for short cards only.
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Removing PCI or PCI Express cards
1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the

access panel (Access panel on page 63). Place the workstation on its side with the system board
facing up. Remove the PCI retainer (PCI retainer on page 78) if present.

2. Open the PCI retention clamp by pressing down on the two green clips at the ends of the clamp
(1) and rotating the clamp toward the back of the system.

3. Lift the PCI card out of the chassis (2). If removing a PCI Express high-end graphics card, remove
the auxiliary power supply cable (not illustrated) if required, and move the lever to release the
card (3) and lift it out of the chassis. Store the card in an anti-static bag.

Figure 5-23  Removing PCI or PCIe card

4. For cards with extenders, release the PCI Express slot latch (1) and lift up slightly. Press the clip
on the card guide (2) and lift the card out of the chassis (3).

Figure 5-24  Removing PCIe card with extender
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PCI or PCI Express installation
1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the

access panel (Access panel on page 63). Place the workstation on its side with the system board
facing up, and remove the PCI retainer (PCI retention clamp on page 80).

2. Open the PCI retention clamp by pressing down on the two green clips (1) at the ends of the clamp
and rotating the clamp toward the back of the system.

3. Remove the PCI slot cover (2).

4. Lower the PCI (3) or PCI Express (3) card into the chassis. Verify that the keyed components of
the card align with the socket.

If installing a card with an auxiliary power connector, plug in the power supply cable or adapter
cable supplied with the card (4).

5. Ensure that all cards are properly seated, and close the PCI retention clamp.

Figure 5-25  Installing PCI or PCIe card
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Front fan removal
To remove the front fan:

1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 63). Place the workstation on its side with the system board
facing up.

2. Disconnect optical and floppy drive cables from the system board. Remove full length PCI cards.

3. Disconnect the front fan cable from the connector on the system board.

4. Release the two card guide latches (1), pivot the card guide toward the system board (2), and lift
it out of the chassis (3).

Figure 5-26  Removing card guide

5. Remove the fan from the card guide by releasing the two latches and applying outward pressure
on the card guide while lifting the fan away.

Figure 5-27  Removing fan from card guide
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To install the front fan:

1. Place the fan in the card guide with the fan label facing into the card guide, and the fan protector
screen facing outward.

NOTE:  Ensure that the fan blows toward the rear of the chassis.

2. Thread the front fan cable through the slot in the card guide.

3. Set the front fan in the card guide and snap the fan into place.

Figure 5-28  Installing the fan in card guide

4. Lower the card guide with installed fan into the chassis. Place the card guide tabs into the chassis
slots and snap the card guide into place.

5. Plug the front fan cable into its connector on the system board.
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Front fan jumper cable installation
This procedure describes how to install a front fan jumper cable in an HP xw9400 Workstation when a
4 GB or greater DIMM is used in the workstation. The additional jumper cable provides for quieter fan
operation.

1. Disconnect the front system fan cable from the system board.

Figure 5-29  Disconnect front system fan cable from system board

2. Connect the system fan jumper cable to the front system fan cable.

Figure 5-30  Connect system fan jumper cable to front system fan cable
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3. Place the excess cable in the empty space under the hard drive cage.

Figure 5-31  Place excess cable in chassis

4. Connect the system fan jumper cable to the front fan cable connector on the system board. Use
the system board connector to which the original front fan cable connected.

Figure 5-32  Connect system fan jumper cable to system board
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Battery
CAUTION: Before removing the battery, be sure your CMOS settings are backed up because all
CMOS settings are lost when the battery is removed. To back up the CMOS settings, use Computer
Setup and run the Save to Diskette option from the File menu.

To remove the battery:

1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 63). Place the workstation on its side with the system board
facing up.

2. On the system board, press on the release tab of the battery holder.

3. Rotate the battery enough to get beyond the latch, and lift it straight up.

Figure 5-33  Removing the battery

To install the battery, slide the battery into the holder until it snaps into place.

88 Chapter 5   Removal and replacement procedures ENWW



Power connections to drives
For help in identifying power cables, refer to the following figure and table. Route or tie cables so that
they cannot interfere with the CPU heatsink fans.

Figure 5-34  Identifying correct power connections

Table 5-6  Power connector descriptions

Connector Description

P1 24-pin main power
connector

P2 4-pin memory power
connector

P3 8-pin processor power
connector

P4–P8 SATA and IDE ODD/
accessory power
connectors

P9 Diskette connector

P10–P14 HDD connector

P15 PCIe connector

P16 PCIe connector
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Optical drive
Your workstation might have a SATA or an IDE optical drive. To remove the optical drive:

1. Disconnect power from the system (Pre-disassembly procedures on page 55) and remove the
access panel (Access panel on page 63).

2. Disconnect the audio (1), data (2), and power (3) cables from the drive. The connector colors might
be different than illustrated.

NOTE: The audio cable is only required for Linux-based systems.

Figure 5-35  Disconnecting IDE (left) or SATA (right) cable from optical drive

3. Lift the green drivelock release lever, and gently slide the drive out of the chassis.

Figure 5-36  Removing optical drive from chassis
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To replace an optical drive:

1. Lift the green drivelock release lever while sliding the optical drive into the bay. When the optical
drive is partially inserted, release the drivelock release lever, and slide the drive completely into
the bay until the drive is secured.

CAUTION: Ensure that the optical drive is secure. Failure to do so can cause damage to the drive
when moving the workstation.

2. Connect the power, data , and audio (if required) cables to the drive and workstation.

NOTE: The audio cable is only required for Linux-based systems.

3. If you are installing more than one optical drive, route the cable as in the following image.

Figure 5-37  Connecting IDE (left) or SATA (right) optical drive cable to system board
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Replacing the SATA optical drive data cable
If your workstation has a SATA optical drive, replace the cable as follows:

1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 63). Place the workstation on its side with the system board
facing up.

2. Disconnect the SATA data cable from the system board and from the optical drive.

3. Replace the cable. Attach it to the optical drive and its system board connector as shown.

Notice for Blu-ray optical drives
If you installed a Blu-ray optical drive, note the following:

Blu-ray movie playback

As Blu-ray is a new format containing new technologies, certain disc, digital connection, compatibility
and/or performance issues may arise, and do not constitute defects in the product. Flawless playback
on all systems is not guaranteed. In order for some Blu-ray titles to play, they may require a DVI or HDMI
digital connection and your display may require HDCP support. HD-DVD movies cannot be played on
this workstation.

Blu-ray movie playback compatibility and update

Playing back Blu-ray HDCP (High-bandwidth Digital Content Protection) content such as commercially
distributed Blu-ray HD movies requires a fully HDCP compliant path on your computer. The HDCP
technology checks compliance of each component in the path from the content on the Blu-ray disc all
the way to the display monitor, including but not limited to graphic cards and monitor adapters.

The HP 400, 600 and 800 Workstations have been designed with this in mind; nearly all
configurations with currently available HP Professional Displays are compliant. Older HP xw4600 and
xw9400 Workstation configurations may not have fully compliant paths based on the installed graphics
card and display monitor; HP recommends confirming separately that you have a fully compliant system
if commercial content playback is a requirement for your use. HDCP compatibility of your graphics card
and monitor can be determined by checking the QuickSpecs at http://www.hp.com/go/productbulletin.

For the best HDCP performance, HP recommends that you install the latest updates:

1. Blu-ray player firmware

2. Playback application patches

3. Graphics firmware and drivers

Updates are located on the support web site for your specific product at http://www.hp.com/support/
workstations.
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Diskette drive (optional)
To remove a diskette drive:

1. Disconnect power from the system (Pre-disassembly procedures on page 55). Remove the access
panel (Access panel on page 63) and the front bezel (Front bezel on page 64).

2. Disconnect the data and power cables from the back of the diskette drive.

Figure 5-38  Disconnecting cables from the diskette drive

3. While lifting the green drivelock release tab, slide the drive forward out of the chassis.

Figure 5-39  Removing the diskette drive from the chassis
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4. Remove the diskette drive from its bracket by removing the two M3 screws in the rear-most holes
and pulling the diskette drive from the bracket.

Figure 5-40  Removing the diskette drive from the bracket

To replace a diskette drive:

1. Slide the diskette drive into the bracket, and secure it with two M3 screws.

2. While lifting the green drivelock release tab, slide the drive into the chassis.

3. Route the diskette drive data cable between the system board and the hard drive cage. Your cable
might look different than the one shown. Connect the data and power cables to the diskette drive.
Ensure that the power cable is connected to the system board.

Figure 5-41  Routing the diskette drive cable to the system board

4. Connect the cables to the back of the diskette drive.
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Hard drive

Replacing a hard drive
For more information on SATA hard drives and the SATA RAID configuration, see Appendix B—SATA
devices on page 172.

Removing a hard drive

1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 63).

2. Disconnect the cables from the hard drive.

3. Push in on the green drivelock release tabs, and pull the hard drive out of the chassis.

Figure 5-42  Removing the hard drive
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Installing a hard drive

1. Select a drive bay in which to install the drive. If installing more than one hard drive, use the hard
drive order shown in the following image.

Figure 5-43  Identifying hard drive installation order

2. Squeeze the green tabs, and slide the rails out of the empty bay.

3. Attach the rails to the hard drive. Align the pins on the rails with the hard drive holes, and snap the
rails into place.

Figure 5-44  Attaching rails to the hard drive

4. Push the drive into the selected bay until it snaps into place.
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5. Attach a data cable from a SATA connector on the system board to the hard drive, and attach a
power cable to the drive.

Figure 5-45  Replacing the SATA hard drive

6. For a SAS hard drive, attach a SAS/SATA adapter to the connector on the hard drive. Attach a
data cable from a SAS connector on the system board to the hard drive, and attach a power cable
to the drive.

Figure 5-46  Installing the SAS/SATA adapter (left) and cable (right)
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Installing a hard drive in the fifth hard drive bay
To install a SAS or SATA hard drive into fifth HDD bay:

1. Place the workstation on its side, and remove the three drive screws that are located on the bottom
of the chassis.

Figure 5-47  Installing screws for the hard drive in the fifth hard drive bay

2. Insert the drive into bay five and align the holes in the bottom of the hard drive with the screw holes
at the base of the chassis.

3. Insert the screws through the base, and tighten them to secure the hard drive to the chassis.

4. Attach a data cable from a SATA connector on the system board to the hard drive, and attach the
fifth drive power cable to the drive. It is attached to a clip in front of the power supply.

Figure 5-48  Attaching the data cable for the SATA hard drive in the fifth hard drive bay

5. For a SAS hard drive, attach a SAS/SATA adapter to the connector on the hard drive. Attach a
data cable from a SAS connector on the system board to the hard drive, and attach a power cable
to the drive.
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Liquid cooling unit
The following section describes how to remove a processor liquid cooling unit.

Removing the liquid cooling unit
The following steps describe removal of a liquid cooling unit.

1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 63). Place the workstation on its side with the system board
facing up.

2. Loosen the two liquid cooling unit/radiator mounting screws (1) from the liquid cooling unit.
Alternately and evenly loosen the two CPU 0 mounting screws (2).

Figure 5-49  Loosen radiator and CPU mounting screws
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3. Raise the radiator to its upright position.

Figure 5-50  Raise the radiator

4. Disconnect the memory fan (1), radiator fan (2), and voltage regulator fan (3) cables from the
system board. Pull the memory fan cable clear of the liquid cooling unit.

Figure 5-51  Disconnect memory, radiator, and voltage regulator fan cables
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5. Alternately and evenly loosen the two liquid cooling unit/CPU 1 mounting screws from the liquid
cooling unit.

Figure 5-52  Loosen liquid cooling unit/CPU 1 mounting screws

6. Lower the fan/radiator to its closed position.

7. For convenience, disconnect the PSU (1) cable from the system board. Disconnect the liquid
cooling unit pump cable (2) from the system board.

Figure 5-53  Disconnect pump cable
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8. Press the green tab in on the memory fan housing (1) and lift the unit from the system board (2).
Carefully pull the memory fan cable from the liquid cooling unit.

Figure 5-54  Removing the memory fan

9. Raise the liquid cooling unit fan/radiator to its upright position and remove the unit from the
workstation.

CAUTION: Be careful not touch the voltage regulator heatsink or the thermal compound on the
processor.

10. If desired, loosen the liquid cooling unit chassis bracket screws and remove the bracket from the
chassis. (This is necessary if the system board is to be removed.)

Figure 5-55  Remove liquid cooling unit chassis bracket
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Installing a liquid cooling unit
The following steps describe installation of a liquid cooling unit.

1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the
access panel (Access panel on page 63). Place the workstation on its side with the system board
facing up.

2. Install the liquid cooling unit rear chassis bracket if it is not already installed.

Figure 5-56  Install rear chassis bracket

3. For a new installation, remove the plastic protectors covering the thermal interface material on the
liquid cooling unit.

Figure 5-57  Remove plastic protectors

4. For a reused liquid cooling unit, clean the old thermal interface material from the processor and
from the reused liquid cooling unit cold plates. Reapply new thermal interface material to the
processors and to the reused liquid cooling unit.
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NOTE: Do not remove the interface material from a new liquid cooling unit.

5. Ensure all cables are clear of the installation area in the chassis. For convenience, disconnect P15
and/or P16 power cables from the graphics cards (if applicable), and disconnect the P3 power
connector from the system board.

6. Place the liquid cooling unit fan/radiator is in its upright position. Align the liquid cooling unit rear
guide pins to the notches in the rear cover guide while slowly lowering the liquid cooling unit into
the chassis.

WARNING! Be careful not to put your fingers in the liquid cooling unit hinge arm.

CAUTION: Be careful not to touch the voltage regulator heat sink or other nearby components.

Ensure that the liquid cooling unit mounts to not touch the processor socket or other metal parts.

Figure 5-58  Align guide pins to guide holes

Figure 5-59  Install liquid cooling unit in chassis
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7. Lower the liquid cooling unit fan/radiator.

8. Install the workstation memory fan. Lower the memory fan assembly into the workstation chassis
and snap it into place.

Figure 5-60  Removing the memory fan

9. Guide the memory fan cable through the liquid cooling unit radiator tubing as shown in the following
illustration.

Figure 5-61  Position memory fan cable

10. Raise the radiator fan to its upright position.
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11. Connect the memory fan cable to the system board.

Figure 5-62  Connect memory fan cable

12. Connect the cables for the radiator fan (1) and voltage regulator fan (2) to the system board. For
convenience, you may remove any nearby PC card from its slot while you connect cables.

CAUTION: Ensure that no cables interfere with the liquid cooling unit's system board mounts or
with other components on the system board.

Figure 5-63  Connect radiator fan and voltage regulator fan cables to system board
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13. Alternately and evenly tighten the liquid cooling unit/CPU 1 mounting screws to a torque of 6 in./
lbs.

Figure 5-64  Tighten liquid cooling unit/CPU 1 mounting screws

14. Lower the radiator to its closing position.

15. Alternately and evenly tighten the liquid cooling unit/CPU 0 mounting screws to a torque of 6 in./
lbs.

Figure 5-65  Tighten liquid cooling unit/CPU 0 mounting screws
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16. Tighten the radiator mounting screws.

Figure 5-66  Position radiator and tighten mounting screws

17. Connect the liquid cooling unit pump cable to the system board.

Figure 5-67  Connect pump cable to system board
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18. If appropriate, reconnect power cable P3 to the system board.

Figure 5-68  Reconnect P3 to system board

19. If appropriate, reconnect power cables P15 and/or P16 to the graphics cards.
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Replacing the liquid cooling unit VRD fan
This section explains how to replace the VRD fan in the liquid cooling unit.

Removing the VRD fan

To remove the VRD fan:

1. Remove the VRD cable from the cable channel.

2. Remove the VRD fan from its holder. Grasp the fan and pull up.
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Installing the VRD fan

To install the VRD fan:

1. Position the VRD fan such that the indicator arrow on the fan points in the same direction as the
indicator arrow in the fan holder.

2. Insert the fan in its holder.

3. Press down until the fan snaps into place.
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4. Position the VRD cable in the cable channel.
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Processor heatsink

Removing the CPU heatsink
NOTE: The following illustrated CPU heatsink is typical of what you might have in your workstation.
Be aware that different variations of the CPU heatsinks exist, but the overall procedures listed are
sufficient to assist you in removing the CPU heatsink.

1. Shut down the workstation, and disconnect power from the system (Pre-disassembly
procedures on page 55). Remove the access panel (Access panel on page 63), and place the
workstation on its side with the system board facing up.

2. Remove the two processor screws slowly, being sure to loosen the screws evenly. Loosen one
screw (1) until the screw shank disengages from the system board, then loosen the remaining
screw (2). Do not fully loosen one screw, then move on to the next. Loosen both screws a little at
a time, so that the processor remains level.

Figure 5-69  Identifying proper screw removal order

3. Disconnect the CPU heatsink fan connector (1) from the system board. Loosen the heatsink
mounting screws (2).
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4. Before lifting the heatsink, carefully break the thermal compound between the CPU heatsink and
processor by moving the heatsink back and forth or twisting it (3).

Figure 5-70  Removing the CPU heatsink from the system board

5. Use alcohol and a soft cloth to clean all of the thermal interface material residue from the CPU
heatsink and processor.

CAUTION: Allow the alcohol on the processor and CPU heatsink to dry completely.
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Replacing the CPU heatsink
1. Disconnect power from the system (Pre-disassembly procedures on page 55). Remove the access

panel (Access panel on page 63) and the CPU heatsink (Removing the CPU heatsink
on page 113).

2. Use alcohol and a soft cloth to clean all of the thermal grease from the CPU heatsink and processor.

CAUTION: Allow the alcohol on the processor and CPU heatsink to dry completely.

3. Apply fresh thermal grease to the top of the processor in the pattern shown in the following figure.

Figure 5-71  Applying thermal grease

4. Place the CPU heatsink on top of the processor, and align the two mounting screws with the
holes (1) in the system board.

NOTE: If both CPU heatsinks were removed, be sure that all system board standoffs engage with
the keyholes in the chassis, and that the system board connectors engage correctly with the rear
I/O panel, and push back on the system board while engaging the CPU heatsink screws with the
chassis standoffs. You only need to push back when trying to engage the first sc rew.
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5. Connect the CPU heatsink fan connector to the system board (2).

Figure 5-72  Replacing the CPU heatsink on the system board

6. Insert and tighten the two CPU heatsink screws. First, tighten both screws partially so that the CPU
heatsink remains level. Next, fully tighten one screw (1), then fully tighten the remaining screw
(2). Tighten to a torque setting of 6 in-lb.

Figure 5-73  Identifying proper screw removal order
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Processor

Removing the processor
CAUTION: Use extreme care when installing or removing a processor. The exposed socket pins
are extremely fragile. Damaged sockets will require a board replacement.

Lift the processor out of the socket— do not slide the processor on the socket.

When installing a processor, align the dimples on the side of the processor with the notches in the socket.

1. Disconnect power from the system (Pre-disassembly procedures on page 55). Remove the access
panel (Access panel on page 63) and the CPU heatsink (Removing the CPU heatsink
on page 113).

2. Raise the processor socket handle fully (1) and lift the socket cover (2).

Figure 5-74  Raising the processor socket handle
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3. Lift the processor straight out of the socket.

Figure 5-75  Lift the processor from the socket

CAUTION: To avoid bending the socket pins, keep the processor perfectly flat when removing
or installing it.

NOTE: Store the processor in a static-free, safe place where it will not be damaged.

4. In some workstation configurations, a bypass board may be installed in the socket instead of a
processor. Remove the bypass board by lifting it straight out of the socket.

Figure 5-76  Lift the bypass board from the socket
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Replacing the processor
CAUTION: HP recommends you do not swap processors (CPUs) from one motherboard to another.

CAUTION: Use extreme care when installing or removing a processor. The exposed socket pins
are extremely fragile. Damaged sockets will require a board replacement.

Lift the processor out of the socket— do not slide the processor on the socket.

When installing a processor, align the dimples on the side of the processor with the notches in the socket.

1. Disconnect power from the system (Pre-disassembly procedures on page 55). Remove the access
panel (Access panel on page 63), the CPU heatsink (Removing the CPU heatsink on page 113),
and the processor (Removing the processor on page 117).

2. Raise the processor socket handle fully.

3. If necessary, remove the bypass board from the socket. Align the notches in the processor base
with the tabs on the socket. Seat the processor into the socket. Ensure that the underside of the
processor is level with the top of the processor socket. Close the processor cover plate. Lightly
press down on the processor cover plate while closing the socket lever.

Figure 5-77  Seating the processor
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System board

Removing the system board
1. Disconnect power from the system (Pre-disassembly procedures on page 55), and remove the

access panel (Access panel on page 63). Place the workstation on its side with the system board
facing up. Remove all expansion boards, external cables, graphics cards (Removing PCI or PCI
Express cards on page 82), and the CPU heatsink (Processor heatsink on page 113). Remove the
system and memory fan assemblies.

2. Disconnect all cables from the system board.

NOTE: Make note of the cable connections before disconnecting them from the system board.
See Power connections to drives on page 89for more information.

3. Rotate the system board latch lever 90 degrees (1) clockwise to unlock the system board.

4. Slide the system board forward (2) to disengage the metal mounting standoffs from the chassis.

CAUTION: Do not attempt to remove the system board mounting screws. These screws are
permanently secured and are not removable.

5. Lift the system board out (3) of the chassis, being careful not to damage the cables and rear panel
connectors. You can lift the board by the rear audio connector and the 2 x 4 power connector (4).

Figure 5-78  Removing the system board

Replacing the System Board
1. Insert the system board straight down, and be sure that all system board standoffs engage with

the keyholes in the chassis.

NOTE: Be sure the system board connectors engage correctly with the rear I/O panel.

2. Push back on the board while maintaining downward pressure on the board, so all standoffs remain
engaged.

3. Rotate the system board latch 90 degrees counter clockwise.
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4. Install the heatsink (Replacing the CPU heatsink on page 115).

5. Install all removed components and cables.

Product recycling
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries.

For information about recycling HP components or products, see http://www.hp.com/go/recycle.
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6 System diagnostics and
troubleshooting

This chapter discusses the tools available for diagnosing and troubleshooting system issues.

● HP troubleshooting resources and tools on page 122

● Troubleshooting checklist on page 125

● LED color definitions on page 125

● Self-troubleshooting with HP Vision Field Diagnostics on page 126

● Diagnostic error codes on page 134

● Troubleshooting scenarios and solutions on page 137

● POST error messages on page 160

HP troubleshooting resources and tools
This section provides information on the HP Help and Support Center, E-support, and Helpful Hints for
troubleshooting.

HP Help and Support Center
The HP Help and Support Center is a customized HP user interface that enhances the Windows XP
Help and Support Center Help feature. This customized utility allows you to access specific information
about your HP Workstation such as configuration information by clicking Start > Help and Support
Center. The interface also provides customized help and support links to the HP Web site related to
your HP Workstation.

NOTE: The customized HP Help and Support Center is not available on Windows XP Professional
x64 Edition or on Linux.

NOTE: Currently, HP Help and Support Center does not work on Windows Vista.

E-support
Online access and support resources include Web-based troubleshooting tools, technical knowledge
databases, driver and patch downloads, online communities, and product change notification services.

The following Web sites are also available to you:

● http://www.hp.com—Provides useful product information.

● http://www.hp.com/support/workstation_manuals—Provides the latest online documentation.

● http://www.hp.com/go/workstationsupport—Provides technical support information for
workstations.
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● http://www.hp.com/support—Provides a listing of the worldwide technical support phone numbers.
Access the telephone numbers by visiting the Web site, then select your region, and click Contact
HP in the upper-left corner.

● http://www.hp.com/support/workstation_swdrivers—Provides access to software and drivers for
workstations.

Troubleshooting a problem
To help you troubleshoot problems with your system, HP provides the Business Support Center (BSC).
The BSC is a portal to an extensive selection of online tools. To access BSC and troubleshoot a problem
with the workstation, complete the following:

1. Visit http://www.hp.com/go/workstationsupport.

2. Under the Business Support Center menu on the left, select Troubleshoot a problem.

3. Under Select your product (center window), select Workstations (under personal
computing).

4. Under Select your product, continue with selections as appropriate to the workstation series and
model, and to the problem you are troubleshooting.

Instant Support and Active Chat
HP Instant Support is a set of Web-based support tools that automate and speed up the resolution of
desktop computing, tape storage, and printing problems.

Active Chat enables you to electronically submit a support ticket to HP over the Web. When you submit
a support ticket, Active Chat collects information about the computer and pass it to an online support
specialist. The collection of information might take up to 30 seconds depending on the computer
configuration. When you submit a support ticket, you receive a confirmation message containing your
case ID, the support hours for your location, and the estimated time of response.

For more information about HP Instant Support and Active Chat and how to use them, visit
http://www.hp.com/hps/hardware/hw_professional.html.

NOTE: This feature is not available on Windows XP Professional x64 Edition or on Linux.

Customer Advisories, Customer and Security Bulletins, and Customer Notices
To find advisories, bulletins, and notices:

1. Visit http://www.hp.com/go/workstationsupport.

2. Select the desired product.

3. Under Resources for <your selected product>, select See more….

4. Under Self-Help resources: in the center of the window, choose the desired action and appropriate
information in the scroll list to view the index.

Product Change Notifications
Product Change Notifications (PCNs) are proactive notifications for product changes occurring within a
30-60 day window of the effective date of the change in the manufacturing process. PCNs give
customers advanced notice of changes to their product, such as an updated BIOS version that they may
need to qualify prior to the change taking place. The latest PCNs are located at: http://www.hp.com/go/
workstationsupport.
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Helpful hints
If you encounter a problem with the workstation, monitor, or software, the following provides a list of
general suggestions that help you isolate and focus on the problem before taking further action.

At startup

● Verify that the workstation and monitor are plugged into a working electrical outlet.

● Remove all diskettes, optical disks, and USB drive keys from the drives before powering on the
workstation.

● Verify that the workstation is turned on and the green power light is on.

● If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on your system by visiting http://www.hp.com/go/quickspecs.

● Verify that the monitor is turned on and the green monitor light is on.

● Turn up the brightness and contrast controls of the monitor if the monitor is dim.

● If the workstation has multiple video sources and only a single monitor, the monitor must be
connected to the source selected as the primary VGA adapter. During startup, the other monitor
connectors are disabled; if the monitor is connected to one of these ports, it will not function after
Power-on Self Test (POST). You can select the default VGA source in Computer Setup (F10).

During operation

● Look for blinking LEDs on the front of the workstation. The blinking lights are error codes that will
help you diagnose the problem. Refer to the Diagnostic lights and audible (beep) codes section of
this document for information on interpreting diagnostic lights and audible codes.

● Press and hold any key. If the system beeps, then your keyboard is operating correctly.

● Check all cables for loose or incorrect connections.

● Wake the workstation by pressing any key on the keyboard or the power button. If the system
remains in suspend mode, shut down the system by pressing and holding the power button for at
least four seconds, then press the power button again to restart the system. If the system does not
shut down, unplug the power cord, wait a few seconds, then plug it in again. If it does not restart,
press the power button to start the workstation.

● Reconfigure the workstation after installing a non–plug and play expansion board or other option.
Refer to the Hardware installation problems section of this document for instructions.

● Be sure that all required device drivers have been installed. For example, if you have connected
a printer, you must install a printer driver.

● If you are working on a network, plug another workstation with a different cable into the network
connection. There might be a problem with the network plug or cable.

● If you recently added new hardware, remove the hardware and verify if the workstation functions
properly.

● If you recently installed new software, uninstall the software and verify if the workstation functions
properly.

● If the screen is blank, plug the monitor into a different video port on the workstation if one is
available. Alternatively, replace the monitor with a monitor that you know is working properly.
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● Upgrade the BIOS. A new release of the BIOS might have been released that supports new features
or fixes your problem.

● For more detailed information, see the troubleshooting chapter in the Service and Technical
Reference Guide at http://www.hp.com/support/workstation_manuals.

Customizing the monitor display
You can manually select or change the monitor model, refresh rates, screen resolution, color settings,
font sizes, and power management settings. To do so, right-click the desktop, then click Properties to
change display settings. For more information, see the online documentation provided with the graphics
controller utility or the documentation that came with your monitor.

Troubleshooting checklist
Before running diagnostic utilities, use the following checklist to find possible solutions for workstation
or software problems.

● Is the workstation and monitor connected to a working electrical outlet?

● Is the workstation powered on?

● Is the green power light illuminated?

● Is the monitor on?

● Is the green monitor light illuminated?

● If the monitor is dim, adjust the monitor brightness and contrast controls.

● Press and hold any key. If the system beeps, the keyboard is operating correctly.

● Check cables for loose or improper connections.

● After installing a non-plug and play (PnP) expansion board or other option (such as a diskette drive),
reconfigure the workstation.

● Are all necessary device drivers installed?

● Have all printer drivers been installed for each application?

● Have you removed diskettes, optical disks, and USB drive keys from the drives before powering
on the workstation?

● Are you running the latest version of BIOS, drivers, and software?

LED color definitions
The front panel LED indicates system status as described in Table 1.

Table 6-1  Front panel LED color definitions

LED State LED Color System Status

Solid Green System is on.

Blinking Green System is in Standby mode.

Solid or blinking Red System has an error. See Diagnostic light
codes on page 134.

None No light System is in Hibernate mode, or it is off.
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Self-troubleshooting with HP Vision Field Diagnostics
Hewlett-Packard Vision Field Diagnostics is a diagnostic tool that can be used by the end user or
technical support personnel to view information about the hardware configuration of the computer and
perform hardware troubleshooting on HP Desktop and Workstation systems. This diagnostic tool should
be used to help determine hardware failures. Accessible by either CD or USB key, these diagnostics
run outside the operating system and so make it easy to isolate potential issues that may be operating
system related versus hardware.

HP Vision Field Diagnostics benefits are:

● Capture complete system configuration information that can be shared as an HTML file, including:

◦ System serial number

◦ System product number

◦ System BIOS revision

◦ Memory size and configuration

◦ Processor information

◦ Storage device information and configuration

◦ Graphics / audio / communications information and configuration

◦ And more...

● Comprehensive list of diagnostic test available with new added features:

◦ Highly configurable testing options: quick / complete / custom / interactive / non-interactive

◦ Specific failing memory DIMM identification

◦ Tests video card memory

◦ Launches DST Smart tests for both SATA and SAS drives

◦ Many other tests and diagnostics

● Warranty Code output – A unique warranty code is generated for each failure which can be used
to validate diagnostic use for a specific system

● Easy to use - uses similar user interface as previous field diagnostics, HP Insight Diagnostics

● True End2End diagnostics – same diagnostics modules used in factory

● Easy to obtain

◦ Download from Web

◦ USB key bootable or CD bootable

◦ Included with restore media

It is expected that these Vision diagnostics will be run on supported products when attempting to
troubleshoot system issues.

Overview
The HP Vision Field Diagnostics utility allows you to view information about the hardware configuration
of the workstation and perform hardware diagnostic tests on the subsystems of the workstation. The
utility simplifies the process of effectively identifying, diagnosing, and isolating hardware issues.
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The Survey tab is displayed when you invoke HP Vision Field Diagnostics. This tab shows the current
configuration of the workstation. From the Survey tab, there is access to several categories of
information about the workstation. Other tabs provide additional information, including diagnostic test
options and test results. The information in each screen of the utility can be saved as an html file and
stored on a diskette or USB flash drive.

Use HP Vision Field Diagnostics to determine if all the devices installed on the workstation are
recognized by the system and functioning properly. Running tests is optional but recommended after
installing or connecting a new device.

You should run tests, save the test results, and print them so that you have printed reports available
before placing a call to the Customer Support Center.

NOTE: Third-party devices may not be detected by HP Vision Field Diagnostics.

Downloading and accessing HP Vision Field Diagnostics
To access HP Vision Field Diagnostics the utility has to be downloaded from the HP Web site and copied
to CD or USB drive.

1. Go to http://www.hp.com.

2. Select the Support & Drivers link.

3. Select the Download driver and software radio button.

4. Enter your product number (for example, 800) in the text box, and then press Enter.

5. Select your operating system.

6. Select the Diagnostic link.

7. Locate HP Vision Field Diagnostics and select Download.

8. After the .iso file is downloaded, use CD-ROM burning software to copy the .iso file to an optical
medium or USB flash drive.

9. When the CD or USB flash drive has the utility installed, insert the CD or USB flash drive into the
workstation (while it is on).

10. Shut down the operating system and turn off the workstation.

11. Turn on the workstation. The system will boot into HP Vision Field Diagnostics.

NOTE: If the system does not boot to the CD in the optical drive or to the USB flash drive, you
may need to change the boot order in the Computer Setup (F10) utility.

12. At the boot menu, select either the HP Vision Field Diagnostics utility to test the various hardware
components in the computer or the HP Memory Test utility to test memory only.

NOTE: The HP Memory Test is a comprehensive memory diagnostic utility that is run as a stand-
alone application, outside of HP Vision Field Diagnostics.

13. If running HP Vision Field Diagnostics, select the appropriate language and click Continue.

14. In the End User License Agreement page, select Agree if you agree with the terms. The HP Vision
Field Diagnostics utility launches with the Survey tab displayed
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User interface
The HP Vision Field Diagnostics application provides six major functions, accessible through Tabs.
These functions are:

● Survey — Your current system hardware information.

● Test — List all diagnostics available for your system. Tests are started there.

● Status — This screen shows progress and status of currently running diagnostics.

● History — All past diagnostics runs and status are listed there.

● Errors — All past diagnostics failures are listed there.

● Help — User help about HP Vision Diagnostics.

There are also some common operations that are part of the utility. They include:

● Exit Diagnostics button — This button will close HP Vision Diagnostic application and reboot your
system. Any running test will be aborted.

● Reload button — If available, this button will rescan your system hardware and reload the
diagnostics without the need to restart your entire system.

● Save button — If available, save your system survey, test history or error data as an HTML file to
a floppy disk or a USB key drive.

Survey tab
The Survey tab shows your system hardware information, organized into eleven Categories (for example
"Processors") and device instances (for example "Processor 1").

The amount of information displayed can be controlled by selecting a combination of View Level and
Category.

The View Levels include:

● Overview — shows high level summary of the system hardware. This is the default view level.

● Summary — gives limited configuration data for each specific Category.

● Advanced — offers more technical and low-level data for the computer-savvy user.

The Categories Levels include:

● All — Shows all Categories.

● Architecture — Shows system architecture information such as high level PCI devices, low level
SMBIOS, CMOS and PCI configuration space data.

● Audio — Shows all embedded and add-on audio devices.

● Asset Control — Shows asset control related information such as product name, serial number,
asset tag, and universal unique ID information.

● Communication — Shows communication devices such as serial, parallel, USB, network,
Firewire, modem, and Bluetooth ports and devices.

● Graphics — Shows all embedded and add-on video cards.

● Input Devices — Shows user input devices such as all connected mice and keyboards.

● Memory — Shows system memory information.
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● Miscellaneous — List any devices or data that doesn't belong to any other Category.

● Processors - Shows system processors.

● Storage — Shows mass storage devices such as floppy drives, optical drives, SATA, SAS hard
disk drives and controllers, as well as any RAID arrays.

● System — Shows information about motherboard devices such as fans and cables.
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Test tab
The Test tab lists all available diagnostics. The lists have been tailored according to your system
configuration. Individual test may be selected or unselected. The following Test Modes exist:

● Quick — This test selection was picked to perform quickly while covering your entire hardware.
Test parameters cannot be modified.

● Complete — This test selection offers all available tests and may take a long time to complete.
Test parameters cannot be modified.

● Custom — Like Complete this test selection offers all available tests. The test parameters may be
modified to fit specific needs. For advanced users only!

By default, the three test modes do not display prompts and require no interaction. If errors are found,
they are displayed when testing is complete.

However, for each test type, you may also optionally add interactive tests by clicking the Include
interactive tests box under Test mode. Selecting interactive tests provides the maximum control over
the testing process. The diagnostic software will prompt you for input during tests.

NOTE: Memory can not be tested from within the HP Vision Field Diagnostics application. To test the
memory in your workstation, exit HP Vision Field Diagnostic, boot to either the CD or USB flash drive
and select HP Memory Test from the boot menu.

The Duration of Test options control the duration of the test sequence. The following options are
available:

● Number of loops — A test selection will run once by default. Enter a positive number to make a
test selection run many times.

● Total test time (hours:minutes) — Alternatively, the test selection can be set to run for a specified
amount of time. This does not guarantee that all tests will run if the entered time is less than the
necessary time to run all the tests

● Stop at first error— Check this option to stop test execution as soon as one error is encountered.

The following Test Controls exist:

● Select All, Unselect All button — This button toggles to select or unselect all the tests from the
test selection tree.

● Expand, Collapse button — This button toggles to expand or collapse the test selection tree.

● Start Test button — Click this button to start executing all selected tests. HP Vision Field
Diagnostics will automatically switch to the Status tab in order to keep track of the test execution
and status.

WARNING! Once started, do not reboot or power off your computer until all the tests have been
completed.

To begin testing:

1. Select the Test tab.

2. Select the type of tests you want to run: Quick, Complete, or Custom.

3. Include optional interactive tests by selecting Include interactive tests.

4. Choose how you want the test to be executed, either Number of Loops or Total Test Time. When
choosing to run the test over a specified number of loops, enter the number of loops to perform. If
you want the diagnostic test for a specified time period, enter the amount of time in minutes.
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5. Click the Start Test button to start the testing. The Status tab, which allows you to monitor the
progress of the tests, is automatically displayed during the testing process. When the tests are
complete, the Status tab shows whether the devices passed or failed.

6. If errors are found, go to the Errors tab to display detailed information and recommended actions.
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Status tab
The Status tab shows the overall progress and status of the test scenario as well as the progress and
status of each test. The color coded status are black, blue, green, red, and orange.

The Status tab colors are:

● Waiting (black) — when no test is running

● Running (blue) — when at least one test is currently running

● Passed (green) — when all tests have run successfully, meaning that no hardware error or defect
have been detected

● Failed (red) — when thee tests have detected at least one error with your system

● Canceled (orange) — when the test scenario has been explicitly canceled, in which case no pass
or fail conclusion can be drawn

The available data is:

● Current Loop — Shows the current execution loop out of total number of loops specified in the
Test panel.

● Test Time — Shows the total time elapsed since the beginning of the test execution.

● Test Complete — Shows the number of tests successfully completed out of the total number of
test to execute.

● Cancel button — Push the Cancel button to immediately terminate all currently running tests.

History tab
The History tab shows the history of the past test executions.

The History Log displays all tests that have been executed, the number of times of execution, the number
of times failed, the date each test was executed, and the time it took to complete each test. The Clear
History button will clear the contents of the History Log.

The contents of the History Log may be saved as a HTML file to either floppy or USB flash drive by
clicking the Save button.

Errors tab
The Errors tab displays detailed information about any errors found, as well as any recommended
actions.

The Error Log displays the tests for devices that have failed during the diagnostic testing and includes
the following columns of information.

● The Device section displays the device tested.

● The Test section displays the type of test run.

● The Times Failed is the number of times the device has failed a test.

● The Defect Code provides a numerical code for the failure. The error codes are defined in the Help
tab.

● The Description section describes the error that the diagnostic test found.

● The Reason section describes the likely cause of the error.
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● The Recommended Repair will give a recommended action that should be performed to resolve
the failed hardware.

● The Warranty ID is a unique error code associated with the specific error on your computer. When
contacting the HP Support Center for assistance with a hardware failure, please be prepared to
provide the Warranty ID.

● The Clear Errors button will clear the contents of the Error Log.

The contents of the Error Log may be saved as a HTML file to either floppy or USB flash drive by clicking
the Save button.

Help tab
The Help tab contains a Vision Help section, and a Test Components section. This tab includes search
and index features. You may also review the HP End User License Agreement (EULA), as well as the
HP Vision Field Diagnostic application version information on this tab.

The various sections located here are:

● The Vision Help section contains information on the major functions of HP Vision Field Diagnostics.

● The Test components section provides a description of each test, as well as the parameters that
may be adjusted when running in Custom test mode.

● The Defect codes section contains information on the numerical error code that may appear in the
Errors tab.

● The Memory test tab section provides information on the HP Memory Test application that may be
launched from the boot menu.

● The HP Support section provides information on obtaining technical support from HP.
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Saving and printing information in HP Vision Field Diagnostics
You can save the information displayed in the HP Vision Field Diagnostics Survey, History and Errors
tabs to a diskette or a USB flash drive. You can not save to the hard drive. The system will automatically
create an html file that has the same appearance as the information displayed on the screen.

1. Insert a diskette or USB flash drive if running HP Vision Field Diagnostics from CD.

2. Click Save in the bottom on any of the Survey, History or Errors tabs. All three log files will be saved
regardless of from which tab the Save button was clicked.

3. Select the drive onto which you will save the log files and click the Save button. Three html files
will be saved to the inserted diskette or USB flash drive.

NOTE: Do not remove the diskette or USB key until you see a message indicating that the html
files have been written to the media.

4. Print the desired information from the storage device used to save it.

NOTE: To exit HP Vision Field Diagnostics, click the Exit Diagnostics button at the bottom of
the screen. Be sure to remove the USB flash drive or CD from the optical drive.

Downloading the latest diagnostic utility
Follow these steps to download the latest diagnostic utility:

1. Go to http://www.hp.com.

2. Select the Support & Drivers link.

3. Select the Download driver and software radio button.

4. Enter your product number (for example, 800) in the text box, and then press Enter.

5. Select your operating system.

6. Select the Diagnostic link.

7. Locate HP Vision Field Diagnostics and select Download.

8. After the .iso file is downloaded, use CD-ROM burning software to copy the .iso file to an optical
medium.

Diagnostic error codes
This sections provides an overview of the diagnostic lights and error codes that are related to your
workstation.

Diagnostic light codes
NOTE: The beeps are heard through the chassis speaker. The blinking LEDs and beeps repeat for
five cycles. After that, only the blinking LEDs repeat.
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Table 6-2  Diagnostic LED codes

Chassis Indicator LEDs 

Power LED and Sound
Activity

Diagnosis and Service Action

None CAUTION: Disconnect AC power from the workstation before reseating or
replacing components because there is power to the system board even
when the workstation is powered down.
System does not power on. Press power button. If HDD LED = GREEN,
then:

1. Remove expansion cards one at a time.

2. Replace the system board.

OR

If HDD LED does not illuminate, then:

1. Verify that the unit is plugged into a working AC outlet.

2. Open access panel, and verify that the power button harness is properly
connected to the inline front panel I/O device assembly connector.

3. Verify that the power supply cables are properly connected to the
system board.

4. Verify the power supply functionality.

a. Disconnect AC power.

b. Remove all internal power supply cables from the system board.

c. Plug in AC power.

● If the power supply fan spins and the BIST* LED lights, then the
power supply is good. Replace the system board.

● If the power supply fan does not spin or the BIST* LED does
not light, replace the power supply.

Blinks red/beeps two
times, once per second,
then two-second pause

Thermal shutdown.

1. Ensure that the workstation system air vents are not blocked and the
cooling fan is running.

2. Open the access panel, press power button, and see if the processor
fan spins. Check both fans for a dual-processor workstation. If the
processor fan is not spinning, make sure the fan's cable is plugged into
the system board header. Ensure the fan is fully/properly seated or
installed.

3. If fan is plugged in and seated properly, but is not spinning, the problem
may be in the processor fan. Contact HP for assistance

4. Verify that the fan assembly is properly attached. If problems persist,
there may be a problem with the processor heatsink. Contact HP for
assistance.

Blinks red/beeps three
times, once per second,
then a two-second pause

CAUTION: Disconnect AC power from the workstation before reseating or
replacing components because there is power to the system board even
when the workstation is powered down.
CPU not installed.

1. Check to see that the processor is present.

2. Reseat the processor.
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Chassis Indicator LEDs 

Power LED and Sound
Activity

Diagnosis and Service Action

Blinks red/beeps four
times, once per second,
then a two–second pause

CAUTION: Disconnect AC power from the workstation before reseating or
replacing components because there is power to the system board even
when the workstation is powered down.
Power supply failure.

1. Open the access panel and ensure the following connections are secure
on the system board:

◦ 24–pin main power

◦ 8–pin CPU

◦ 4–pin memory

2. Locate faulty device by removing all devices and then reinstalling one
at a time until workstation fails. Replace the device causing the failure.
Continue adding devices to ensure all are functioning properly.

3. Verify power supply functionality.

a. Disconnect AC power.

b. Remove all internal power supply cables from the system board.

c. Plug in AC power.

● If the power supply fan spins and the BIST* LED lights, then the
power supply is good. Replace the system board.

● If the power supply fan does not spin or the BIST* LED does
not light, replace the power supply.

Blinks red/beeps five
times, once per second,
then two-second pause

CAUTION: Disconnect AC power from the workstation before reseating or
replacing components because there is power to the system board even
when the workstation is powered down.
Pre-video memory error.

1. Ensure DIMMs are loaded in correct slots.

2. Reseat DIMMs.

3. Replace DIMMs one at a time to isolate faulty module.

4. Replace third-party memory with HP memory.

5. Reseat CPUs.

6. Replace system board.

Blinks red/beeps six
times, once per second,
then a two-second pause

CAUTION: Disconnect AC power from the workstation before reseating or
replacing components because there is power to the system board even
when the workstation is powered down.
Pre-video graphics card error.

1. Ensure auxiliary power cable is connected if applicable (high power
graphics cards only).

2. Reseat the graphics card.

3. Replace the graphics card.

4. Replace the system board.

Table 6-2  Diagnostic LED codes (continued)
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Chassis Indicator LEDs 

Power LED and Sound
Activity

Diagnosis and Service Action

Blinks red/beeps seven
times, once per second,
then a two-second pause

CAUTION: Disconnect AC power from the workstation before reseating or
replacing components because there is power to the system board even
when the workstation is powered down.
System board failure (ROM detected failure before video).

1. Clear CMOS by pressing the Clear CMOS button on the system board.

2. Replace system board.

Blinks red/beeps eight
times, once per second,
then a two-second pause

CAUTION: Disconnect AC power from the workstation before reseating or
replacing components because there is power to the system board even
when the workstation is powered down.
Invalid ROM based on bad checksum.

1. Clear CMOS by pressing the Clear CMOS button on the system board.

2. Upgrade the ROM using a ROMPaq diskette, CD, diskette, or USB
removable device (e.g., HP Drive Key). See the ROM Flash section of
the Service and Technical Reference Guide at http://www.hp.com/
support/workstation_manuals.

3. Replace system board.

Blinks red/beeps nine
times, once per second,
then a two-second pause

CAUTION: Disconnect AC power from the workstation before reseating or
replacing components because there is power to the system board even
when the workstation is powered down.
System powers on but is unable to boot.

1. Replace the processor.

2. Replace the system board.
* Refer to the Service and Technical Reference Guide for your workstation for BIST information.

Troubleshooting scenarios and solutions
This section presents an extensive overview of various troubleshooting scenarios and includes possible
solutions for each.

Solving minor problems
Table 6-3  Minor problems

Problem Cause Possible Solution

Workstation seems to be
locked up.

Program in use has
stopped responding to
commands.

1. Attempt the normal Windows shut down
procedure.

2. Restart the workstation using the power
button.

Workstation appears
locked up and will not
turn off when the power
button is pressed.

Software control of the
power switch is not
functional.

1. Press and hold the power button for at least
four seconds until the workstation turns off.

2. Disconnect electrical plug from outlet.

Table 6-2  Diagnostic LED codes (continued)
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Problem Cause Possible Solution

Workstation date and
time display is incorrect.

Real-time clock (RTC)
battery might need to be
replaced.

1. Reset the date and time under Control
Panel.

2. Replace the RTC battery.

Workstation appears to
pause periodically.

Network driver is loaded
and no network connection
is established.

Establish a network connection, or use
Computer Setup or Microsoft Windows Device
Manager to disable the network controller.

Cursor will not move
using the arrow keys on
the keypad.

The Num Lock key
might be on.

Press Num Lock. The Num Lock key can be
disabled (or enabled) in Computer Setup.

Poor performance is
experienced.

Processor is hot. 1. Be sure airflow to the workstation is not
blocked.

2. Be sure the fans are connected and working
properly (some fans only operate when
needed).

3. Be sure the CPU heatsink is installed
properly.

There is not enough
memory.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
Add more memory.

Hard drive is full. Delete data from the hard drive to create more
space on the hard drive.

Table 6-3  Minor problems (continued)
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Problem Cause Possible Solution

Workstation powered off
automatically and the
Power LED flashes red
two times, once every
second, followed by a
two-second pause, and
two simultaneous beeps
are heard.

Processor thermal
protection activated:

A fan might be blocked
or not turning.

OR

The CPU heatsink is not
properly attached to
the processor.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Check system and CPU fan cables.

2. Be sure workstation air vents are not
blocked and the cooling fan is running.

3. Open the access panel, press the power
button, and determine if the processor fan
spins. If not spinning, be sure the fan’s cable
is plugged into the system board header. Be
sure the fan is fully/properly seated or
installed.

4. Replace the processor fan.

5. Reseat CPU heatsink and verify that the fan
assembly is properly attached.

Workstation does not
power on and the LEDs
on the front of the
workstation are not
flashing.

System unable to
power on.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
Press and hold the power button for less than
four seconds. If the hard drive LED turns green,
then:

1. Remove the expansion cards.

2. Replace the system board.

OR

If the HDD LED does not illuminate, then:

1. Verify that the unit is plugged into a working
AC outlet.

2. Open the access panel, and verify that the
power button harness is properly connected
to the inline front panel I/O device assembly
connector.

3. Verify that the power supply cables are
properly connected to the system board.

4. Verify power supply functionality:

a. Disconnect AC power.

b. Remove all internal power supply
cables from the system board.

c. Plug in AC power.

● If the power supply fan spins and
the BIST* LED lights, then the
power supply is good. Replace the
system board.

● If the power supply fan does not
spin or the BIST* LED does not
light, replace the power supply.

Table 6-3  Minor problems (continued)
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Solving power supply problems

Testing power supply
Before reseating or replacing the power supply, use the BIST feature to determine if the power supply
still works.

To test the power supply:

1. Disconnect AC power to the workstation.

2. Disconnect all internal power supply cables.

3. Plug in AC power.

a. If the green BIST LED on the rear of the workstation is lit and the fan is spinning, the power
supply is functional.

b. If the green BIST LED is not lit or the fan is not spinning, replace the power supply.

Figure 6-1  BIST LED

Table 6-4  Power supply problems

Problem Cause Solution

Power supply shuts down
intermittently.

Power supply fault. Replace the power supply.
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Problem Cause Solution

Workstation powered off
automatically and the Power
LED flashes red two times,
once every second,
followed by a two-second
pause.

Processor thermal
protection activated.

A fan might be blocked
or not turning.

OR

The CPU heatsink fan
assembly is not properly
attached to the
processor.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Be sure that the workstation air vents are

not blocked and the cooling fan is running.

2. Open the access panel, press the power
button, and determine if the processor fan
spins. If the processor fan is not spinning,
be sure the fan’s cable is plugged into the
system board header. Be sure the fan is
properly seated or installed.

3. Check processor fan cables.

4. Replace the processor fan.

5. Reseat the CPU heatsink, and verify that
the fan assembly is properly attached.

Power LED flashes red,
once every two seconds.

Power failure (power
supply is overloaded).

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Determine whether a device is causing the

problem by removing all attached devices.
Power on the system. If the system enters
the POST, then power off and replace one
device at a time and repeat this procedure
until failure occurs. Replace the device
causing the failure. Continue adding
devices one at a time to ensure all devices
are functioning properly.

2. Verify power supply functionality.

a. Disconnect AC power.

b. Remove all internal power supply
cables from the system board.

c. Plug in AC power.

● If the power supply fan spins and
the BIST LED lights, then the
power supply is good. Replace the
system board.

● If the power supply fan does not
spin or the BIST LED does not
light, replace the power supply.

Table 6-4  Power supply problems (continued)
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Solving diskette problems
Table 6-5  Diskette problems

Problem Cause Solution

Diskette drive light stays on. Diskette is damaged. 1. Check power and data cables.

2. Click on My Computer.
3. Right-click on the desired hard drive and

select Properties.

4. Click the Tools tab.

5. Click Check Now... to run error checking.

Diskette is incorrectly
inserted.

Remove diskette and reinsert.

Files on diskette are
damaged.

Check the program diskettes.

Drive cable is not
properly connected.

Reconnect power cable. Be sure that all four
pins are connected.

Drive not found. Cable is loose. Reseat diskette drive data and power cables.

Removable drive is not
seated properly.

Reseat the drive.

Diskette drive cannot write
to a diskette.

Diskette is not formatted. Format the diskette.

Diskette is write-
protected.

Use another diskette or remove the write
protection.

Writing to the wrong
drive.

Check the drive letter in the path statement.

Not enough space is left
on the diskette.

Use another diskette.

Diskette write control is
enabled.

Use Computer Setup to check the storage
security feature disabled settings.

Diskette is damaged. Replace the damaged disk.

Cannot format diskette. Invalid media reported. Check to see if diskette is bad.

When formatting a disk in MS-DOS, you might
need to specify diskette capacity. For
example, to format a 1.44-MB diskette, enter
the following command at the command
prompt:

FORMAT A: /F:1440

A problem has occurred with
a disk transaction.

The directory structure
is bad, or there is a
problem with a file.

Right-click Start, click Explore, and select a
drive. Select File>Properties>Tools. Under
Error-checking, click Check Now.

142 Chapter 6   System diagnostics and troubleshooting ENWW



Problem Cause Solution

Diskette drive cannot read
a diskette.

Diskette is not formatted. Format the diskette.

You are using the wrong
diskette type for the drive
type.

Be sure you use the correct diskette type for
the type of drive you are using.

You are reading the
wrong drive.

Check the drive letter in the path statement.

Diskette is damaged. Replace the diskette with a new one.

Invalid system disk is
displayed.

A diskette that does not
contain the system files
needed to start the
workstation has been
inserted in the drive.

When drive activity stops, remove the diskette
and press the spacebar. The workstation
should start up.

Diskette error has
occurred.

Restart the workstation by pressing the
power button.

Cannot Boot from Diskette. Diskette is not bootable. Replace with a bootable diskette.

Diskette boot has been
disabled in Computer
Setup.

Run Computer Setup and enable diskette
boot in Storage>Boot Order.

Removable media boot
has been disabled in
Computer Setup.

Run Computer Setup and enable Removable
Media Boot in Storage>Storage Options.

Solving hard drive problems
Table 6-6  Hard drive problems

Problem Cause Solution

Hard drive error occurs. Hard disk has bad
sectors or has failed.

Use a disk analysis utility to locate and block
usage of bad sectors. If necessary, reformat
the hard disk.

Disk transaction problem. Either the directory
structure is bad or there
is a problem with a file.

1. Click on My Computer.
2. Right-click on the desired hard drive and

select Properties.

3. Click the Tools tab.

4. Click Check Now... to run error checking.

Table 6-5  Diskette problems (continued)
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Problem Cause Solution

Drive not found (identified). Loose cable. Check cable connections.

The system might not
have automatically
recognized a newly
installed device.

1. Run Computer Setup.

2. If the system still does not recognize the
new device, determine if the device is listed
within Computer Setup. If it is listed,
the probable cause is a driver problem. If it
is not listed, the probable cause is a
hardware problem.

3. If this is a newly installed drive, enter
Setup and try adding a POST delay
under Advanced>Power-On>Options.

Drive's SATA controller
is disabled in Computer
Setup.

Run Computer Setup and enable the SATA
controllers in Storage>Storage Options.

Drive responds slowly
immediately after power
on.

Run Computer Setup, and increase the POST
Delay in Advanced>Power-On Options.

Non-system disk/NTLDR
missing message.

System is trying to start
from a non-bootable
diskette.

Remove the diskette from the diskette drive so
the workstation boots from the hard disk.

Non-system disk/NTLDR
missing message.

System is trying to start
from a damaged hard
drive.

● Insert a bootable diskette into the diskette
drive or a CD into the optical drive and
restart the workstation.

System files missing or
not properly installed.

1. Insert a bootable system diskette and
restart.

2. Verify that the hard drive is partitioned and
formatted.

3. Install system files for the appropriate
operating system if necessary.

Hard drive boot disabled
in Computer Setup.

Run Computer Setup and enable the hard drive
entry from Storage Options, then reorder the
hard drive in the Storage>Boot Order list.

Both slow and fast UATA
devices are on the same
data cable.

Connect slower UATA devices to a separate
data cable connected to the secondary IDE
(ATA) controller.

Workstation will not start. Hard drive is damaged. Observe the beeps and LED lights on the front
of the workstation. See  POST error
messages on page 160.

Table 6-6  Hard drive problems (continued)
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Solving display problems
Table 6-7  Display problems

Problem Cause Solution

Blank screen (no video). The cable connections
are not correct.

Check the cable connections from the monitor
to the workstation and to a working electrical
outlet.

The monitor is off. Switch the monitor to on (LED is on). You might
need to refer to the monitor manual for an
explanation of the LED signals.

Screen blanking utility
installed or energy saver
features enabled.

Press any key or click the mouse button and, if
set, enter your password.

System ROM is bad;
system is running in
FailSafe Boot Block
mode (indicated by eight
blinks/beeps).

Reflash the ROM using a ROMPaq diskette or
a CD.

Fixed-sync monitor will
not sync at the resolution
chosen.

Be sure that the monitor can accept the same
horizontal scan rate as the resolution chosen.

Computer is in Standby
mode and the system
LED is flashing

Press the power button to resume from mode.

CAUTION: When attempting to resume from
Standby mode, do not hold down the power
button for more than four seconds. Otherwise,
the workstation will shut down and you will lose
your data.

Monitor settings in the
workstation are not
compatible with the
monitor.

1. Restart the workstation and press F8
during startup when you see Press F8 in
the bottom-right corner of the screen.

2. Using the keyboard arrow keys, select
Enable VGA Mode and press Enter.

3. In Windows Control Panel, double-click
the Display icon and click the Settings
tab.

4. Use the sliding control to reset the
resolution.

5. Refer to your operating system and
graphics card documentation for
information on changing display settings.
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Problem Cause Solution

The display works properly
during the POST but goes
blank when the OS starts.

The display settings in
the operating system are
incompatible with your
graphics card and
monitor.

1. Restart the workstation and press F8
during startup when you see Press F8 in
the bottom-right corner of the screen.

2. Using the keyboard arrow keys, select
Enable VGA Mode and press Enter.

3. In Windows Control Panel, double-click
the Display icon and click the Settings
tab.

4. Use the available functions to set the
display to the proper values.

5. Refer to your operating system and
graphics card documentation for
information on changing display settings.

Power LED flashes red six
times, once every second,
followed by a two second
pause, and the workstation
beeps six times.

Pre-video graphics
error.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Ensure that the auxiliary power cable (if

applicable) is securely connected.

2. Reseat the graphics card.

3. Replace the graphics card.

4. Replace the system board.

Monitor does not function
properly when used with
energy saver features.

Monitor without energy
saver capabilities is
being used with energy
saver features enabled.

Disable monitor energy saver feature.

Characters are dim. The brightness and
contrast controls are not
set properly.

Adjust the monitor brightness and contrast
controls.

Cables are not properly
connected.

Verify that the graphics cable is securely
connected to the graphics card and the
monitor.

Video is blurry or requested
resolution cannot be set.

If the graphics controller
was upgraded, the
correct video drivers
might not be loaded.

Install the video drivers included in the upgrade
kit.

Monitor is not capable of
displaying requested
resolution.

Change requested resolution.

Table 6-7  Display problems (continued)
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Problem Cause Solution

The picture is broken up,
rolls, jitters, or flashes.

The monitor connections
might be incomplete or
the monitor might be
incorrectly adjusted.

1. Be sure the monitor cable is securely
connected to the workstation.

2. In a two-monitor system or if another
monitor is in close proximity, be sure the
monitors are not interfering with each
other’s electromagnetic field by moving
them apart.

3. Be sure that fluorescent lights or fans are
not too close to the monitor.

Monitor needs to be
degaussed.

Degauss the monitor.

Vibrating or rattling noise
coming from inside a CRT
monitor when powered on.

Monitor degaussing coil
has been activated.

None. It is normal for the degaussing coil to be
activated when the monitor is powered on.

Clicking noise coming from
inside a CRT monitor.

Electronic relays have
been activated inside the
monitor.

None. It is normal for some monitors to make a
clicking noise when turned on and off, when
going in and out of Standby mode, and when
changing resolutions.

High pitched noise coming
from inside a flat panel
monitor.

Brightness and contrast
settings are too high.

Lower brightness and contrast settings.

Fuzzy focus; streaking,
ghosting, or shadowing
effects; horizontal scrolling
lines; faint vertical bars; or
unable to center the picture
on the screen. (Flat panel
monitors using an analog
VGA input connection only.)

Flat panel monitor’s
internal digital
conversion circuits might
be unable to correctly
interpret the output
synchronization of the
graphics card.

1. Select the monitor’s Auto-Adjustment
option in the monitor’s on-screen display
menu.

2. See the HP Support website and check for
an updated display driver.

3. Manually synchronize the Clock and Clock
Phase on-screen display functions.
Download the appropriate utility from the
HP website to assist with the
synchronization.

Certain typed symbols do
not appear correct.

The font you are using
does not support that
particular symbol.

Use the Character Map to locate the and select
the appropriate symbol. Click Start>All
Programs> Accessories>System
Tools>Character Map. You can copy the
symbol from the Character Map into a
document.

Table 6-7  Display problems (continued)
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Solving audio problems
Table 6-8  Audio problems

Problem Cause Solution

Sound does not come out of
the speaker or headphones.

Software volume control
is turned down.

Double-click the Speaker icon on the taskbar
and use the volume slider to adjust the volume.

The external speakers
are not turned on.

Turn on the external speakers.

External speakers are
plugged into the wrong
audio jack.

See the sound card documentation for proper
speaker connection.

Audio cable not
connected.

Connect audio cable between CD or DVD-
ROM drive and the system board.

Digital CD audio is
not enabled.

Enable digital CD audio:

1. From the Control Panel, select System.
2. On the Hardware tab, click Device

Manager.
3. Right-click the CD/DVD device and

select Properties.

4. On the Properties tab, be sure Enable
digital CD audio for this CD-ROM
device is selected.

Headphones or devices
connected to the line-out
connector mute the
internal speaker.

Turn on and use headphones or external
speakers, if connected, or disconnect
headphones or external speakers.

Volume is muted. 1. From the Control Panel program, click
Sound, Speech and Audio Devices, and
then click Sounds and Audio Devices.

2. Clear the Mute check box.

Computer is in Standby
mode and the system
LED is flashing.

Press the power button to resume from
Standby mode.

CAUTION: When attempting to resume from
Standby mode, do not hold down the power
button for more than four seconds. Otherwise,
the workstation will shut down and you will lose
your data.

Noise or no sound comes
out of the speakers or
headphones.

1. If using digital speakers that have a stereo
jack and want the system to auto-switch to
digital, use a stereo-to-mono adapter
to properly engage the auto-sense feature
or use the multimedia device properties
to manually switch the audio signal from
analog to digital.

2. If the headphones have a mono jack, use
the multimedia device properties to switch
the system to analog out.
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Problem Cause Solution

NOTE: If you set digital as the Output Mode, the internal speaker and external analog speakers will
no longer output audio until you switch back to an auto-sense or analog mode.
If you set analog as the Output Mode, external digital speakers will not function until you change the
output mode back to an auto-sense or digital mode.

Sound cuts in and out. Processor resources are
being used by other
open applications.

Shut down open processor-intensive
applications.

Workstation appears to be
locked up while recording
audio.

The hard disk might
be full.

1. Before recording, be sure there is enough
free space on the hard disk.

2. Try recording the audio file in a
compressed format.

Solving printer problems
Table 6-9  Printer problems

Problem Cause Solution

Printer does not print.Printer
cable loose.

Printer is not turned on
and online.

Turn the printer on and be sure it is online.

The correct printer driver
for the application are
not installed.

1. Install the correct printer driver for the
application.

2. Try printing using the DOS command:
DIR C:\> [printer port]

where [printer port] is the address of
the printer being used. If the printer works,
reload the printer driver.

If you are on a network,
you might not have
made the connection
to the printer.

Make the proper network connections to the
printer.

Printer might have failed. Run printer self-test.

Printer is out of ink/toner. Replenish ink/toner.

Printer cable loose. Check printer cable connection to non-
networked, local printer.

Printer does not turn on. The cables might not be
connected properly.

Reconnect all cables.

Printer prints garbled
information.

The correct printer driver
is not installed.

Install the correct printer driver for the
application.

The cables might not be
connected properly.

Reconnect all cables.

Printer memory might be
overloaded.

Reset the printer by turning it off for one minute,
then turn it back on.

Printer is offline. The printer might be out
of paper.

1. Check the paper tray and refill it if it is
empty.

2. Select online.

Table 6-8  Audio problems (continued)
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Solving keyboard and mouse problems
Table 6-10  Keyboard and mouse problems

Problem Cause Solution

Keyboard commands and
typing are not recognized by
the workstation.

Keyboard connector
is not properly
connected.

1. Power off the workstation.

2. Reconnect the keyboard to the workstation
and restart the workstation.

Program in use has
stopped responding
to commands.

Shut down the workstation using the mouse
and then restart the workstation.

Keyboard needs repairs. Replace the keyboard.

Keyboard key is stuck
down.

Remove any debris from the keyboard.

Workstation is in
Standby mode and the
system LED is flashing.

Press the power button to resume from
Standby mode.

CAUTION: When attempting to resume from
Standby mode, do not hold down the power
button for more than four seconds. Otherwise,
the workstation will shut down and you will lose
your data.

Cursor will not move using
the arrow keys on the
keypad.

The Num Lock key
might be on.

Press the Num Lock key. The Num Lock light
should not be on if you want to use the arrow
keys. The Num Lock key can be disabled
(or enabled) in Computer Setup.

Mouse does not respond to
movement or is too slow.

Mouse connector is
not properly plugged into
the back of the
workstation.

1. Shut down the workstation using the
keyboard.

2. Plug the mouse connector into the PS/2 or
USB mouse connector in the workstation
and restart the workstation.

You need to increase
mouse acceleration.

1. In Windows, click Start>Control Panel
and double-click Mouse.

2. Select the Motion tab and adjust the
speed.

Program in use has
stopped responding
to commands.

Shut down the workstation using the keyboard
and then restart the workstation.

Mouse needs repairs. Replace the mouse.

Workstation is in
Standby mode and
system LED is flashing.

Press the power button to resume from Stand
By mode.

CAUTION: When attempting to resume from
Standby mode, do not hold down the power
button for more than four seconds. Otherwise,
the workstation will shut down and you will lose
your data.

Mouse will only move
vertically or horizontally,
or movement is jerky.

Mouse roller ball is dirty. Remove roller ball cover from the bottom of the
mouse and clean it.
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Solving front panel component problems
If you are experiencing problems with one of the front panel ports, you might be able to try your device
in the corresponding port on the back side of the computer. If this does not fix the problem, or you must
use the front panel ports, continue troubleshooting.

Some problems in this section are also discussed in other troubleshooting suggestions in this chapter.

Table 6-11  Front panel component problems

Problem Cause Solution

If a USB device,
headphone, or microphone
is not recognized by the
workstation.

It is not properly
connected.

1. Power off the workstation.

2. Reconnect the device to the workstation
and restart the workstation.

The device does not
have power.

If the USB device requires AC power, be sure
one end is connected to the device and one end
is connected to a live outlet.

The correct device driver
is not installed.

1. Install the correct driver for the device.

2. You might need to reboot the workstation.

The cable from the
device to the computer
does not work.

1. If possible, replace the cable.

2. Restart the workstation.

The device is not
working.

1. Replace the device.

2. Restart the workstation.

If a USB, audio, and
IEEE-1394 devices are not
working.

The internal cables
might not be connected
to the system board or
the PCI card.

1. Power off the workstation.

2. Connect the cables correctly.

A device in the IEEE-1394a
port is not responsive.

Cables of new external
device are loose or
power cables are
unplugged.

Be sure that all cables are properly and
securely connected.

The power switch on the
device is not turned on.

Power off the workstation, and power on the
external device, then turn on the workstation to
integrate the device with the workstation
system.

Solving hardware installation problems
You might need to reconfigure the workstation when you add or remove hardware, such as an additional
diskette drive. If you install a PnP (Plug 'n Play) device, Windows XP automatically recognizes the device
and configure the workstation. If you install a non-PnP device, you must reconfigure the workstation
after completing installation of the new hardware.
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Table 6-12  Hardware installation problems

Problem Cause Solution

A new device is not
recognized as part of
the system.

Device is not seated or
connected properly.

Be sure that the device is properly and securely
connected and that pins in the connector are
not bent.

Cables of new external
device are loose or
power cables are
unplugged.

Be sure that all cables are properly and
securely connected and that pins in the cable
or connector are not bent.

Power switch of new
external device is not
turned on.

Power off the workstation, power on the
external device, and power on the workstation
to integrate the device with the workstation
system.

When the system
advised you of changes
to the configuration, you
did not accept them.

Reboot the workstation, and follow the
instructions for accepting the changes.

A PnP board might not
automatically configure
when added if the
default configuration
conflicts with other
devices.

Use the Device Manager to clear the automatic
settings for the board and select a basic
configuration that does not cause a resource
conflict. You can also use Computer Setup to
reconfigure or disable devices to resolve the
resource conflict.

Device hardware is not
properly jumpered or
otherwise configured.

Read the device-specific configuration
information and check for incorrect settings or
conflicts with other devices already installed in
the system.

Workstation will not start. Wrong memory modules
were used in the
upgrade or memory
modules were installed
in the wrong location.

1. Review workstation documentation to
determine if you are using the correct
memory modules and to verify the proper
installation.

2. Observe the beeps and LED lights on the
front of the workstation. Refer to  POST
error messages on page 160 to determine
possible causes.

PCI Express power
cable might be plugged
into the wrong power
connector.

Ensure that the auxiliary PCI Express power
cable is correctly connected to the PCI Express
card.
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Problem Cause Solution

Power LED flashes red five
times, once every second,
followed by a two second
pause, and the workstation
beeps five times.

Memory is installed
incorrectly or is bad.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Ensure DIMMs are loaded in the correct

slots.

2. Reseat DIMMs.

3. Replace DIMMs one at a time to isolate the
faulty module.

4. Replace third-party memory with HP
memory.

5. Replace the system board.

Power LED flashes red six
times, once every second,
followed by a two second
pause, and the workstation
beeps six times.

Video card is not seated
properly or is bad, or
system board is bad.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Ensure that auxiliary power cable is

connected correctly, if applicable.

2. Reseat the graphics card.

3. Replace the graphics card.

4. Replace the system board.

Solving network problems
These guidelines do not discuss the process of debugging the network cabling.

Table 6-13  Network problems

Problem Cause Solution

Wake-on-LAN feature is
not functioning.

Wake-on-LAN is not
enabled.

Use the Network control application to enable
Wake-on-LAN.

Network driver does
not detect network
controller.

Network controller is
disabled.

Run Computer Setup and enable network
controller.

Incorrect network driver. Check the network controller documentation
for the correct driver, or obtain the latest driver
from the manufacturer’s website.

Network status link light
does not turn on or it never
flashes.

The network status light
should flash when there is
network activity.

No active network is
detected.

Check cabling and network equipment for
proper connection.

Network controller is not
set up properly.

Use the network control application to verify
that the device is working properly.

Network driver is not
properly loaded.

Reinstall network drivers.

System cannot auto-sense
the network.

Disable auto-sensing capabilities and force
the system into the correct operating mode.

Table 6-12  Hardware installation problems (continued)
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Problem Cause Solution

Diagnostics reports a
failure.

The cable is not securely
connected.

Be sure that both ends of the data cable are
securely connected.

The cable is attached to the
incorrect connector.

Be sure that the cable is attached to the correct
connector.

There is a problem with the
cable or a device at the
other end of the cable.

Be sure that the cable and device at the other
end are operating correctly.

Network controller interrupt
is shared with
an expansion board.

Under the Computer Setup Advanced menu,
change the resource settings for the board.

The network controller
is defective.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
Replace the NIC.

Diagnostics passes, but
the workstation does not
communicate with the
network.

Network drivers are
not loaded, or driver
parameters do not match
current configuration.

1. Be sure the network drivers are loaded
and that the driver parameters match the
configuration of the network controller.

2. Be sure the correct network client and
protocol is installed.

The network controller
is not configured for this
workstation.

Select the Network icon in the Control Panel
and configure the network controller.

Network controller
stopped working when an
expansion board was
added to the workstation.

Network controller interrupt
is shared with an
expansion board.

Under the Computer Setup Advanced menu,
change the resource settings for the board.

The network controller
requires drivers.

Verify that the drivers were not accidentally
deleted when the drivers for a new expansion
board were installed.

The expansion board
installed is a Network
Interface Card (NIC) and
conflicts with the
embedded NIC.

Under the Computer Setup Advanced menu,
change the resource settings for the board.

Network controller stops
working without apparent
cause.

The files containing the
network drivers are
corrupted.

Reinstall the network drivers, using the
Restore Plus! CD.

The cable is not securely
connected.

Be sure that both ends of the cable are
securely attached to the correct devices.

The network controller is
defective.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
Replace the NIC.

New network card will not
boot.

New network card might be
defective or might not meet
industry-standard
specifications.

Install a working, industry-standard NIC, or
change the boot sequence to boot from
another source.

Table 6-13  Network problems (continued)
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Problem Cause Solution

Cannot connect to
network server when
attempting Remote
System Installation.

The network controller is
not configured properly.

Verify Network Connectivity, that a DHCP
Server is present, and that the Remote System
Installation Server contains the NIC drivers for
your NIC.

System setup utility
reports unprogrammed
EEPROM.

Unprogrammed EEPROM. Flash the ROM.

Solving memory problems
CAUTION: For those systems that support ECC memory, HP does not support mixing ECC and non-
ECC memory. Otherwise, the system will not boot the operating system.

Table 6-14  Memory problems

Problem Cause Solution

System will not boot or does
not function properly after
installing additional memory
modules.

Memory module is not
the correct type or
speed, or the new
memory module is not
seated properly.

Replace module with the correct industry-
standard device for the workstation.

Out of memory error. Memory configuration
might not be set up
correctly.

Use the Device Manager to check memory
configuration.

You have run out of
memory to run the
application.

Check the application documentation to
determine the memory requirements, or add
more memory.

Memory count during POST
is wrong.

The memory modules
might not be installed
correctly.

Check that the memory modules have been
installed correctly and that proper modules are
used.

Insufficient memory error
during operation.

Too many Terminate
and Stay Resident
programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of
memory for the
application.

Check the memory requirements for the
application or add more memory to the
workstation.

Table 6-13  Network problems (continued)
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Problem Cause Solution

Power LED flashes red 5
times, once every second,
followed by a 2-second
pause, and the workstation
beeps 5 times.

Memory is installed
incorrectly or is bad.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Ensure DIMMs are loaded in the correct

slots.

2. Reseat DIMMs.

3. Replace DIMMs one at a time to isolate the
faulty module.

4. Replace third-party memory with HP
memory.

5. Replace the system board.

A total of 4 GB of RAM is
installed, yet the 32–bit OS
only recognizes ? 3 GB.

A 32–bit OS is limited by
4 GB of address space,
and some of the space is
used by I/O devices.

Use a video card that uses less on-board
memory.

Solving processor problems
Table 6-15  Processor problems

Problem Cause Solution

Poor performance is
experienced.

Processor is hot. 1. Be sure the airflow to the workstation is not
blocked.

2. Be sure the fans are connected and
working properly (some fans only operate
when needed).

3. Be sure the CPU heatsink is installed
properly.

Power LED is red and
stays on.

Processor is not seated
properly or not installed.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Check to see that the processor is present.

2. Reseat the processor.

Table 6-14  Memory problems (continued)
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Solving CD-ROM and DVD problems
Table 6-16  CD-ROM and DVD problems

Problem Cause Solution

System will not boot from
CD-ROM or DVD drive.

The CD-ROM or DVD
boot is not enabled
through the Computer
Setup utility.

Run the Computer Setup utility and enable
booting to removable media and verify boot
order settings.

Non-bootable CD/DVD
in drive.

Place a bootable CD/DVD in the drive.

CD-ROM or DVD devices
are not detected or driver is
not loaded.

Drive is not connected
properly or not properly
configured.

1. Reconnect power and data cables to the
drive.

2. Install correct device driver.

Movie will not play in the
DVD drive.

Movie might be
regionalized for a
different country.

See the documentation that came with the
DVD drive.

Decoder software is not
installed.

Install decoder software.

Cannot eject compact disc
(tray-load unit).

Disc not properly seated
in the drive.

1. Power off the workstation, and insert a thin
metal rod into the emergency eject hole
and push firmly.

2. Slowly pull the tray out from the drive until
the tray is fully extended, and remove
the disc.

CD-ROM, CD-RW, DVD-
ROM, or DVD-R/RW drive
cannot read a disc or takes
too long to start.

Disc has been inserted
upside down.

Reinsert the disc with the label facing up.

The DVD-ROM drive
takes longer to start
because it has to
determine the type of
media played, such as
audio or video.

Wait at least 30 seconds to let the DVD-ROM
drive determine the type of media being
played. If the disc still does not start, read the
other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit.

Windows does not
detect the CD-ROM or
DVD-ROM drive.

1. Use Device Manager to remove or
uninstall the device in question.

2. Restart the workstation and allow
Windows to detect the device.

Recording audio CDs is
difficult or impossible.

Wrong or poor quality
media type.

1. Try using a slower recording speed.

2. Verify that you are using the correct media
for the drive.

3. Try a different brand of media. Quality
varies widely between manufacturers.
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Solving Internet access problems
Table 6-17  Internet access problems

Problem Cause Solution

Unable to connect to the
Internet.

Internet Service
Provider (ISP) account is
not set up properly.

Verify Internet settings or contact the ISP for
assistance.

Modem is not set up
properly.

Reconnect the modem. Verify the connections
are correct using the quick setup
documentation.

Web browser is not set
up properly.

Verify that the web browser is installed and set
up to work with your ISP.

Cable/ DSL modem is
not plugged in.

Plug in cable/DSL modem. You should see a
“power” LED light on the front of the cable/DSL
modem.

The network cable is
disconnected.

Connect the network cable between the cable
modem and the workstation RJ-45 connector.
If the connection works, the PC LED light on the
front of the cable/DSL modem will be on.

Cable/DSL service is not
available or has been
interrupted due to bad
weather.

Try connecting to the Internet at a later time or
contact your ISP. (If the cable/DSL service is
connected, the “cable” LED light on the front of
the cable/DSL modem will be on.)

The CAT5 10/100/1000
cable is disconnected.

Connect the CAT5 10/100 cable between the
cable modem and the workstations’s RJ-45
connector. (If the connection is good, the “PC”
LED light on the front of the cable/DSL modem
will be on.)

IP address is not
configured properly.

Contact the ISP for the correct IP address.

Cookies are corrupted. 1. Select Start>Control Panel.
2. Double-click Internet Options.

3. On the General tab, click Delete Cookies.
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Problem Cause Solution

Cannot automatically
launch Internet programs.

You must log on to the
ISP before some
programs will start.

Log on to the ISP and launch the desired
program.

Internet takes too long to
download websites.

Modem is not set up
properly.

Verify that the correct modem speed and COM
port are selected.

1. Select Start>Control Panel.
2. Double-click System.

3. Click the Hardware tab.

4. In the Device Manager area, click Device
Manager.

5. Double-click Ports (COM & LPT).

6. Right-click the COM port your modem
uses, then click Properties.

7. Under Device status, verify that the modem
is working properly.

8. Under Device usage, verify the modem is
enabled.

9. If there are further problems, click
Troubleshoot and follow the on-screen
instructions.

Table 6-17  Internet access problems (continued)
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POST error messages
POST is a program run at startup that initializes and runs some tests on installed hardware. An audible
and/or visual message occurs if the POST encounters a problem. POST checks the following items to
ensure that the workstation system is functioning properly:

● Keyboard

● Memory modules

● Diskette drives

● All SATA, IDE, and SAS mass storage devices

● Processors

● Controllers

NOTE: If the Power-On Password is set, a key icon appears on the screen while POST is running.
You must enter the password before continuing.

Table 6-18  POST error messages

Screen Message Probable Cause Recommended Action

101–Option ROM Error. Plug-in card ROM checksum. Update the ROM on the card.

102–System Board
Failure

DMA, timers. CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Clear CMOS by pressing the Clear

CMOS button on the system board.

2. Remove expansion boards.

3. Replace the system board.

103–System Board
Failure

DMA, timers. CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Clear CMOS by pressing the Clear

CMOS button on the system board.

2. Remove expansion boards.

3. Replace the system board.

110–Out of Memory
Space for Option ROMs

Option ROM for a device was
unable to run due to memory
constraints.

Remove expansion boards and disable
unneeded devices from I/O>Onboard
Devices or Storage>Storage Options.
Run Computer Setup (F10).

162–System Options Not
Set

Your system configuration has
changed since your last boot,
in which case press F1. Or, a
loss of power to the Real Time
clock has occurred.

1. Run Computer Setup (F10).

2. Set the date and time under Windows
Control Panel or in the F10 Setup menu.

3. If the problem persists, replace the RTC
battery.
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Screen Message Probable Cause Recommended Action

163–Time and Date
Not Set

Invalid time or date in
configuration memory.

RTC (real-time clock) battery
might need to be replaced.

1. Set the date and time under Control
Panel or in F10 Setup, depending on the
operating system.

2. If the problem persists, replace the RTC
battery.

164–Memory Size Error The system memory size has
changed since the last boot.

1. Pressing F1 will record the
configuration.

2. If the problem persists, be sure memory
modules (if any) are installed correctly.

3. If third-party memory has been added,
test using HP memory only.

4. Verify proper memory module type.

201–Memory Error The memory test performed
during startup failed.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Run Computer Setup (F10 Setup) or

Windows utilities.

2. Ensure that memory modules are
installed correctly.

3. Verify proper memory module type.

4. If third-party memory has been added,
test using HP memory only.

5. Remove and replace memory modules
one at a time to isolate faulty module.

6. Replace the faulty memory modules.

7. If error persists after replacing memory
modules, replace the system board.

207–ECC Corrected
Single Bit Errors in DIMM
slot(s)

Corrected ECC error(s)
detected.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Verify proper memory module type.

2. Verify 3rd party/HP memory.

3. Try another memory socket.

4. Replace memory module if problem
persists.

Table 6-18  POST error messages (continued)
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Screen Message Probable Cause Recommended Action

211–Memory warning
condition detected

An unknown issue with one of
the DIMMs has been detected.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Verify proper memory module type.

2. Try another memory socket.

3. Replace memory module if problem
persists.

213–Incompatible ECC
Memory Module in
memory Socket(s)

The memory modules in the
system are either not all ECC,
or not all non-ECC. This could
also be caused because the
DIMM is missing critical SPD
information.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Verify that all memory modules are ECC

or non-ECC.

2. Replace memory module if problem
persists.

214–DIMM
Configuration Warning

DIMMs not installed correctly
(not paired correctly).

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
Refer to Memory on page 72 for the correct
memory configurations and reseat the
DIMMs accordingly.

215–Cannot Interleave
Unequal Memory Nodes

Memory node interleave
enabled but memory on CPU0
is unequal with the memory on
CPU1.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Reconfigure memory in both nodes

equally.

2. Disable memory node interleave.

301–Keyboard Error Keyboard failure. 1. Reconnect keyboard with workstation
powered off.

2. Check the connector for bent or missing
pins.

3. Be sure that none of the keys are
pressed or stuck.

4. Replace keyboard.

303–Keyboard
Controller Error

I/O board keyboard controller. CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Reconnect keyboard with workstation

powered  off.

2. Replace the system board.

Table 6-18  POST error messages (continued)
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Screen Message Probable Cause Recommended Action

304–Keyboard or
System Unit Error

Keyboard failure. CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Reconnect the keyboard to the

powered-off workstation.

2. Be sure that none of the keys are
pressed or stuck.

3. Replace keyboard.

4. Replace system board.

510–Splash Screen
Image Corrupted

Splash Screen image has
errors.

Restore BIOS.

511–CPU Fan Not
Detected

Fan is not connected or it might
have malfunctioned.

1. Reseat fan cable.

2. Reseat the fan.

3. Replace the fan.

512–PCI 1 Fan Not
Detected

Fan is not connected or it might
have malfunctioned.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Reseat PCI fan cable.

2. Replace PC1 fan.

513–Chassis Fan or
Memory Fan Not
Detected

Memory or system fan is not
connected or it might have
malfunctioned.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Reseat memory or system fan

connector.

2. Replace memory or system fan.

514–VRD fan not
detected

VRD fan on liquid cooling unit
not functioning.

Verify VRD fan operation; replace if
necessary.

516–Processors Do Not
Have the Same
Frequency Operating
Range

Installed processors operate at
different frequencies.

Replace a processor so that both operate at
the same frequency.

516–Processors Do Not
Have the Same
Frequency Operating
Range

Installed processors operate at
different frequencies.

Replace a processor so that both operate at
the same frequency.

Table 6-18  POST error messages (continued)
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517–Front IEEE 1394
Not Connected

Front IEEE 1394 port is not
connected.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Connect IEEE 1394 cable to system

board.

2. Replace system board.

518–Detected invalid
MAC address

Workstation has invalid MAC
address.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
● Verify correct MAC address. If incorrect,

replace system board.

601–Diskette Controller
Error

Diskette controller circuitry or
diskette drive circuitry
incorrect.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Run Computer Setup (F10 Setup).

2. Ensure that cables are connected
correctly.

3. Check and replace cables.

4. Clear CMOS by pressing the Clear
CMOS button on the system board.

5. Replace diskette drive.

6. Replace the system board.

605–Diskette Drive Type
Error

Mismatch in drive type. 1. Check drive cables.

2. Run Computer Setup (F10 Setup).

3. Disconnect any other diskette controller
devices (tape drives).

4. Clear CMOS by pressing the Clear
CMOS button on the system board.

5. Replace diskette drive.

710–NET Watchdog
Timer Expired from Last
Boot

System hung during last boot. Press F1 to boot.

912–Computer Cover
Has Been Removed
Since Last System Start
Up

System has been opened
since last boot.

No action required.

914–Hood Lock Coil is
not Connected

Hood lock mechanism is
missing or not connected.

1. Reconnect or replace the hood locking
mechanism.

2. Reseat or replace the hood locking
mechanism cable.

Table 6-18  POST error messages (continued)
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915–Fan Power from
Power Supply Not
Connected

The fan power cable is not
connected, or the power
supply is bad.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Verify that all power supply cables are

connected.

2. Replace the power supply.

916–Power Button Not
Connected

The power button is not
connected.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
Connect the power button.

917–Front Audio Not
Connected

The front audio cable is not
connected.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
Connect the front audio cable.

918–Front USB Not
Connected

Front USB is not connected. CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
Connect the front USB cable.

921–Device in PCI
Express Slot Failed to
Initialize

A PCI Express card was
detected in one of the slots, but
failed to initialize properly.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
Reseat all PCI Express cards. If this failure
occurred after inserting a new card, there
could be a problem with that card.

922–Fatal error on slot # Fatal error occurred in the
designated slot.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
Try moving card to a different slot. If the
problem persists, try replacing the card.

923–Non fatal error on
slot #

A PCI or PCIe non-fatal error
condition occurred for the
device in the designated slot.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Reseat the card.

2. Try moving card to a different slot.

3. If the problem persists, replace the card.
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1155–Serial Port
Address Conflict
Detected.

Both external and internal
serial ports are assigned to
same IRQ.

1. Remove any COM port expansion
cards.

2. Clear CMOS by pressing the Clear
CMOS button on the system board.

3. Reconfigure card resources and run
Computer Setup (F10 Setup).

4. Run Computer Setup or Windows
utilities.

1201–System Audio
Address Conflict
Detected

Device IRQ address conflicts
with another device. (Usually
due to an add-in audio card.)

Reset the IRQ.

1720 SMART Hard Drive
Detect Imminent Failure

Hard drive is about to fail.
(Some hard drives have a
firmware patch that will fix an
erroneous error message.)

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Determine if hard drive is giving correct

error message.

2. Run the Drive Protection System test if
applicable.

3. Apply firmware patch if applicable
(see  http://www.hp.com/support).

4. Back up contents and replace hard
drive.

1800–Temperature Alert Internal temperature exceeds
specification.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
1. Check that workstation air vents are not

blocked and that the cooling fan is
running.

2. Verify processor speed selection.

3. Replace the processor.

4. Replace the system board.

1801–Microcode Update
Error

Missing or Invalid Processor
Microcode Update.

Upgrade BIOS to the current version.

1802–CPU0 Not
Supported

The system board does not
support the processor.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
Replace the processor with a compatible
one.

Table 6-18  POST error messages (continued)
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Screen Message Probable Cause Recommended Action

1803–CPU1 Not
Supported

The system board does not
support the processor.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
Replace the processor with a compatible
one.

1805–CPU Bypass
Board is Missing

Bypass board not detected on
single-processor system.

CAUTION: Disconnect AC power from the
workstation before reseating or replacing
components because there is power to the
system board even when the workstation is
powered down.
Install bypass board or install second
processor.

Invalid Electronic Serial
Number

Electronic serial number has
become corrupted.

● Run Computer Setup. Enter the serial
number under Security>System IDs,
and save the changes.

Table 6-18  POST error messages (continued)
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A Appendix A — SAS devices

Supported SAS RAID configurations
The following RAID configurations are supported on the HP xw9400 Workstation.

NOTE:  This section does not apply to configuring RAID in the Linux environment. For RAID in the
Linux environment, configure SW RAID configurations as provided by Red Hat Enterprise Linux.

● Up to 5 internal or 8 external SAS hard disk drives/JBOD.

● External connections require optional internal-to-external cable

● SAS drives require SATA to SAS data and power converter

● LSI MyStorage Utility for Windows

● RAID 0 (IS) – Striped disk array

◦ Two drives minimum

◦ Improved I/O performance

◦ No fault tolerance

● RAID 1 (IM) — Mirrored disk array

◦ Two drives

◦ Improved read performance

◦ 100% redundancy

◦ Can recover from single drive failure

● RAID 1E (IME)

◦ Three drives minimum

◦ Can be an odd number of drives

◦ Can always recover from a single drive failure, and in some cases, recover from two drive
failures

SAS RAID 0 (IS) configuration
Follow the steps below to configure an Integrated Striped (IS) volume with the BIOS-based configuration
utility. The configuration procedure assumes that the system already has the required disks attached to
the SAS/SATA ports.

1. At the BIOS splash screen, press any key to view option ROM messages.

2. Press Ctrl-C at the prompt Press Ctrl-C to Start LSI Logic Configuration Utility to start the utility.

3. On the Adapter List screen of the LSI Logic Config Utility, use the arrow keys to highlight an adapter
(SAS1068e), then press Enter.
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4. On the Adapter Properties screen use the arrow keys to highlight RAID Properties, then press
Enter.

5. In the Select New Array Type-SAS1068e screen, use the arrow keys to highlight Create IS
Volume, then press Enter.

6. In the Create New Array-SAS1068e screen, use the arrow keys to select the first disk for the Create
IS volume. Then use the arrow keys to move to the Raid Disk column for this disk, and press
the SPACE, +, or - key to select Yes as the value for this column. If there is existing data on the
disk, a message displays warning you that data on the disk is lost when the striped volume is
created. Press the M key to migrate, or the D key to delete the data on the drive.

NOTE: An xw9400 chassis supports up to 5 internal hard disk drives. Using external cables, up
to three additional drives can be connected via individual external drives for a total of eight drives.
Up to 128 devices can be supported via connection to a JBOD.

7. Repeat the previous step to select up to four more disks for the striped volume.

8. Press the C key to create the array once all drives have been chosen.

9. Use the arrow keys to select Save Changes then Exit this Menu, then press Enter.

10. Press Esc-Esc. Use the arrow keys to highlight Exit the Configuration Utility and Reboot, then
press Enter.

11. If necessary, change the boot order in system BIOS to obtain the correct boot device.

SAS RAID 1 (IM) configuration
Follow the steps below to configure an Integrated Mirroring (IM) volume with the BIOS-based
configuration utility. The configuration procedure assumes that the system already has the required
disks attached to the SAS/SATA ports.

1. At the BIOS splash screen, press any key to view option ROM messages.

2. Press Ctrl-C at the Press Ctrl-C to Start LSI Logic Configuration Utility prompt to enter the
configuration utility.

3. On the Adapter List screen of the LSI Logic Config Utility, use the arrow keys to highlight an adapter
(SAS1068e), then press Enter.

4. On the Adapter Properties-SAS1068e screen use the arrow keys to highlight RAID Properties,
then press Enter.

5. On the Select New Array Type screen, use the arrow keys to highlight the Create Volume IM
volume, then press Enter.

6. In the Create New Array-SAS1068e screen, use the arrow keys to select the primary disk for the
IM volume (the disk with the data you want to mirror.) Use the arrow keys to move to the Raid Disk
column for this disk and use the Space, +, or - key to select Yes as the value. If there is existing
data on the disk, a message appears warning you that data on the disk is lost when the disk is
used in an IM array.

Press the M key to keep the existing data and migrate to an IM array. Synchronization of the disk
occurs. Press he D key to overwrite the existing data and create a new IM array. No synchronization
is performed.

CAUTION: All data on all disks in the array is deleted if D is selected.

After selecting M or D, the Drive Status changes to Primary for the initial drive selected.
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7. Use the arrow keys to select the secondary (mirrored) disk for the IM volume. Use the SPACE,
+, or - key to select Yes as the value for the Array Disk column. When the second drive selected
in RAID Disk is set to Yes, Drive Status changes to Secondary.

● [Optional] Use the arrow keys to select a hot spare disk for the IM volume. Use SPACE, +,
or - to select Yes as the value in the Hot Spr column.

8. When you have completed selection of drives and hot spares for the IM array, press C to create
the array.

9. Use the arrow keys to select Save Changes then Exit this Menu, then press Enter.

10. Press Esc-Esc. Use the arrow keys to highlight Exit the Configuration Utility and Reboot, and
press Enter.

11. If necessary, change the boot order in system BIOS to obtain the correct boot device.

SAS RAID 1E (IME) configuration
Follow the steps below to configure an Integrated Mirroring Extended (IME) volume with the BIOS-based
configuration utility. The configuration procedure assumes that the system already has the required
disks attached to the SAS/SATA ports.

1. At the BIOS splash screen, press any key to view option ROM messages.

2. Press Ctrl-C at the Press Ctrl-C to Start LSI Logic Configuration Utility prompt to enter the
configuration utility.

3. On the Adapter List screen of the LSI Logic Config Utility, use the arrow keys to highlight an adapter
(SAS1068e), then press Enter.

4. On the Adapter Properties-SAS1068e screen use the arrow keys to select RAID Properties, then
press Enter.

5. On the Select New Array Type-SAS1068e screen, use the arrow keys to highlight Create IME
Volume, then press Enter.

● In the Create New Array-SAS1068e screen, use the arrow keys to select the first disk for the
IME volume. Use the arrow keys to move to the RAID Disk column for this disk, and use
the SPACE, +, or - key to select Yes as the value.

6. Use the arrow keys to select the next disk for the IME volume. Use the SPACE, +, or - key to
select Yes as the value for the RAID Disk column.

7. Repeat the previous steps to select up to four more disks for the IME volume. If you want to
configure a hot spare disk for the volume, you can only select up to three more disks.

● [Optional] Use the arrow keys to select a Hotspare disk for the IME volume. Use SPACE, +,
and - to select Yes as the value in the Hot Spr column.

8. When you have completed selection of the drives and hot spares for the IME array, press C to
create the array.

9. Use the arrow keys to highlight Save Changes Then Exit this Menu, and press Enter.

10. Press Esc-Esc. Use the arrow keys to highlight Exit the Configuration Utility and Reboot, and
press Enter.

11. If necessary, change the boot order in system BIOS to obtain the correct boot device.
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Changing boot order
If the RAID array will be a data array, the disk drive with the operating system must appear higher in the
boot order. If the RAID array will be the operating system drive, it should appear higher in the boot order.

To change the boot order:

1. Press F10 to call up the BIOS Setup utility when booting the system.

2. If first boot, select the desired language and press Enter. English is the default.

3. Use the arrow keys to highlight Storage>Boot Order, and press Enter.

4. In the Hard Drive section device names are listed in order of boot. Use the arrow keys to move the
cursor to the device that you want to move. Press Enter to highlight the device.

5. Use the up/down arrow keys to move the device to the desired order location. Press Enter to un-
highlight the device.

6. Press F10 to save changes.

7. Use the arrow keys to highlight File>Save Changes and Exit. Press Enter, then F10.
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B Appendix B—SATA devices

This appendix describes how to use the NVIDIA MediaShield utility to set up and manage SATA RAID
volumes.

The SATA RAID option must be enabled in BIOS and the SATA drives must be attached to the
workstation ports to configure them into a RAID array.

Attach the required number of SATA HDDs for the desired RAID level:

● RAID 0–two to six HDDs–data is striped across drives for performance

● RAID 1–two HDDs–data is mirrored on two drives for security

● RAID 5–three to six HDDs–data is striped across drives with parity for performance with security

● RAID 10–four to six HDDs–data is mirrored and striped across all drives for security and some
performance

Enable SATA RAID option in BIOS
To enable the SATA RAID option in BIOS:

1. During boot up, press F10 to enter the Setup menu. Entering BIOS Setup (Press F10) appears
at the bottom of the screen.

2. If first boot, select the desired language and press Enter.

3. Use the arrow keys to highlight I/O>Device Options and press Enter.

4. Use the up/down arrow keys to place the cursor next to SATA RAID. Use the left/right arrow keys
to change the State to Enable.

NOTE: All six ports (0–5) then indicate they are enabled. If the operating system boot drive is a
non-RAID SATA drive, this port should have RAID disabled.

5. Use the up/down arrow keys to place the cursor next to the ports that are not to be included in the
RAID array. Use the left/right arrow keys to change the state of each of them to Disable.

6. Press F10 when all ports have been set to the desired state.

7. Use the arrow keys to highlight File>Save Changes and Exit. Press Enter, then press F10 to save
changes.

The workstation will reboot after the changes are saved. After the workstation reboots, the BIOS displays
the MediaShield copyright message.

Configuring a SATA RAID array
To configure a SATA RAID array:

1. At the BIOS splash screen, press any key to view option ROM messages.

2. Press F6 to enter the RAID setup utility when Press F6 to enter RAID setup utility is displayed.
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3. On the Define a New Array screen, RAID Mode is highlighted in blue and mirroring is set as the
default setting. Press Enter to show the RAID modes. This mode enables control of mirroring,
striping, stripe mirroring, spanning, and RAID 5.

4. Use the up/down arrow keys to highlight in red the desired RAID type, then press Enter. The desired
RAID mode will be highlighted in blue.

5. Press the Tab key to move the blue highlight to Striping Block:.

6. Use the up/down arrow keys to highlight in red the desired striping block size (4K, 8K, 16K 32K,
64K, 128K or Optimal). Press Enter to select the desired size.

NOTE: Optimal is the default and is generally selected. It is determined by the RAID controller
for best fit.

7. Press the Tab key to move the blue highlight to the Free Disks section.

NOTE: All drives available for RAID are listed and the first drive is highlighted in red.

8. Use the up/down arrow keys to highlight in red the drives to be included in the RAID array.

9. Use the right arrow key to move the drive to the Array Disks section.

NOTE: The left arrow key moves the red highlighted drive in the Array Disks section to the Free
Disks section.

10. Press F7 to finish when all desired drives selected for the array are in the Array Disks section.

11. To clear disk data press Y, or to save disk data in the array press N.

The Array List window appears showing the created array. It contains Status, Bootable, Vendor,
and Array Model Name information.

12. Press Ctrl-X to exit the utility.

Changing boot order
If the RAID array will be a data array, the disk drive with the operating system must appear higher in the
boot order. If the RAID array will be the operating system drive, it should appear higher in the boot order.

To change the boot order:

1. Press F10 to call up the BIOS Setup utility when booting the system.

2. If first boot, select the desired language and press Enter. English is the default.

3. Use the arrow keys to highlight Storage>Boot Order, and press Enter.

4. In the Hard Drive section device names are listed in order of boot. Use the arrow keys to move the
cursor to the device that you want to move. Press Enter to highlight the device.

5. Use the up/down arrow keys to move the device to the desired order location. Press Enter to un-
highlight the device.

6. Press F10 to save changes.

7. Use the arrow keys to highlight File>Save Changes and Exit. Press Enter, then F10.
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Deleting RAID volumes
Use the NVIDIA MediaShield utility to delete RAID volumes.

1. Press F6 to enter the RAID setup utility when Press F6 to enter RAID setup utility is displayed.
The MediaShield Utility displays the array list. One of the arrays listed is highlighted in red.

2. Use the up/down arrow keys to highlight RAID volume to be deleted.

3. Press Enter to enter the array details. The Array Details screen shows the array details. Press D
to delete, then Y to confirm the delete.

The screen then returns to either Array List or Define a New Array.
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C Appendix C— Connector pins

Connector pin descriptions
Ethernet connector Pin Signal

1

2

3

4

(+) Transmit
Data

(-) Transmit
Data

(+) Receive
Data

Unused

5

6

7

8

Unused

(-) Receive
Data

Unused

Unused

Serial connector Pin Signal

1

2

3

Carrier Detect

Receive Data

Transmit Data

4

5

6

Data Terminal Ready
Signal

Ground

Data Set Ready

7

8

9

Request to Send

Clear to Send

Ring Indicator

USB connector Pin Signal

1

2

3

4

+5 VDC

- Data

+ Data

GND
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IEEE 1394 connector Pin Signal

1 power

2 gnd

3 tpb-

4 tpb+

5 tpa-

6 tpa+

Microphone connector (1/8 inch) Pin  Signal  

1 (Tip)

2 (Ring)

3 (Shield)

Audio

Power

Ground

Headphone connector (1/8 inch) Pin  Signal  

1 (Tip)

2 (Ring)

3 (Shield)

Audio_Left

Audio_Right

Ground

Line-in audio connector (1/8 inch) Pin  Signal  

1 (Tip)

2 (Ring)

3 (Shield)

Audio_In_Left

Audio_In_Right

Ground

Line-out audio connector (1/8 inch) Pin  Signal  

1 (Tip)

2 (Ring)

3 (Shield)

Audio_Out_Left

Audio_Out_Right

Ground

SPDIF OUT connector  Pin Signal

1

2

+VDC

Ground
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SPDIF OUT internal header  Pin Signal

1

2

+VDC

Ground

NOTE: The SPDIF Out internal header is used in parallel with the SPDIF OUT connector. Only one
should be used at a time.

SATA connector

Pin Signal  Pin Signal  Pin Signal  

Data Cable  Power Cable  Power Cable  

S-1 Ground P-1 3.3-V power P-8 5-V power

S-2* A+ P-2 3.3-V power P-9 5-V power

S-3* A- P-3 3.3-V power P-10 Ground

S-4 Ground P-4 Ground P-11 Reserved

S-5** B- P-5 Ground P-12 Ground

S-6** B+ P-6 Ground P-13 12-V power

S-7 Ground P-7 5-V power P-14 12-V power

* S2 and S3 differential signal pair

**S5 and S6 differential signal pair

P-15 12-V power
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SAS connector

Segment Pin Backplane
receptacle

Plug and cable
receptacles

Primary signal segment S1 SIGNAL GROUND

S2 TP+ RP+

S3 TP- RP-

S4 SIGNAL GROUND

S5 RP- TP-

S6 RP+ TP+

S7 SIGNAL GROUND

Secondary signal segment S8 SIGNAL GROUND

S9 TS+ RS+

S10 TS- RS-

S11 SIGNAL GROUND

S12 RS- TS-

S13 RS+ TS+

S14 SIGNAL GROUND

Power segment P1 V33
c

P2 V33
c

P3 V33
c precharge c

P4 GROUND

P5 GROUND

P6 GROUND

P7 V5
c precharge c

P8 V5
c

P9 V5
c

P10 GROUND

P11 READY LED d

P12 GROUND

P13 V12 precharge c

P14 V12
c

P15 V12
c
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VGA cconnector  

 

Pin  Signal Pin  Signal Pin  Signal  

1

2

3

Red Analog

Green Analog

Blue Analog

6

7

8

GND

GND

GND

11

12

13

Monitor ID

DDC Serial Data

Horizontal Sync

4

5

Monitor ID

GND

9

10

+5V DC

GND

14

15

Vertical Sync

DDC Serial Clock

DVI connector

Pin Signal Pin Signal

1 T.M.D.S DATA 2- 16 HOT PLUG DETECT

2 T.M.D.S DATA 2+ 17 T.M.D.S DATA 0-

3 T.M.D.S DATA 2/4
SHIELD

18 T.M.D.S DATA 0+

4 T.M.D.S DATA 4- 19 T.M.D.S DATA 0/5
SHIELD

5 T.M.D.S DATA 4+ 2 0 T.M.D.S DATA 5-

6 DDC CLOCK 21 T.M.D.S DATA 5+

7 DDC DATA 22 T.M.D.S CLOCK
SHIELD

8 ANALOG VERT. SYNC 23 T.M.D.S CLOCK+

9 T.M.D.S DATA 1- 24 T.M.D.S CLOCK-

10 T.M.D.S DATA 1+

11 T.M.D.S DATA 1/3
SHIELD

C1 ANALOG RED

12 T.M.D.S DATA 3- C2 ANALOG GREEN

13 T.M.D.S DATA 3+ C3 ANALOG BLUE

14 +5V POWER C4 ANALOG HORZ SYNC

15 GND C5 ANALOG GROUND
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ATA/ATAPI (IDE) standard drive cable connector

Pin  Signal  Pin  Signal  Pin  Signal

1

2

3

4

5

 Reset

GND

DD7

DD8

DD6

15

16

17

18

19

DD1

DD14

DD0

DD15

GND

 29

30

31

32

33

DMAK

GND

INTRQ

IOCS16

DA1

6

7

8

9

10

 DD9

DD5

DD10

DD4

DD11

20

21

22

23

24

(Key)

DMAR
Q

GND

DIOW

GND

34

35

36

37

38

PDIAG (cable
detect)

DA0

DA2

CS1FX

CS3FX

11

12

13

14

 DD3

D12

D2

D13

25

26

27

28

DIOR

GND

IORD
Y

CSEL

39

40

DASP

GND

24-Pin Main power connector

1 12

13 24

1

2

3

4

5

6

7

+3.3
V

+3.3
V

GND

+5 V

GND

+5 V

GND

 8

9

10

11

12

13

POK

+5 Vaux

+12V-B

+12V-B

+3.3 V

+3.3 V/+3.3 V-
Rsense

14

15

16

17

18

19

20

-12 V

GND

PS_ON
_L

GND

GND

GND

21

22

23

24

+5 V

+5 V/+5 V-
Rsense

+5 V

GND
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4-Pin power (memory system board) connector Pin Color Signal

1 BLK GND

2 BLK GND

3 BLK w/YEL
stripe

+12V-M

4 BLK w/YEL
stripe

+12V-M

8-Pin power (for CPUs and onboard
regulators) connector

Pin  Color Signal

5 8

41

1 BLK GND

2 BLK GND

3 BLK GND

4 BLK GND

5 Gray

BLK w/WHT
stripe

+12 V CPU0
Rsense

+12 V CPU0

6 BLK w/WHT
stripe

+12VCPU0

7 BLK w/light
blue stripe

+12VCPU1

8 BLK w/light
blue stripe

+12VCPU1

NOTE: The 6-pin power (auxiliary PCI Express) is only required with high-powered graphics cards.

6-Pin power (auxiliary PCI Express) Pin Color Signal

4 6

31

1 BLK w/YEL
stripe

+12V-G

2 BLK w/YEL
stripe

+12V-G

3 BLK w/YEL
stripe

+12V-G

4 BLK GND

5 BLK GND

6 BLK GND
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Keyboard connector Pin Signal

1

2

3

Data
Unused
Ground

4

5

6

+5 VDC
Clock

Unused

Mouse connector Pin Signal

1

2

3

Data
Unused
Ground

4

5

6

+5 VDC
Clock

Unused

Internal Type A USB connector Pin Signal

1

2

3

4

+5 VDC

- Data

+ Data

Ground

Internal IEEE 1394b connector Pin Signal

1

2

3

4

5

6

7

8

9

TPB-

TPB+

TPA-

TPA+

TPA (R)

VG

SC

VP

TPB (R)
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D Appendix D— System board
designators

This appendix lists the system board designators for this system.

Designator Silkscreen Component

BAT1 BAT1 Battery retainer

E49 CLR PSWD Clear password jumper

J9 None Stacked RJ45/dual USB

J12 FRNT 1394 Front panel 1394a header

J14 SPDIF OUT connector

J15 None Stacked RJ45/dual USB

J20 SLOT3 PCI32/33 PCI 32–bit slot

J25 SLOT6 PCI-X x100 PCI-X slot

J26 SLOT7 PCI-X x100/133 PCI-X slot

J31 SLOT1 PCI-E x8 PCIe x8 slot

J32 SLOT5 PCI-E x16 PCIe x16 slot

J33 SLOT4 PCI-E x8 PCIe x8 slot

J34 FRNT-P Front panel connector

J41 SLOT2 PCI-E x16 PCI Express x16 slot for graphics

J68 None Stacked keyboard/mouse connector

J83 Triple stacked audio jack

J84 1394/USB IEEE 1394a/dual USB stacked
connector

JP13 1-2 FORCE TO100 MHz

2-3 100/133 MHz (DEFAULT)

PCI-X bus speed select jumper*

JP16 HBA HDD LED ACTIVITY HBA HDD LED activity header

JP30 FAN DET OVR Fan detection override jumper

P1 PWR Main power connector (24-pin)

P2 PWR2 Memory power connector (4-pin)

P3 PWRCPU Processor power connector (8-pin)

P7 CD CD analog audio connector

P8 CHASSIS FAN Primary chassis fan header

P10 FLPY Floppy connector
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Designator Silkscreen Component

P11 AUX Auxiliary audio connector

P19 SPDIF OUT SPDIF OUT header

P20 PRIMARY IDE Primary IDE connector

P23 FRNT AUD Front panel audio header

P24 FRNTUSB2–3 Front panel USB header

P25 IUSB1 Internal USB header

P26 IUSB0 Internal USB header (Requires AMO
kit with USB cable)

P54 None Serial port connector

P60-63, P66-67 SATA0-SATA5 SATA Connectors

P70 CPUFAN0 CPU0 fan header

P71 CPUFAN1 CPU1 fan header

P80-87 SAS/SATA0–SAS/SATA7 SAS Connectors

P91 VOLTAGE REGULATOR FAN (LIQUID
COOLING UNIT)

Voltage regulator fan connector

P92 PCI FAN PCI fan header

P93 MEMORY FAN Memory fan header

P94 12V FAN 12-V fan header

P95 12V FAN 12-V fan header

SW50 CMOS Clear CMOS switch/push button

U15 ROM ROM socket

XMM1 DIMM3b Memory slot

XMM2 DIMM3a Memory slot

XMM3 DIMM1b Memory slot

XMM4 DIMM1a Memory slot

XMM5 DIMM4b Memory slot

XMM6 DIMM4a Memory slot

XMM7 DIMM2b Memory slot

XMM8 DIMM2a Memory slot

XU1 CPU0 Primary processor socket

XU2 CPU1 Secondary processor socket

* With the jumper on pins 1 and 2, the PCI-X bus speed is 100 MHz, regardless of the card configuration
in slots 6 and 7. With the jumper on pins 2 and 3 (default), the following PCI-X bus speed/card
configuration applies:
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Card configuration Max PCI-X bus speed
achieved*

One card in slot 7 only 133 MHz

One card in slot 6 only 100 MHz

Two cards, one in each
slot

100 MHz

* Dependent upon card capability.
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E Appendix E— Power cord set
requirements

The power cord set (flexible cord or wall plug) received with this product meets the requirements for use
in the country where you purchased the equipment.

If you must obtain a power cord for a different country, purchase a power cord that is approved for use
in that country.

The power cord must be rated for the product and for the voltage and current marked on the product’s
electrical ratings label. The voltage and current rating of the cord should be greater than the voltage and
current rating marked on the product. The length of the cord must be between 1.8m (6 feet) and 3.6m
(12 feet). If you have questions about the type of power cord to use, contact an HP authorized service
provider.

Route the power cord so that it is not likely to be walked on or pinched by items placed on it or against
it. Pay particular attention to the plug, electrical outlet, and the point where the cord exits from the
product.

NOTE: Use a 15 A-capable (minimum) power cord with a 110V power source. Use a 10 A-capable
(minimum) power cord with a 220V power source.
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F Appendix F— Routine care

General cleaning safety precautions
● Never use solvents or flammable solutions to clean the workstation.

● Never immerse any component in water or cleaning solutions; apply any liquids to a clean cloth
and then use the cloth on the component.

● Always unplug the workstation before cleaning the keyboard, mouse, or air vents.

● Disconnect the keyboard before cleaning it.

● Wear safety glasses equipped with side shields when cleaning the keyboard.

Maximizing the airflow
● Keep your workstation in an area where the airflow to the front and rear of the system is not

obstructed.

● If possible, keep the unit off of surfaces where dust can gather.

● Keep the back of the unit at least 0.15m (6 in.) away from a wall or other obstruction.

● Keep the front of the unit clear of any obstruction that keeps air from entering the front of the system.

● Remove any dust on the front panel (vent area) and the rear fans with a small vacuum, compressed
air, or dust rag.

Cleaning the workstation case
● Follow the safety precautions presented in Service considerations on page 51 before cleaning the

workstation.

● To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

● For stronger stains, use a mild dish-washing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

● For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed because the alcohol will
evaporate quickly and not leave a residue.

● After cleaning, always wipe the unit with a clean, lint-free cloth.

● Occasionally clean the air vents on the workstation. Lint and other foreign matter can block the
vents and limit the airflow.
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Cleaning the keyboard
CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under
the keys.

● Follow the safety precautions presented in Service considerations on page 51 before cleaning the
keyboard.

● Visible debris underneath or between the keys can be removed by vacuuming or shaking.

● Canned, pressurized air can be used to clean debris from under the keys. Use caution because
too much air pressure can dislodge lubricants applied under the wide keys.

● If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool
is available through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys
are improperly removed or installed, the keyboard might not function properly.

● Clean under a key with a swab moistened with isopropyl alcohol and squeezed out. Be careful not
to wipe away lubricants necessary for proper key functions. Allow the parts to air dry before
reassembly.

● Use tweezers to remove any fibers or dirt in confined areas.

Cleaning the monitor
● Follow the safety precautions presented in Service considerations on page 51 before cleaning the

monitor.

● To clean the monitor, wipe the monitor screen with a towelette designed for cleaning monitors or
a clean cloth moistened with water.

CAUTION: Do not use sprays or aerosols directly on the screen—the liquid might seep into the
housing and damage a component.

Never use solvents or flammable liquids on the monitor because display or housing damage may
result.

Cleaning the mouse
1. Follow the safety precautions presented in Service considerations on page 51 before cleaning the

mouse.

2. Remove the mouse ball from the housing by removing the retaining plate.

3. Clean the mouse ball.

4. Pull out any debris from the ball socket, and wipe the ball with a clean, dry cloth.

5. Reassemble the mouse.
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G Appendix G— Additional password
security and resetting CMOS

This workstation supports the following security password features, which can be established through
the Computer Setup Utility menu:

● Setup password

● Power-on password

If only a power-on password is established, it must be entered to boot the workstation.

If only a setup password is established, it must be entered to access the setup menu. Power cycling is
required for the setup password to take effect.

If both passwords are set, either password can be entered to boot, but the setup password must still be
entered to access the Computer Setup Utility menu.

If you forget the password for the computer, remove the Clear Password jumper on the system board.

Resetting the password jumper
To disable the power-on or setup password features and clear the power-on and setup passwords:

1. Shut down the operating system, and power off the workstation and any external devices.
Disconnect the power cord of the workstation and any external devices from the power outlets.

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure
to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

CAUTION: When the workstation is plugged in, the power supply always applies voltage to the
system board–even when the unit is turned off. Failure to disconnect the power cord can result in
damage to the system.

CAUTION: Static electricity can damage the electronic components of the workstation or optional
equipment. Before beginning these procedures, be sure that you are discharged of static electricity
by briefly touching a grounded metal object.

2. Remove the access panel.

3. Locate the password header and jumper. The password header is E49. For assistance locating
the password jumper and other system board components, refer to the service label on the
workstation access panel.

4. Remove the jumper.

5. Replace the access panel.

6. Plug in and power on the workstation. Allow the operating system to start. This process clears the
current passwords and disables the password features.

7. To establish new passwords, repeat steps 1 through 3, replace the password jumper on both pins
1 and 2, and repeat steps 5 through 6. Establish the new passwords in the Computer Setup Utility.
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Clearing and resetting the CMOS
The CMOS of the workstation stores password information and information about the workstation
configuration. This section describes the steps to successfully clear and reset the CMOS.

Using the CMOS button
1. Shut down the operating system, and power off the workstation and any external devices.

Disconnect the power cord of the workstation and any external devices from the power outlets.

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure
to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

CAUTION: When the workstation is plugged in, the power supply always applies voltage to the
system board–even when the unit is turned off. Failure to disconnect the power cord can result in
damage to the system.

CAUTION: Static electricity can damage the electronic components of the workstation or optional
equipment. Before beginning these procedures, be sure that you are discharged of static electricity
by briefly touching a grounded metal object.

2. Remove the access panel.

3. Locate and press the clear CMOS button.

CAUTION: Pushing the clear CMOS button resets CMOS values to factory defaults and erases
some customized information. It is important to back up the workstation CMOS settings before
resetting them in case they are needed later. To back up the CMOS settings, use the Replicated
Setup option in the Computer Setup Utility menu.

For assistance locating the clear CMOS button and other system board components, refer to the
service label on the workstation access panel.

NOTE: AC power does not need to be disconnected for the clear CMOS button to work.

The clear CMOS button does not clear the workstation passwords.

4. Replace the access panel.

5. Plug in and power on the workstation.

NOTE: Any special configurations will have to be reset.

Using the Computer Setup Utility to reset CMOS
To reset CMOS to factory defaults:

1. Enter the Computer Setup Utility menu by pressing F10 when the F10=Setup prompt displays on
the screen during bootup. The word Setup displays in the lower right corner of the screen. If a
setup password has been set, a password prompt displays on the screen.

NOTE: If you do not press the F10 key while the message is displayed, the workstation must be
powered off, then on again, to access the utility.

2. Select File>Default Setup>Restore Factory Settings as Default, and press F10. Press any key
at the prompt that then displays.

NOTE: This procedure does not reset the date and time.

3. Select File>Apply Defaults and Exit. Press F10 at the prompt that then displays.
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H Appendix H— Quick troubleshooting
flowcharts

This appendix presents some quick troubleshooting flowcharts for the following issues:

● Initial troubleshooting

● No power

● No video

● Error messages

● No OS loading

● No OS loading from hard drive

● No OS loading from diskette drive

● No OS loading from optical drive

● No OS loading from network

● Non-functioning device

NOTE: The flowcharts presented are for general troubleshooting purposes only and they might not
apply to your specific workstation.
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Initial troubleshooting
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No power
No power, part 1
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No power, part 2
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No power, part 3
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No video
No video, part 1
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No video, part 2
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No video, part 3

198 Appendix H   Appendix H— Quick troubleshooting flowcharts ENWW



Error messages
Error messages, part 1
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Error messages, part 2
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No operating system loading

ENWW No operating system loading 201



No operating system loading from hard drive
No operating loading from hard drive, part 1
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No operating system loading from hard drive, part 2
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No operating system loading from hard drive, part 3
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No operating system loading from diskette drive
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No operating system loading from optical drive
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No operating system loading from network
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Non-functioning device
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I Appendix I—PCI bus layout

PCI bus layout and device list
The following illustration shows the HP xw9400 Workstation PCI bus layout. It is followed by a PCI device
list description.

Figure I-1  PCI bus layout

Table I-1  PCI device list

Device Bus# Dev# Fn#

MCP55ProPro HT Config 0 0 0

MCP55ProPro LPC 0 1 0

MCP55Pro SMBUS 0 1 1

MCP55Pro Trim 0 1 2

MCP55Pro ASF SMU 0 1 3

MCP55Pro USB OHCI 0 2 0

MCP55Pro USB EHCI 0 2 1

MCP55Pro IDE 0 4 0

MCP55Pro SATA0 0 5 0

MCP55Pro SATA1 0 5 1
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Device Bus# Dev# Fn#

MCP55Pro SATA2 0 5 2

MCP55Pro P2P Bridge (Bridge to Slot 3) 0 6 0

MCP55Pro High Definition Audio Controller 0 6 1

MCP55Pro LOM 0 0 8 0

MCP55Pro LOM 1 0 9 0

MCP55Pro PCIE Root Port 0 (Port to Slot 2) 0 F 0

MCP55Pro PCIE Root Port 2 (Port to NEC Bridge) 0 D 0

MCP55Pro PCIE Root Port 5 (Port to Slot 1) 0 A 0

IO55 HT Config 40h 0 0

IOP55 LPC 40h 1 0

IOP55 SMBUS 40h 1 1

IOP55 Trim 40h 1 2

IO55 PCIE Root Port 0 (Port to Slot 5) 40h F 0

IO55 PCIE Root Port 2 (Port to SAS) 40h D 0

IO55 PCIE Root Port 5( Port to Slot 4) 40h A 0

Slot 1 (PCIEx8) 5h 0 0

Slot 2 (PCIEx16) 18h 0 0

Slot 3 (32 bit PCI ) 1h 4 0

Slot 4 (PCIEx8) 45h 0 0

Slot 5 (PCIEx16) 58h 0 0

Slot 6 (PCIX 100) 2Ch 4 0

Slot 7 (PCIX 100/133) 2Ch 9 0

1394 Controller 1h 5 0

NEC PCIX Bridge Controller 2Bh 0 0

NEC PCIX Bridge Controller (No Physical Slot
Connections)

2Bh 0 1

LSI SAS Controller 6Bh 0 0

Table I-1  PCI device list (continued)
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J Appendix J— Configuring SATA and
PATA optical disk drives

This section provides information on the sequence in which the workstation detects and assigns optical
disk drive (ODD) IDs and drive letters when both Serial ATA (SATA) and Parallel ATA (PATA) ODDs
are installed in a workstation. It also provides configuration rules that determine which SATA ports are
functional and which ports can be used to update system BIOS. The following information provides
assumptions and configuration rules for installing SATA and PATA ODDs in the same workstation. It
also provides configuration guidelines for installing SATA ODDs in the same workstation with SATA
hard disk drives (HDDs).

Drive detection and assignment sequence
When mixing PATA and SATA ODDs in a workstation, the PATA optical drive will always be detected
first by the system. For example, if the first ODD is a SATA drive and the second ODD is a PATA drive,
the system will detect the PATA ODD drive first. This will generally result in the PATA ODD being
assigned the lower drive ID or drive designation letter by the operating system.

Workstation SATA port configuration rules
Port configuration rules are determined individually by workstation product as shown in the following
sections.

HP w9400 Workstation BIOS configuration
When the xw9400 Workstation is set to RAID Mode in BIOS, any SATA ports that have an ODD
connected to them must have RAID turned off.

HP xw8400/xw6400/xw4400 Workstation SATA configuration mode settings
When the SATA Configuration Mode for these workstations is set to:

● Separate Mode - Only SATA ports 0, 1, 2, and 3 are functional for any SATA devices.

● Combined Mode - Only SATA ports 0 and 2 are functional for any SATA devices.

● RAID/AHCI Mode - You will not be able to update system BIOS from the SATA ODD.

● Combined Mode or Separate Mode - BIOS can be updated using a SATA ODD attached to
functional ports.
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